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Chapter 1
About This TechNote

This TechNote provides Compaq server management integration guidelines, based
on our testing of hardware and software products from Compaq and other vendors.
The management platforms that Compaq selected to test might not be the same as
your configuration. However, this TechNote provides guidelines that you can use to
integrate with any SNMP-compliant management platform.

This TechNote also provides the following:

■ Network management overview, terminology, and standards.

■ Discussion about Compaq Insight Management Agents and how they
easily integrate with other management platforms.

■ Information on how to use the Compaq Insight Management MIBs in
SNMP-compliant platforms.

Chapter Organization
This chapter is intended to help you use this TechNote; therefore, a brief
summary of each chapter follows:

Chapter 1  --  Introduces the TechNote with a brief summary of each chapter,
general information about the conventions used, and a bibliography you can
use to find more information on Enterprise management platforms.

Chapter 2  --  Provides a network management overview that includes
terminology, standards, and a discussion of the complexity of network
management.

Chapter 3  --  Describes the Compaq Management Technology framework
that includes Compaq management hardware and software products.

Chapter 4  -- Discusses integrating Compaq Insight Management Agents with
the IBM NetView for AIX (from IBM) network management platform.
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Chapter 5  --  Discusses integrating Compaq Insight Management Agents with
the SunNet Manager (from SunConnect) network management platform.

Chapter 6  --  Discusses integrating Compaq Insight Management Agents with
the HP OpenView (from Hewlett-Packard Company) network management
platform.

Appendix A  -- Describes Compaq Insight Management MIBs and the
information they provide to help you diagnose and solve Compaq server-related
problem scenarios.

Appendix B  -- Provides a listing of traps generated by Compaq Insight
Agents to assist you in translating trap variables.
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Notational Conventions
This TechNote uses the following conventions to distinguish elements of text:

Table 1-1
Notational Conventions

Convention Use

Set, Get Screen button labels appear in bold initial caps.

ENTER Keys on your keyboard appear in boldface and uppercase,
not a sequence of keys to press.

Enter When instructed to enter information, type the information
and press the ENTER key.

"new terms" and "prompts" The first occurrence of a technical term, prompts, and
references to a word other than a command appears in
quotes.

Key + Key When you see a plus sign between two keys, hold down
the first key while you simultaneously press the second
key.

For example, "Press the CTRL + Z keys" means to press
the CTRL key while you simultaneously press and release
the Z key.

Select item → item Items separated by arrows indicate items you select in a
sequence.

screen selections and variables These items appear in italics in all chapters of this
TechNote.

file names and directories These items appear in lowercase italics in the UNIX
environment.

user input, screen display Information you type exactly as it appears, and information
that displays on the screen displays in lowercase and in a
different typeface in the UNIX environment.

commands, options, programs,
utilities

These items appear in lowercase boldface in the UNIX
environment.

continued
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Notational Conventions   Continued   

USER INPUT Information you type exactly as it appears is shown in
uppercase and in a different typeface in the DOS and
Windows NT environments.

FILENAMES Names of files appear in uppercase italic in the DOS and
Windows NT environments.

PROGRAMS, COMMANDS, DIRECTORY
NAMES, and DRIVE NAMES

These items appear in uppercase in the DOS and Windows
NT environments.

! IMPORTANT Presents clarifying or specific points of information.

NOTE Presents commentary, sidelines, or interesting points of
information.

Additional Resources to Use
The following references were used in the development of this TechNote:

Compaq TechNote, Configuration and Tuning of Microsoft SQL Server for
Windows NT on Compaq Servers, P/N 184207-002
Compaq Computer Corporation, April 1995.

Compaq Insight Manager User Guide, P/N 133394-006
Compaq Computer Corporation, February 1995.

Compaq Insight Management Agents User Guide,
Compaq Computer Corporation, February 1995.

SCO UNIX IP Routing Over X.25 Networks TechNote, P/N 145711-001
Compaq Computer Corporation, April, 1993.

Release Notes for Microsoft Windows NT Advanced Server,
Microsoft Corporation, March 1993.

HP OpenView Windows User's Guide,
Hewlett-Packard Company, 1992.
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HP OpenView Network Node Manager 3.3 Administrator's Reference,
Hewlett-Packard Company, 1992.

HP OpenView Network Node Manager 3.3 User's Guide,
Hewlett-Packard Company, 1992.

SunNet Manager 2.2 Reference Guide,
Sun Microsystems, Inc., 1992.

SunNet Manager 2.2 User's Guide,
Sun Microsystems, Inc., 1992.

The Simple Book: An Introduction to Management of TCP/IP-based Internets.
Marshall T. Rose. Englewood Cliffs, New Jersey: Prentice-Hall, 1991.

Troubleshooting Internetworks:  Tools, Techniques, and Protocols.
Mark A. Miller. San Mateo, California: M&T Books, 1991.

McGraw-Hill's Compilation of Open Systems Standards.
Ed. Harold C. Felts. New York: McGraw-Hill, 1989.

The Basic Reference Model of Open Systems Interconnection (OSI),
ISO 7498 - Part 4

PC Systems Standard MIF Definition, Desktop Management Task Force
(DMTF). Release Version 1.2, February 1995.

The Internet

To access the Compaq home page on the Internet, enter:

http://www.compaq.com
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Chapter 2
Network Management

This TechNote is intended for network administrators who need to know the
critical success factors for integrating the management technologies and tools
of Compaq servers and client desktop PCs into a broader network
management environment. Compaq servers support Compaq developed,
SNMP-based management agents running under network operating systems
such as Microsoft Windows NT, NetWare, SCO OpenServer, UnixWare,
IBM OS/2, and UNIX to provide management of the hardware. The
Compaq Deskpro Family supports “Intelligent Manageability,” which
moves many Compaq server management technologies to the desktop.
Compaq Desktop Management Solution Partners access these Intelligent
Manageability features.

The typical network configuration can include devices such as routers,
bridges, gateways, and other SNMP-host computers. Figure 2-1 is an example
of such a network.

Dallas

New YorkHouston

 Host




SER001.ai

FIG2-1.eps

Router

Bridge

File Server

Modem

Router

Figure 2-1.  Typical network configuration
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Managing a multivendor, multioperating system environment, similar to the
typical network configuration illustrated in Figure 2-1, is a complex process.
However, such networks are not uncommon in many organizations and might
resemble your own.

Compaq provides you with tools for managing Compaq servers and desktops.
These tools build upon the functionality and features engineered into the
servers and desktops. The tools, used in combination with tools specific to
your network operating system, can provide you with cost-effective methods
to manage your network.

Compaq server management technologies, desktop Intelligent Manageability,
and tools adhere to accepted network management standards such as:

■ Simple Network Management Protocol (SNMP)

■ Point-to-Point Protocol (PPP)

■ Transmission Control Protocol (TCP) and Internet Protocol (IP)

■ Internet Packet Exchange (IPX)

■ Telnet

■ Windows Internet Name Service (WINS)

■ Dynamic Host Configuration Protocol (DHCP)

■ American Network Standards Institute (ANSI) terminal emulation

The Compaq commitment to standards assures you the flexibility and
cost-effectiveness of an open, industry-standard solution.
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Network Management Terms
Table 2-1 contains a list of network management terms and definitions
associated with computing devices, infrastructure devices, and network
protocols. In this TechNote, the first reference of the network management
term is used to introduce a term and the second reference is used for the
remainder of the document.

Table 2-1
Network Management Terminology

First
Reference

Second
Reference

Definition
of Term

Attribute Attribute
Characteristics of the object provided to a
network administrator (for example fault,
performance, and configuration information).

Element Manager Element
Manager

Application that manages a device or
a subsystem.

Managed Device Device
Computing and infrastructure devices that are
manageable (for example, servers and routers
that run management agents and therefore
are manageable).

Managed Object Object
Component of a device that is manageable (for
example, network interface, storage subsystem,
operating system, active applications, or
hardware configuration).

Insight
Management
Server Agent

Insight
Server Agent

Software or firmware installed and running in a
managed device that provides attribute
information to an element manager.

SNMPv1 SNMP
Industry-standard protocol for the exchange of
management data between management
applications and management agents.

Subsystem Subsystem
Major components of a device (for example, disk
subsystem, storage subsystem, memory
subsystem, and processor subsystem).
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Figure 2-2 illustrates the relationship between the network management
terminology described in Table 2-1.

Managed 

Device

Disk

Fault

Network Interface

             Controller (NIC)

SER002.AI

Fig2-2.eps

Attributes

Managed Objects

Performance Configuration Fault Performance Configuration

Attributes

 Figure 2-2.  Relationship of network management terms

In summary, every managed device:

■ Possesses a set of managed objects that correspond to hardware
subsystems and software components.

■ Possesses a number of attributes that describe the objects. The
attributes of the managed device are readable and might be writable by
a management application.

■ Sends notification of changes in operating status and information about
a failure condition to a management application.
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Discussion of Network Management
Network management enables the monitoring, analysis, and control of
computing and infrastructure devices, as well as the network protocols.

Managed devices can include the following:

■ Computing devices  --  servers, desktops, workstations, hosts,
and mainframes

■ Infrastructure devices  --  bridges, routers, gateways, and hubs

Today, management applications exist that allow you to monitor the status
of attributes, analyze their condition, and perform a resulting action on a
managed device. For example, you might choose to reset a port on a hub
when the device attached to that port generates an excessive number of
network errors.

A benefit of network management is that it allows you to provide acceptable
service levels to your users in the most cost-effective manner. This service, in
turn, depends on several issues such as:

■ How critical is uptime to your network?

■ How much do you want to restrict access to the network?

■ What level of performance do you expect to achieve?

■ What does it cost to manage your network effectively?

Network management often requires you to balance several objectives that
could be contradictory. For example, two of your requirements might be to
reduce costs and reduce downtime. However, the cost of 100-percent uptime
is often prohibitive.
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The following is a sample of the factors that contribute to the complexity of
network management:

■ Networks containing a variety of devices.

■ Varying requirements from one user organization to another; each
organization perceives its needs to be unique.

■ Users have a sharply different perception and expectation than network
administrators and MIS management within an organization. This
problem becomes more complicated because of the growing influence
of new technology and the need for businesses to rightsize their
computing environments.

■ Lack of easy to use, broad-based solutions.

■ The focus of many management solutions today is to manage a
single-network element such as a bridge, a router, or a server. For
PC-based networks, some solutions specialize in certain areas of
network management such as configuration or performance
monitoring. Management solutions that can manage several network
devices and support multiple functional areas of network management
typically require additional systems integration.

Standards-Based Network
Management Model

The International Standards Organization (ISO) has formulated a network
management framework because the scope of network management is so broad.
This management framework is a document that provides a reference for
coordinating development of management standards. The Basic Reference
Model of Open Systems Interconnection (OSI), ISO 7498 — Part 4 describes the
functional areas of network management. This reference document supplements
the ISO Open Systems Interconnection (OSI) model. The OSI model describes
the seven protocol layers  (that is, physical through application layer) and
the activities necessary, at each layer, for systems to interconnect over
communications media such as a telephone line, a serial cable, or a
coaxial cable.
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The ISO network management model identifies five functional areas of
management. They are:

■ Fault Management

■ Performance Management

■ Configuration Management

■ Security Management

■ Accounting Management

There are several publications, as well as the ISO standard itself, that can
provide you with complete details on each of these management areas. The
following is just a brief overview of the typical requirements in each area.

Fault Management

Detecting faults and notifying network administrators of a fault occurrence is
an intrinsic function of network management. This function becomes critical
in a distributed networking environment, particularly in an economic climate
where shrinking budgets force MIS departments to automate remote fault
detection and resolution. Compaq recognizes the importance of this category
by providing devices that provide a wide array of fault tolerant features, and
monitorable error indicator attributes, and “fault prediction” attributes. With
fault prediction attributes, you can proactively manage the devices to predict
faults and provide maximum server uptime.

Performance Management

Performance management allows you to monitor, analyze, and tune devices
and network operation. This function is important in a distributed networking
environment where the application or network uptime is mission critical.
With performance data available, you can do capacity planning to enable the
cost-effective growth of your ever-changing network.
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Configuration Management

New devices such as servers, workstations, printers, routers, and specialized
high-speed links are constantly added to networks as the prices of computing
resources drop. The term “network” takes on new meaning when you consider
devices such as laptops, that at times are not connected to the network. With
configuration management you can effectively monitor the existence and
configuration of the computing assets deployed on your network.

Security Management

There are two facets to security management. They are:

■ Allowing legitimate users access to information relevant to their
job function

■ Restricting unauthorized users

Under no circumstances should all users automatically get rights to access all
information. Access rights must be set up in a consistent manner, so you can
quickly track access violations.

As your organization grows, it might become necessary to separate your
network into smaller workgroups, each part of a logical domain such as
Sales, Marketing, Engineering, and so on. You need to control intra-domain
access in a way that makes it easy for your users to share information, while
preventing abuse. Similar, though more restrictive, access applies to
exchanging information with external sources such as your suppliers,
customers, consultants, and so on. Another concern is physical security
(access to the hardware), as well as operating system security and network
security (access to data).
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Accounting Management

Today, networks can offer a variety of services from video conferences, to
e-mail, to file sharing. It is often necessary to monitor the usage of these
services so you can distribute the costs equitably and charge back to
individual cost centers. Knowledge of usage patterns can also assist you
in capacity planning and in redeploying network resources to serve
changing needs.

Network Management Standards
As discussed earlier, managing a network is complex. Management
becomes even more complicated without standards. When an organization
purchases multiple management tools, each with a different method of
managing a particular hardware or software product, it must then maintain
and train network administrators in different tools. This is expensive and
inefficient. Consequently, standards committees have developed protocols for
network management.

SNMP Standard

The Internet Engineering Task Force (IETF), the standards rating body for the
world-wide Internetwork, has defined a management protocol. The Simple
Network Management Protocol (SNMP) has accumulated a major share of the
market and has the support of over 20,000 different products. SNMP has its
roots in the Internet community — the complexity of large international
TCP/IP networks provided the necessary incentive to develop a standard
method of managing devices on the network.

Within the SNMP framework, manageable network devices (routers, bridges,
servers, and so on) contain a software component called a management agent.
The agent monitors the various subsystems of the network element and stores
this information in a management information base (MIB). Conceptually, the
MIB is a database, readable and writable by a management application using
the SNMP protocol.
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There are two types of MIBs:

■ Internet Management MIBs  --  These MIBs include MIB-II, RMON,
and others. These MIBs, standardized by the Internet community,
represent the core objects that are common across the widest range of
network devices implementing the Internet protocols. Examples of
these objects include network protocols such as TCP/IP and network
devices such as Ethernet network interfaces.

■ Vendor MIBs  --  These MIBs represent objects that are unique to an
individual vendor's product or product line. Over 500 vendors and
organizations have created their own vendor MIBs. Compaq was the
first personal computer company to develop a MIB that enabled SNMP
management of server hardware.

The majority of vendors of internetworking devices have embraced the SNMP
standard, including:

■ Bay Networks Incorporated

■ Cisco Systems Incorporated

■ Cabletron

■ 3Com Corporation

SNMP has also gained acceptance among vendors who have developed
compliant management platforms, including:

■ HP OpenView (Hewlett-Packard Company)

■ NetView for AIX (IBM)

■ SunNet Manager (SunConnect -- a Sun Microsystems, Inc. Business)
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Among server vendors, Compaq offers SNMP-compliant management agents
that provide specific Compaq device information. These include:

■ Compaq Insight Management Server Agents for Microsoft Windows NT

■ Compaq Insight Management Server Agents for NetWare

■ Compaq Insight Management Server Agents for SCO OpenServer

■ Compaq Insight Management Server Agents for UnixWare

■ Compaq Insight Management Server Agents for IBM OS/2

■ Compaq Insight Management Server Agents for SCO UNIX

■ Compaq Insight Management Desktop Agents for Windows 95

■ Compaq Insight Management Desktop Agents for Windows NT

SNMP often uses the network for sending and receiving management
information. This is called "in-band" management, however, SNMP is not
limited to in-band management. In-band management is discussed in more
detail later in this chapter.

SNMP supports both read and write operations (GET and SET) commands on
attributes. Some vendors do not support the SET command because of the
potential to allow an unauthorized person to alter critical parameters on a
network element. Insight Server Agents support the SNMP community string
and a command line argument to control SET operation behavior of non-
critical parameters. For more detailed information about the Insight Server
Agents for a particular operating system, refer to the appropriate Compaq
Insight Management Server Agents User Guide.

NOTE:  Some users of SNMP have expressed concern over the low level of
security mechanisms employed. In response to that concern, the Internet
community has recently specified SNMPv2. SNMPv2 is the next version of the
Simple Network Management Protocol that includes improvements to SNMP in the
areas of performance, security, confidentiality, and manager-to-manager
communications. At this time, SNMPv2 has not been implemented by vendors of
network devices.
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SNMP is associated with TCP/IP and monitoring devices on Ethernet
networks because of its long association with the Internet. However, you can
use SNMP over other protocols such as IPX and AppleTalk. For example, the
Compaq Insight Manager application supports SNMP over IPX and IP.

NOTE:  For an in-depth discussion of SNMP, refer to The Simple Book - An Introduction
to Internet Management by Marshall T. Rose (Prentice-Hall).

The SNMPv1 management protocol specifies four operations that a
management application can use to manage information known to the agent.
These are the GET, GET-NEXT, SET, and TRAP operations, all briefly
described as follows:

■ GET and GET-NEXT

 The management application uses the GET and GET-NEXT (read)
commands to acquire the data, the MIB variables, that provide the
mechanism for monitoring. The Compaq Insight MIBs, included with
the Compaq Insight Server Agents, describe the MIB variables.

■ SET

 The SET (write) operation allows the management application to set or
change a variable value that is known to the agent.

■ TRAP

 The management agents can send asynchronous trap messages or
unsolicited information when they determine that a significant fault or
performance event has occurred. All traps generated by Insight Server
Agents are Compaq enterprise traps.
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Methods of Managing
Network Resources

There are two different methods to access your network resources. Your
computer can access the managed device(s) "in-band" using the network or
"out-of-band" through a point-to-point connection such as a modem link. The
operational status of your network device(s) influence the actions that you
perform at the computer. The element is either "online," providing its network
services (such as routing packets or sharing files), or "offline," not providing
network services due to routine maintenance or catastrophic failure.

In-Band Device Access

Regardless of the operational status of the device, in-band access requires an
operational network link between the device and computer. In-band
management is useful for local access or even remote access when you are
confident of your LAN and WAN infrastructure.

Out-of-Band Device Access

In contrast to in-band device access, out-of-band access does not require an
operational network. You can remotely access a device using out-of-band
management when access does not exist to a LAN or WAN, either by design
or due to the failure of a network link. Typically, you would establish an
out-of-band device access to provide a point-to-point connection between a
management console and the managed device. For example, you might use
out-of-band management when the remote office is not on the network.
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Online Management

Online management refers to the management of an operational network
device. The following sections discuss online in-band and online
out-of-band management.

Online In-Band Management

This is the most common management model, since most network
administrators are confident of their LAN and WAN infrastructure. The
management actions between the management application and the managed
device occur within the network. These actions include reading and writing
attributes. The network carries regular data as well as management data. This
model is very cost-effective because management data typically uses only a
small percentage of overall network bandwidth, and you do not need an
alternate network to carry the data. However, overloading the network with
management data can cause network performance degradation.

Online Out-of-Band Management

This management model is less common, but can be useful for branch office
environments. In contrast to in-band management, the management actions
between the application and the managed device occur outside a network,
usually via an asynchronous or modem connection. Otherwise, all capabilities
are the same as online in-band management.

You can use two standard transport protocols to perform out-of-band
SNMP management:

■ Serial Line Internet Protocol (SLIP)

■ Point-to-Point Protocol (PPP)

In addition to SLIP and PPP, many vendors use proprietary protocols to
perform out-of-band management.
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Offline Management

When you need to perform an operation such as recovery of a failed network
device, one that no longer provides services to the network, the operation is
usually considered maintenance. In general, offline maintenance tasks require
the use of recovery tools, as well as the replacement of failed components.
Typically, this management style requires a remote logon to the failed
device to perform recovery operations such as diagnostics, configuration, or
firmware update.

Offline In-Band Management

Applications to perform offline in-band management include:

■ NetWare Virtual Terminal (NVT) over IPX

■ Telnet over IP

Offline Out-Of-Band Management

Local terminals (or via modem) with ANSI and VT100 terminal emulation
capabilities perform offline out-of-band management.

Many vendors use proprietary protocols and applications to perform offline
management including:

■ Telnet

■ ANSI

■ VT100
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Server Management as a Subset of
Network Management

LANs are strategic resources for the development and deployment of critical
applications. Businesses are increasingly deploying LANs to rightsize their
operations and capitalize on improved economic results. Consequently, the
cost associated with hiring, training, and keeping skilled network
administrative personnel to support a growing and complex LAN
environment continues to increase. LAN management tools help control
the rising costs of LAN administration while increasing the dependability
of network environments.

Network administrators have sophisticated management tools for network
resources such as bridges, routers, and concentrators, as well as network
protocols. However, to manage servers, a key network resource, network
administrators have typically used simple tools. The comprehensive
manageability of servers and sophisticated server management tools are
essential requirements for PC networks. As shown in Figure 2-3, these server
management requirements include in-depth monitoring, analysis, and control
of the performance, fault, and configuration aspects of the server operation.
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 Figure 2-3.  Server management

Effective server management requires:

■ Built-in capabilities to the server and options

■ Strict adherence to popular network management standards for
communication protocols and data interchange

■ Tools that operate within the customer's preferred environment

The combination of these capabilities allows you to manage the server to
ensure that it is one of the most reliable resources in the network.
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Desktop Management as a Subset
of Network Management

The increasing emphasis on PC LANs has made manageability of PC
networks a key customer need. Many businesses are increasing their
dependence on PC networks. Large businesses are installing increasingly
larger and more complex PC networks; therefore, customers are now
demanding significant network dependability.

To meet these customer needs, Compaq has forged close alliances with
leading vendors of PC LAN management applications. In conjunction with
this effort, Compaq has also implemented desktop PC management
capabilities called Intelligent Manageability.

These comprehensive management capabilities make network PCs easier to
manage and less expensive to maintain. Figure 2-4 illustrates an example of
today’s typical data flow when managing a PC network.
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 Figure 2-4.  Desktop and server management
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Effective desktop management requires:

■ Enhanced desktop hardware features that provide a rich set of
management capabilities, including Asset and Fault Management

■ Close integration of hardware, operating systems, and management software

■ Support for a wide range of network management standards

■ Fault management of client PCs through standard management
products

All of these Intelligent Manageability features are designed to provide
manageable PCs that work in any customer’s strategic environment. No matter
what scale of management a customer uses, the Compaq Deskpro Family has
features that add value in the realm of managing networks.
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Chapter 3
Compaq Management
Technologies

Compaq integrates hardware management features and complementary
management tools to provide a complete server and desktop PC management
solution for the network administrator.

STANDARD MANAGEMENT FEATURES

MANAGEMENT FEATURES

COMPAQ

INSIGHT

MANAGER

COMPAQ

OPTIONAL MANAGEMENT TOOLS

INSIGHT
MANAGEMENT

AGENTS

INTEGRATED

Figure 3-1.  Compaq server management framework
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The technology framework focuses on hardware management and Compaq
Insight Management software that ensures dependable, easy-to-manage
computers. The following sections provide a detailed overview of the
components of the framework:

■ Compaq Server Management Technologies

■ Compaq Desktop PC Management Technologies

■ Compaq Insight Manager Software

■ Integration with Operating System Management

■ Network Management Interoperability

Compaq Server Management
Technologies

The ability to manage server fault conditions, using advanced technologies, is
a significant aspect in any server operation. Every hardware subsystem (such
as the hard drive, system memory, and system processor) in Compaq servers
has a robust set of management capabilities, designed-in, that address one or
more of the fault, performance, and configuration management aspects of
server operation.

Network dependability is enhanced by delivering timely information on the
operational status of critical server subsystems. Using this information to
manage faults is the focus of a comprehensive design approach to server and
network uptime. Compaq refers to this design as "Full-Spectrum Fault
Management." These fault management technologies provide you with the
ability to prevent faults before they happen, keep the system up and running in
case of an unlikely failure, or deliver rapid recovery to normal operation after
a fault condition.
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Full-Spectrum Fault Management is built into Compaq servers. Figure 3-2
illustrates the fault management process.

Fault Prevention Fault Tolerance Rapid Recovery

Predicts and

avoids failures

Keeps server

running in event

of component

failure

Quickly and

automatically

recovers from

critical failures

Figure 3-2.  Compaq Full-Spectrum Fault Management

The following subsections provide a detailed overview of the Compaq Server
Management technologies components:

■ Fault Prevention

■ Fault Tolerance

■ Rapid Recovery

■ Remote Maintenance

Fault Prevention

Compaq servers provide a fault prevention feature designed to predict and
avoid failures. Compaq Server Parameter Tracking forms the foundation of
Compaq server management. Server Parameter Tracking combines hardware,
firmware, and industry-standard management software. It provides timely
fault, performance, and configuration information for the critical processor,
memory, and I/O (storage and network interface) server subsystems and
server environment.

Server Parameter Tracking immediately notifies you of impending component
failures, enabling preventive maintenance that avoids server failures and
maximizes network uptime. For example, predictive storage subsystem
tracking warns you of impending failure, allowing you to replace the hard
drive or disk controller prior to failure.
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Fault Tolerance

Compaq servers also provide a set of fault-tolerant features designed to keep
the server up and running if a failure occurs. Compaq ProLiant servers come
standard with the "Hot-Pluggable Drive" capability. This feature allows you to
replace hard drives without interrupting server operation, thereby maximizing
server availability.

Compaq ProLiant servers also can include an "Off-Line Backup Processor."
The Off-line Backup Processor automatically reboots to a second processor if
the first processor fails.

These features complement additional capabilities such as Advanced Error
Checking and Correcting (ECC) Memory and the Compaq SMART SCSI
Array Controller to maintain a high level of server availability and ensure
data integrity.

Integration Management

Integration management is provided by the Compaq Integration Server, which
is a server that has been designated to supply operating system software,
database software, drivers, and patches to other devices over a network. When
a new or existing server is connected to the same network as the Compaq
Integration Server, the new server can obtain a fresh setup or an update to
existing software via the Compaq Integration Server.

See the Compaq Insight Manager User Guide for more information on
integration management.

Rapid Recovery

Compaq servers offer another important built-in capability to manage faults. If
a critical server failure occurs, the server can automatically recover. The
"Compaq Rapid Recovery Engine" is engineered into Compaq ProLiant
servers to diagnose and rapidly return the server to full operation. You can use
the Rapid Recovery Engine independently of other server management
products or you can use it with Compaq server management tools.
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The Rapid Recovery Engine performs several functions that can intelligently
and automatically restart the server without user intervention, including:

■ Server Health Logging

■ Capturing snapshots of the subsystem parameters that indicate failure
and placing them into nonvolatile health logs and history tables.

■ Automatic Server Recovery-2 (ASR-2)

❏ Restarting the server and resetting all option boards.

❏ Using the nonvolatile logs to recover, reconfigure, and
automatically correct failures to the processor and cache, memory
failures, and software errors.

Figure 3-3 illustrates how the Rapid Recovery Engine process detects and
resolves critical errors in your Compaq server.
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Figure 3-3.  Rapid Recovery Engine flowchart
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Server Health Logs

Server Health Logs store error information in nonvolatile memory so that
Compaq utilities and network administrators can retrieve and analyze the data
later. You can view the server health log contents using the Compaq Inspect
Utility or Compaq Insight Manager. By analyzing the data from the server
health logs, you can increase your efficiency in resolving current server
problems as well as prevent future server errors. The Compaq Diagnostics
software also uses the data from the server health logs to streamline its testing
and quickly pinpoint problems.

The server health logs include the following:

■ Critical Error Log  --  records catastrophic errors, such as
noncorrectable memory, expansion board, and expansion bus
arbitration errors. After a critical error occurs, the system ROM
indicates on bootup that an error has occurred and prompts you to run
Compaq utilities. The Critical Error Log contains the time, date, and
frequency of errors logged. When a critical error is logged, the server
can notify you when it reboots.

■ Corrected Error Log  --  contains the date, time, frequency, and unique
information about errors that the various subsystems have
automatically corrected, such as ECC Memory errors.

■ Power-On Error Log  --  records any errors that occur during Power-On
Self-Test (POST).

■ Revision History Table  --  stores board revision information in
nonvolatile memory. It logs the system board revision first and then
logs other boards that support the Revision History Table, such as the
Compaq SMART SCSI Array Controller, Compaq NetFlex-3
Controller, Compaq Fast-SCSI-2 Controller, Compaq Fast-Wide SCSI-
2 Controller, and Compaq IDA-2 Controller. When you upgrade your
server or when you add new expansion boards, the Revision History
Table logs this information. As you troubleshoot server problems, you
can use this information to determine if a change to the server
configuration has caused the server problem.

Refer to the appropriate Compaq server user guide for a more detailed
description of the server health logs.
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Automatic Server Recovery-2

Automatic Server Recovery-2 (ASR-2) intelligently restarts the server,
analyzes the server health logs, and automatically corrects many errors such as
processor, memory, server environment failures, and software errors. ASR-2
also informs network administrators by accessing a telephone pager to notify
them that a failure has occurred and that it has been corrected.

Table 3-1 describes the critical errors detected by ASR-2.

Table 3-1
Critical Errors

Type Description

Software Errors Catastrophic software errors that cause the server to
cease operation, such as operating system abnormal
termination or "hung" application software.

Memory Errors Memory errors that cannot be corrected and cause the
server operating system to cease operation.

Server Environment Errors Internal server temperature that exceeds the factory
preset threshold.

AC power failure (requires Compaq UPS).

Processor Board Errors Catastrophic failure of the system processor board.

Remote Maintenance

The Remote Maintenance feature allows you to diagnose errors and configure
the server from any location, either on the network or via modem. This option
is necessary only if the ASR-2 process cannot perform an automatic recovery.
During the initial system configuration process, these utilities are copied to a
special system utility partition on the hard drive.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
3-9

Integrating Compaq Insight Manager with Enterprise Management Platforms

Using remote maintenance requires:

■ An operating system with ASR-2 support.

■ Compaq System Configuration Utility 2.22 or later and Diagnostics
utilities installed locally on the system partition of the hard drive.

■ ASR-2 configured to load the Compaq utilities after the server restarts.

Using a Modem Connection

If you choose to perform remote maintenance using a modem, you must have:

■ A Hayes-compatible modem with the auto-answer feature installed in
the server. Compaq ProLiant servers have a management modem slot
that allows you to perform remote maintenance over the phone without
using an EISA slot.

■ A local terminal with VT100 or ANSI terminal capabilities or
management PC configured with Compaq Insight Manager 2.0 or later.

This arrangement provides the following capabilities:

■ The server can send notification to your pager.

■ You can dial-in to the server to perform remote control of Compaq
utilities running at the server.

Using a Network Connection

If you choose to perform remote maintenance over a network, you must have:

■ An NVT over IPX or Telnet over IP connection between the server and
the management PC.

■ An NVT over IPX or Telnet over IP feature configured and enabled on
the server’s system utility partition.

■ Compaq Insight Manager 2.20 or later, or an NVT over IPX or Telnet
over IP terminal emulator running on the network.

■ Your network connection enables you to perform remote control of
Compaq utilities running on the server.
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Compaq Desktop PC
Management Technologies

Compaq has forged close alliances with leading vendors of PC LAN
management applications and has leveraged server management technology
developed in the Compaq Systems Division. These relationships and expertise
have enabled Compaq to create hardware designs and management tools to
manage the Compaq Deskpro Family of PCs installed on networks.

The following subsections provide a detailed overview of the Compaq
Desktop PC management technologies components:

■ Intelligent Manageability

■ Inventory and Configuration Management

■ Fault Management

■ Rapid Recovery

■ Security Management

■ PC LAN Management Software Support

Intelligent Manageability

Intelligent Manageability is the industry-leading desktop management strategy
from Compaq that makes networked PCs easier to manage today and
tomorrow. Compaq is making enhancements to the basic PC hardware to
ensure that the PC is easier to inventory, to troubleshoot, and to protect.

These hardware enhancements are then complemented by a wide range of PC
LAN management software. Because this software is integrated and
compatible with Intelligent Manageability, it ensures that customers can easily
manage Compaq PCs over the network using the customer’s preferred PC
LAN management products.

Inventory and Configuration Management

Computing devices (PCs, servers, printers) and internetworking devices
(routers and bridges) are routinely added to the network to satisfy changing
business needs. The dynamic nature of these computing environments requires
customers to maintain an accurate inventory of the network and to configure
the devices rapidly for optimal operation.
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Inventory Management

Inventory management is a set of capabilities that provide comprehensive
hardware and software component identification and configuration reporting
to enable inventory and accounting procedures. This component identification
(inventory data) is also a prerequisite to distributing data files and
software, troubleshooting remote systems, and managing geographically
dispersed assets.

The Deskpro Family has integrated AssetControl features which allow
administrators to maintain an accurate, up-to-date and centralized inventory of
desktop PCs and their components. These features enable businesses to
maintain control of their PC assets and allow for effective and accurate
software distribution. The features also help streamline service calls because
the administrator can provide the service person with fast access to the PC’s
configuration and history.

Asset Information

The Deskpro Family features used in conjunction with a Compaq Desktop
Management Solutions Partner application make a wealth of useful asset
information available to the user and the network administrator. The available
information includes:

■ The manufacturer, model, and serial number of the PC system,
monitor, and hard drive.

■ An asset tag and the revision levels of the system board and system ROM.

Fault Management

Fault management is a set of capabilities that provide an early warning of
impending component or subsystem failure. This enables you to perform
preventive maintenance before the failure.

The current Compaq Fault Management implementation includes provisions
for IntelliSafe Hard Drives, environmental fault prevention tracking, and
network performance monitoring.
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IntelliSafe Hard Drive

An IntelliSafe Hard Drive is the next generation IDE/ATA drive and an ANSI
standard that was co-designed by Compaq and Conner, Quantum, and Seagate
(leading drive manufacturers). IntelliSafe Hard Drives contain enhanced
firmware that predicts an impending drive failure. System software, working
with the IntelliSafe hard drive, can notify users and LAN administrators of the
impending drive failure. When a failure is predicted, the hard drive can be
backed up automatically, either locally or over the network (with Windows 95
or Windows NT).

Environmental Fault Prevention Tracking

This is a hardware and software feature which tracks the internal temperature
of the PC and alerts the user and/or network administrator of excessively high
internal temperature. This alert enables you to take action before damage
occurs to data or internal components. Detection of system-damaging internal
temperatures automatically shuts off the power to the PC when the
temperature climbs far past the point when the initial warning occurred.

NOTE:  Environmental fault prevention tracking for Compaq Desktops is available
only in a Microsoft Windows 95 or Windows NT operating environment. For servers,
it is available for all the Compaq supported operating systems.
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Network Performance Monitoring

Using Compaq Insight Manager, a network administrator can monitor
and detect performance degredation of the integrated Network Interface
Controller (NIC).

NOTE:  Network performance monitoring is available only in a Microsoft
Windows 95 or Windows NT operating environment.

Rapid Recovery

Rapid Recovery is a set of capabilities that provide notification, rapid
identification of faults, and automated restart of failed systems or subsystems
so that unplanned downtime is minimized. The current Compaq Fault
Management implementation includes provisions for proactive tape backup,
flashing of ROM BIOS, and availability of accurate contact information.

Proactive Tape Backup

This feature provides added data protection from hard drive failure by
automatically backing up the PC hard drive contents to a local or server tape
drive when an impending failure is detected.

NOTE:   Proactive tape backup is available only in a Microsoft Windows 95 or
Windows NT operating environment.

Flash ROM BIOS

This allows quick updating of the system ROM without removing the PC
cover. If a system error requires an update of the system ROM, the flash ROM
capability of the Deskpro Family provides for a fast recovery by allowing the
ROM to be quickly updated via a ROMPaq utility.
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Accurate Contact Information

Accurate desktop PC information provided by AssetControl features allow the
network administrator to coordinate service responses for maximum
efficiency. When a hardware failure occurs, the AssetControl features enable
the network administrator to provide the service person with key information
such as the:

■ Model and revision level of  the PC and components
(automatically generated)

■ Specific problem, in some cases (automatically generated)

■ Location of the PC (manually set)

■ Contact person (manually set)

Security Management

Networked PC computing has increased the quantity of easily accessible
information that a corporation maintains. Ensuring that this information is
accessed only by authorized personnel and that the integrity of the information
and PC is maintained is critical in the information age. Security Management
is concerned with these issues and is comprised of capabilities to safeguard
and protect business-critical data and the PC.

Table 3-2 describes the comprehensive security features to protect critical and
confidential data and computing resources. All security management features
will be maintained under Microsoft Windows 95.

Table 3-2
Deskpro Family Security Features

Feature Function

Power-on Password Prevents unauthorized person from booting up the PC.

Setup Password Prevents unauthorized change of system configuration.

QuickLock/QuickBlank Allows user to lock keyboard and/or blank screen.

continued
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Deskpro Family Security Features   continued    
Feature Function

Keyboard Password Allows PC to boot up but prevents data input until the
password is entered.

Network Server Mode Allows hard drive or network restart while keyboard
is disabled.

Diskette Boot Control Prevents PC from being booted from a floppy diskette.

Diskette Write Control Prevents unauthorized writing of data to floppy diskette.

Flash ROM Lock Uses the Setup Password to prevent unauthorized changes to
the system ROM.

Parallel Interface
Control

Prevents transfer of data through the parallel
interface connector.

Serial Interface Control Prevents transfer of data through the serial
interface connector.

Diskette Drive Control Allows disabling of the diskette drive.

Fixed Disk Drive
Control

Allows disabling of the hard drive.

U-bolt/Cable Lock
Provision

Allows user to secure PC hardware and protect against theft.
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PC LAN Management Software Support

Compaq is taking a proactive initiative to ensure the compatibility and
integration of PC hardware enhancements for manageability with the leading
vendors of PC LAN management products. This initiative is called the Compaq
Desktop Management Solutions Partners Program. The Solution Partners’
products deliver features demanded by network administrators such as server and
client monitoring, network protocol analysis, software distribution, and software
and hardware inventory.

Compaq Desktop Management
Solutions Partners Program

Compaq has worked closely with leading management software vendors to
provide remote access to the Intelligent Manageability capabilities of the
Deskpro Family. The broad vendor support ensures that Compaq customers can
easily manage Compaq PCs using their choice of tools.

Vendors currently participating in the Compaq Desktop Management
Solutions Partners Program include:

■ Asset Software International

■ Bindview Development

■ Cheyenne Software, Inc.

■ Intel Corp.

■ McAfee Associates, Inc.

■ Microsoft Corp.

■ Novell, Inc.

■ Seagate Enterprise Management Software

■ Seagate Storage Management Group

■ Symantec Corp.

■ Tally Systems Corp.
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Solutions Partners Operating
System Support

The Solutions Partners’ products provide remote AssetControl support across a
wide range of operating environments. This increases the probability that one of
the Solutions Partners will have a solution to meet the customer’s needs.

Support is available for client PCs using Windows 3.1, Windows NT, and
Windows 95. These clients are supported across a wide range of network
operating systems, including Windows NT, NetWare, LAN Manager, and LAN
Server. Customers must contact specific Solutions Partners to determine the
range of support in their particular environment.

Compaq Insight Manager and the
Desktop Management Solutions
Partners Program

When used with the Deskpro Family, Compaq Insight Manager and the
Solutions Partners’ products are complementary. Compaq Insight Manager
functions primarily as the remote hardware and fault management tool. The
Solutions Partners’ products handle remote inventory management, software
distribution, and so on.

Although Insight Manager does provide access to all of the Deskpro Family
AssetControl information, Insight Manager is primarily a fault management
tool providing both IntelliSafe hard drive and thermal monitoring and alerting.
Insight Manager is designed to monitor Compaq hardware only.

The Solutions Partners’ products are primarily asset management tools which
can provide asset management reports for a range of hardware. The products
also might include features such as software distribution, software license
metering, and remote workstation control. Although the Solutions Partners’
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products are designed to manage almost any PC hardware, only the Deskpro
Family provides detailed asset information such as serial numbers and monitor
information.

NOTE:  Customers must contact specific vendors to gain an up-to-date status on
individual product capabilities.

Compaq Insight Manager Software
The Compaq Insight Manager Software architecture is typical of other
SNMP-based management software and is composed of Compaq Insight
Manager, Compaq Insight Management Server Agents, Compaq Insight
Management Desktop Agents, and the Compaq Inventory Collector.

The agent software executes on a manageable device such as a server or
desktop and monitors the fault and performance aspects of the device. These
monitored statistics, along with device configuration information, provide data
to a management application using the SNMP protocol.

Manager software, such as Insight Manager, provides the user interface to the
management features in Compaq servers. You can integrate the Insight
Management Server Agents with SNMP-based management platforms to
manage Compaq servers.

Inventory Collector software creates Management Information Format (MIF)
files from information gathered by the Insight Server Agents software.

The following subsections provide a detailed overview of the Compaq Insight
Manager software components:

■ Compaq Insight Manager

■ Compaq Insight Management Agents

■ Compaq Management Information Base

■ Compaq Inventory Collector
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Compaq Insight Manager

Compaq developed Insight Manager to make the overwhelming task of system
monitoring and management easy. Insight Manager delivers intelligent
monitoring and alerting, remote maintenance, and visual control of the
systems in your network environment. In the unlikely event of server failures,
Insight Manager provides a full spectrum of remote maintenance and control
facilities such as system rebooting, system configuration, and system
diagnostics.

Insight Manager provides timely server status and the means for remotely
controlling servers through the following key features:

■ Comprehensive Fault Management

 Insight Manager provides comprehensive fault management for all
major subsystems, including pre-failure alerting for disks, memory, and
PentiumPro processors.

■ Integration Management

 Insight Manager, together with SmartStart, allows you to effectively
deploy and manage configurations throughout the enterprise using the
Integration Server and Insight Version Control.

■ Performance Management

 Insight Manager allows you to set performance and capacity thresholds
for management variables related to CPU and bus utilization, NIC
throughput, logical disk capacity, and more.

■ Client Management

 Insight Manager allows you to manage faults and assets on Compaq
Deskpro’s.

■ Asset Management

 Insight Manager allows you to export asset information from the
Insight Manager database to leading database and spreadsheet
applications, making asset management easier than ever.
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■ Remote Management

 Insight Manager allows you to manage in-band or out-of-band servers
online or offline from anywhere.

■ Reporting

 Using Automatic Data Collection, Insight Manager allows you to
gather historic performance information for graphing or export
purposes, helping with upgrade performance.

■ Integration with Enterprise Management Platforms

 Insight Manager provides integration with leading management
platforms including HP OpenView, IBM NetView, SunNet Manager,
ManageWise, and Microsoft Systems Management Server.

Additional Compaq Insight Manager features include:

■ Ability to configure the primary UPS server with the network address
of secondary servers so if an impending power outage occurs all server
gracefully shutdown.

■ Support for tape drive management on NetWare 3.12 and 4.x as well as
Microsoft Windows NT 3.51.

■ Ability to recover information from a primary server in the event of a
server failure. This feature is known as Standby Recovery Server.

■ Support for Windows Internet Naming Service (WINS) and
Dynamic Host Configuration Protocol (DHCP).
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Insight Manager adheres to the following standards:

■ Management Protocol  --  SNMPv1 running over IPX, IP, or PPP

■ Compaq Insight Management MIB  --  all possible manageable objects
specific to Compaq hardware

■ Standard Internet MIBs  --  support information from MIB-II, Token
Ring MIB, and Ethernet MIB

Additionally, Insight Manager stores gathered object information in a Paradox
database. You can retrieve this information using Insight Manager or one of
several commercially available applications that can access Paradox data.

Compaq Insight Management Agents

Insight Management Agents consist of server and desktop software that
integrates Compaq manageability into SNMP-based management
environments. Insight Agents perform in-depth monitoring of the fault and
performance aspects of the key subsystems: storage, memory, system
processor, network interface, and the environment. Insight Agents provide this
information, along with system configuration, to SNMP-compliant
management applications such as Insight Manager. In addition, Insight Agents
can generate traps to notify the administrator of significant changes in the
fault or performance aspects of the computer operation. With these traps, you
can proactively manage the computer, minimize unplanned downtime, and
maximize performance.

Insight Server Agents support Microsoft Windows NT, NetWare, SCO
OpenServer, UnixWare, IBM OS/2, Banyan VINES, and UNIX. Insight
Desktop Agents support Windows NT and Windows 95. For more information
about the Insight Server Agents for a particular operating system, refer to the
appropriate Compaq Insight Management Server Agents User Guide.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
3-22    Compaq Management Technologies

Compaq Management
Information Base

A management information base (MIB) is a description of a set of manageable
objects. A manageable device can implement one or more MIBs, depending
on its function. A Simple Network Management Protocol (SNMP) MIB,
which Compaq fully supports, is very similar to a database schema in that it
describes both the structure and format of a set of data. The Internet-assigned
Compaq enterprise ID is 232.

Figure 3-4 shows the location of the Compaq enterprise ID in context within
the Internet Naming Tree.

CCITT(0) ISO(1) CCITT/ISO(2)

Standard(0) Author(1) Member-Body(2) Org(3)

DOD(6)

Internet(1)

Directory(1) Mgmt(2) Experimental(3) Private(4)

MIB(1) Enterprise(1)

Compaq (232)
SER019.ai

FIG3-3.eps

Figure 3-4.  Internet naming tree with Compaq Enterprise ID (232)

The Compaq enterprise ID (232) specifies the location of the Insight MIBs
within the Internet Naming Tree. The Insight MIBs are modular, with each
subbranch from the Compaq enterprise ID representing a distinct function or
subsystem supported by the Insight Server Agents.
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Due to the constant changing, updating, or adding of Insight MIBs, Table 3-3
shows a list of only the most current MIBs:

Table 3-3
Most Current MIBs

MIB Describes . . .

Standard PC Equipment
Configuration

Information that can be configured on an PCI,
ISA, or EISA system

System Information Specific Compaq features such as security, and
asset management

Intelligent Drive Arrays Compaq Drive Array Controllers

SCSI Devices Compaq SCSI interface products

Server Health Features that monitor server health, such as
thermal sensing

Drive Storage Systems Compaq ProLiant Storage System

Management Engine Software components to track statistics,
generate alarms, and more

Host OS Information
Generic host OS information, for example,
system processor utility and file system
information

Uninterruptible Power
Supply Information

Compaq UPS

Although the Insight MIBs are organized according to subsystem, your
management application can organize the display of the data from the
managed devices to convey the most usable presentation. See the Compaq
TechNote, Integrating Compaq Insight Manager with Enterprise Management
Platforms, for more detailed information about Insight MIBs.
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Compaq Inventory Collector

The Compaq Inventory Collector program defines the set of manageable
objects known to Systems Management Server. These files follow the
Management Information Format (MIF), which is a subset of the MIF
Specification authored by the DMTF. As a result, the Compaq MIF files, and
all MIF files written for Systems Management Server, gather static
information only and ignore dynamic information. The DMTF MIF
Specification has provisions to obtain dynamic information from a MIF file.

The Compaq MIF files are modular, with each file representing a distinct
function or subsystem supported by the Insight Management Server Agents for
Microsoft Windows NT. The Compaq Inventory Collector creates the MIF
files from the information gathered by the Insight Server Agents. Table 3-4
consist of the MIF files.

Table 3-4
MIF Files

Type Describes . . .

Compaq CPU Information on all CPUs in the Compaq system

Compaq EISA/PCI Slots Configuration information on EISA/PCI boards in the
Compaq system

Compaq System Asset information on the Compaq system

Compaq Memory Modules Memory modules installed in the Compaq system

Compaq Software Versions Versions for all Compaq software installed on a
Compaq system

Compaq Drive Array
Controllers

Information on the Drive Array controller installed in a
Compaq system

Compaq Drive Array Logical
Drive

Information on all logical drives configured on a Drive
Array in a Compaq system

Compaq Drive Array
Physical Drive

Information on all physical drives installed on a Drive
Array in a Compaq system

continued
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MIF Files  continued    
Type Describes . . .

Compaq Health Subsystem Configuration information on the health subsystem for a
Compaq system

Compaq Storage System Information on the Compaq Storage System installed on a
Compaq system

Compaq UPS Subsystem Information for any Compaq manageable UPS attached to
a Compaq system

Compaq SCSI Devices Information on all SCSI devices, including adapters, in a
Compaq system

Table 3-4 shows all the possible MIF files that might be created by the
Inventory Collector. However, every subsystem or function might not be
present in a given system. As a result, there may be fewer tables displayed by
Systems Management Server.

Integration with Operating
System Management

A complete, SNMP-based, server management solution requires developing
capabilities that provide server hardware and software management for
operating systems and applications. Insight Server Agents take advantage of
the extensible SNMP agents provided by Microsoft, Novell, the Santa Cruz
Operation (SCO), IBM, and Banyan. Developing agents according to the
extensible agent specification ensures that Compaq hardware management
technologies integrate with the server and desktop software management.
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Network Management
Interoperability

Delivering hardware management technologies that integrate with your
SNMP-management environment is as important as building the management
technologies themselves. Compaq servers can satisfy your management
interoperability requirements.

Compaq servers and Compaq Insight Management Software integrate within
your preferred management environment. Compaq adheres to network
management standards.

Compaq servers provide an extensive set of MIBs which can be used in a full
range of environments from a one-server LAN to a globally dispersed
enterprise. Because the information is available through SNMP, it is available
to point solutions on the LAN for small installations all the way up to complex
WAN/LAN enterprises. As your single network LANs grow into larger routed
LANs and then into internetworked WANs, you can be sure that Compaq
information will grow with you and support your management needs.
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Chapter 4
Integration with
IBM NetView for AIX

This chapter discusses the integration of Compaq server management
information into IBM NetView for AIX. The information is based on tests
performed with Version 3 Release 1 and Version 4 Release 1 in the Compaq
Systems Management Solutions Lab.

NOTE:  In this chapter, several examples involve IP addresses. These addresses are
denoted in the examples as X.Y.<number>.<number>, where X.Y. represents a
Class B network address and <number> is a value from 0 to 255.

Feature Summary
IBM NetView for AIX is an internetwork and enterprise-wide management
platform that provides a network management solution for multivendor
devices and open networks requiring SNMP.  The following are some key
features of IBM NetView for AIX:

■ A distributed management infrastructure that supports various
management protocols such as SNMP and CMIP.

■ Management services such as event management services and object
recognition services. You can use Application Program Interfaces (APIs) to
access some of these services.

■ An X Windows- and Motif-based management application that manages a
variety of devices such as hubs, bridges, routers, and servers. The platform
architecture allows integration of applications from IBM and third parties.

The following are some key features of the standard management application:

■ A Management Information Base (MIB) load utility that lets you add
MIB definitions for new device types in your network.

■ Node discovery that can seek out, identify, and display managed IP devices.

■ A graphical map representing the topology and status of managed devices.

■ MIB browsing and results graphing tools.

■ Methods to integrate new applications without programming.
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Adding Compaq Insight Agent Support
The Compaq Management CD includes the Compaq Systems Management
Toolkit which can be found in the \TOOLKIT directory.  The Systems
Management Toolkit includes files which can be used to integrate the
management of Compaq Insight Agents into IBM NetView for AIX. These
include the Compaq MIBs, icon files, trap definitions, and files to add
Compaq-specific query applications.  Please refer to the file README.TXT in
the \NV_AIX directory located in the Systems Management Toolkit for
additional integration information.

NOTE:  If you will be accessing the files in the Systems Management Toolkit
using a Compaq Integration Server the directory tree is:
\\servername\CPQIS1\CPQIS\TOOLKIT\ver_no\

where servernameis the name of the Integration Server

and ver_no is the version of the Toolkit.

Adding support for Compaq Insight Agents into NetView for AIX consists of
the following steps:

1. Transfer the MIB files to the NetView for AIX console.

2. Load the MIB files into NetView for AIX.

3. Discover or add your servers and desktops to the network map.

4. Add new managed device types for Compaq servers and desktops.

5. Transfer the Compaq server and desktop icon files to the NetView for
AIX console.

6. Transfer the custom MIB query application files to the NetView for
AIX console.

7. Setup Compaq traps in NetView for AIX.

The following sections discuss each of these steps in detail.
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Transferring MIB Files to
the NetView for AIX Console

Compaq includes Insight MIB files with the Insight Agents for your operating
system. These files define the information structure that the NetView for AIX
console requires to retrieve information from the agents. The file names are
CPQ?????.MIB where ????? denotes four or five unique characters. Two
optional MIBs, ETHER.MIB and TOKEN.MIB, are included with the Compaq
Systems Management Toolkit in the \MIBS directory.

There are several ways to transfer the Insight MIB files from the Compaq
Management CD to your NetView for AIX console.  If you have a CD-ROM drive
on your console you may mount the CD to a local file system and then copy the
files directly from the CD.  Alternatively, the CD may be mounted remotely as an
exported file system using the Network File System (NFS). Consult the AIX
documentation for information on using the CD-ROM drive and NFS.

Another method for transferring files between systems is to use the File Transfer
Protocol (FTP). The default path that NetView for AIX uses for MIBs is
/usr/OV/snmp_mibs.

NOTE:  FTP is available with Windows NT, SCO UNIX, UnixWare, and IBM OS/2
installations. For NetWare, you must transfer the files from a NetWare client that has
TCP/IP support using software such as LAN Workplace for DOS. Be sure to choose ASCII
file transfer mode.
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The following is an example of a typical FTP transfer.

C:\users\default>ftp hostname
Connected to hostname
220 hostname FTP server ready.
User (hostname:): root
331 Password required for root.
Password:
230 User root logged in.
ftp> send
(local-file) D:\TOOLKIT\MIBS\CPQIDA.MIB
(remote-file) /usr/OV/snmp_mibs/CPQIDA.MIB
200 PORT command successful.
150 ASCII data connection for /usr/OV/snmp_mibs/CPQIDA.MIB
X.Y.24.20,1031).
226 ASCII Transfer complete.
128553 bytes sent in 8.21 seconds (15.67 Kbytes/sec)
ftp> quit
221 Goodbye.
C:\users\default>

In the example above, the file was transferred from the CD in drive D to the
directory /usr/OV/snmp_mibs on the target system.

Loading the MIB Files

Once you have the MIB files on your NetView for AIX console, follow this
procedure to load them into your NetView for AIX configuration:

1. Select the Option→Load/Unload MIBs: SNMP... menu item. A dialog
box displays that lists the currently loaded MIBs.

2. Click on the Load button. A dialog box displays listing the MIB files in
the default directory. If you transferred the Insight MIBs to this
directory, they should be listed here (otherwise, specify the pathname
where you put the files).

3. Highlight the desired MIB file and select Load.... The Insight MIB
automatically loads and the Load/Unload MIBs dialog box redisplays.
Repeat this step until you load all the Insight MIB files.
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4. Select the Close button to exit.

 The Insight MIB files should compile without any errors. If the console
displays error messages, do the following:

❏ Check the messages to determine which line(s) in the file contain
the error(s).

❏ Check your file transfer procedure to verify that you transferred
the file without problems. For example, you might have transferred
them in binary format rather than in ASCII. In this case you must
convert the DOS file formats to UNIX formats. Refer to your
UNIX documentation for the appropriate command and syntax.

Refer to the NetView for AIX User’s Guide under the topic "Loading and
Unloading MIBs" for additional information.

NOTE:  NetView for AIX ships with several preloaded MIBs (both enterprise and
standard). These MIBs are in the default directory /usr/OV/snmp_mibs.

Discovering or Adding Compaq Systems
to the Submap

You can add Compaq systems to your database manually or automatically by
using the Discover tool. The following sections contain instructions for both
methods.

Automatic Discover Tool

The NetView for AIX netmon process discovers (and subsequently polls for
status) new managed devices on the network. Typically, this process does not
require your intervention except to ensure that the routing tables at the NetView
for AIX console are set up properly with the default gateway enabled.
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The initial management region contains only the networks directly connected
to the management station.  You can expand this region two ways:

■ Interactively expand the management region using the graphical map’s
Options→Manage Objects operation.

■ Provide a “seed file” that contains the IP addresses of SNMP-based
routers on your network.

For further details, refer to the netmon Reference Page (man page) or to the
NetView for AIX User’s Guide under the topic "Using a Seed File to Control
Network Discovery."

As the netmon process executes, it automatically adds new managed devices
to the appropriate submaps. For instance, when you install Compaq servers on
the network, the Discover tool automatically adds symbols to the view
representing them as managed devices. This assumes that the servers are
operational and configured to use IP, SNMP, and the Insight Agents.

If the new device appears in the /etc/hosts file, NetView for AIX translates the
IP addresses of the servers to hostnames. Otherwise, the symbol label on
screen contains only the IP address.

The netmon process uses, by default, the file named /usr/OV/conf/oid_to_type
to determine the topological role of the discovered managed devices (gateway,
bridge, hub, and so on). The netmon process queries the SNMP MIB-II
variable system.sysObjectID to find a match between the value returned by the
SNMP agent running on the managed device and an entry in the file. If there
is a match, the symbol on the submap displays with the proper icon
representing the properties (gateway, bridge, hub, and so on). If there is no
match, the discovery process tries to classify the discovered managed devices
into generic symbol classes representing computers, connectors, network
devices and so on.

NOTE:  Each symbol class has subclasses that provide further description. For
example, the Computer class can have subclasses that describe PCs, workstations,
minis, and mainframes.
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The discovery process automatically represents Compaq servers on screen as a
square symbol. This is a generic subclass of the Computer class. Details on
modifying the subclass to a Compaq server are provided later in this chapter.

Manual Discovery

You can manually add a symbol representing a Compaq server using the
Edit→Add Object... command. Temporarily create a symbol representing a
generic subclass in the Computer class, and change the subclass after you
create a subclass specifically for a Compaq server (this is described later). To
add a symbol, add the object first (an on-screen representation of the object).
Refer to the NetView for AIX User’s Guide under the topic "Adding Objects
and Symbols."

Changing the Subclass Icon

You can change the subclass to represent servers and clients accurately. For
the servers, you must create the subclass first (discussed later in this section).
For clients, you can change the subclass type from generic to a PC. NetView
for AIX ships with a subclass icon representing a PC. To change the subclass
icon, perform the following procedure:

1. Select the object for which you want to change the icon subclass.

2. Select button 2 to bring up the symbol pop-up menu.

3. From the pop-up menu, select Edit→Change Symbol Type...
The Change Symbol Type dialog box appears.

4. Select a new symbol subclass.

5. Click OK.  The dialog box closes and the symbol changes to the chosen
symbol type.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
4-8    Integration with IBM NetView for AIX

Adding a New Subclass to
the Computer Class

Adding a new subclass for a Compaq system involves:

■ Modifying Field Registration files

■ Creating bitmap files to represent Compaq systems

■ Defining a Symbol Subclass in the Symbol Registration file

■ Modifying the configuration files

Each of these processes is discussed in detail.

Modifying Field Registration Files

NetView for AIX extensively uses field definitions, stored in Field Registration
files. You can find these files in the directory /usr/OV/fields/$LANG, where
$LANG represents language-specific information. For default installations,
$LANG is defined as “C”. You can usually find the Field Registration files in the
directory /usr/OV/fields/C. The two Field Registration files of interest are
ovw_fields and snmp_fields.
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The ovw_fields File

This defines the overall field definitions used by the NetView for AIX.  Edit
this file to update the vendor enumeration listing by adding "Compaq" to the
list as follows:

Field "vendor" {
        Type    Enumeration;
        Flags   capability, general, locate;
        Enumeration "Unset",
                "Hewlett-Packard",
                "ACC",
                "Cayman",
                "cisco Systems",
                "CMC",
                "Compaq", ←← Add this line.
                "Data General",
                "DEC",

<other names follow here>
                "Xyplex"
                ;
}

Edit the file by adding a new field called isCpqInsight, signifying whether a
given managed device is running the Insight Agents. Append the following to
the end of the file:
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/*****
 ***
 *      This field defines if the system is running
 *      Compaq Insight Management Agents
 ***
 *****/
Field "isCpqInsight" {
        Type    Boolean;
        Flags   capability, locate;
}

The snmp_fields File

This contains various SNMP-related fields. Update the SNMP Agent
enumeration listing by adding "Compaq Insight Management Agents" to the list
as follows:

Field "SNMPAgent" {
        Type Enumeration;
        Flags   capability, general, locate;
        Enumeration
                "Unset",
                "HP 3000/XL",
                <various HP agents follow here>
                "ACC 4140 Bridge/Router",
                "cisco Gateway Server",
                "cisco Terminal Server",
                "cisco T-Router",
                "cisco Protocol Translator",
                "Cayman GatorSystem",
                "CMC",
                "Compaq Insight Management Agents",      ←← Add this line.
                "DECstation",
                "DG Aviion",

             <other vendor agent names follow>
                "Xyplex Remote Ethernet Bridge",
                "4BSD ISODE";
}
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Incorporating the Changes

After making your changes, verify them as follows:

nv6000 -verify

The screen scrolls with the verified items, until it displays a "Verification
complete" message.

To prevent the screen from scrolling by too fast for you to read the messages,
use the more command:

nv6000 -verify | more

If you have any errors, correct them and try again. When you have no errors,
you can add the new fields to the database by entering the following
command:

nv6000 -fields

This verifies the field syntax for fields that exist in the database and adds the
new fields. For further details, refer to the NetView for AIX Programmer’s
Guide under the topic "Creating Fields."
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Creating Bitmap Files to
Represent Compaq Systems

Compaq provides bitmap files to represent Compaq servers and desktops in
the subdirectories located in \NV_AIX\ICONS in the Compaq
Systems Management Toolkit.  Refer to the README.TXT file in the
\NV_AIX directory of the Toolkit for more information.  You can transfer
these files to your NetView console by using one of the methods described
previously in this chapter.  If you use these files, the following procedure to
create bitmaps manually is not required.

NetView for AIX represents objects as symbols. Each symbol has a class (such
as Computer) and a subclass (such as PC). The class has a shape associated with
it. For example, computers are represented as squares, networks as circles, and
so on. Within each class, the subclass has a bitmap representation, enclosed by
the class shape. A PC bitmap surrounded by a square represents a PC on-screen,
denoting that it is a member of the Computer class. To define a new subclass for
a Compaq server, you must create bitmap files of the proper size.

Bitmap files are always in pairs, containing the bitmap and a bitmap mask
used as a stencil. These files follow the name syntax:

filebase.size.type

Where filebase is the name of the subclass, size is the size in pixels, and type
denotes if this is a bitmap or a bitmap mask. The type is always a "p" for
bitmaps or an "m" for masks.

You can find bitmap files in the directory /usr/OV/bitmaps/$LANG, where
$LANG represents language-specific information. For default installations,
$LANG is defined as “C”. You can usually find the Field Registration files in the
directory /usr/OV/bitmaps/C.

You can use the icon or bitmap editor program supplied with your system to
create the icon files and their masks. The following figures illustrate the bitmap
and its corresponding mask for a Compaq server with a size of 38 x 38 pixels.
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Figure 4-1.  Bitmap for a Compaq server (38 x 38 pixels)
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Figure 4-2.  Bitmap mask for a Compaq server (38 x 38 pixels)

NOTE:  IBM recommends defining bitmap files with the following sizes (in pixels):
20 x 20, 26 x 26, 32 x 32, 38 x 38, 44 x 44, and 50 x 50. You must have at least
one pair of bitmap files (icon and mask file) of a particular size.

For further details, refer to the NetView for AIX Programmer’s Guide under
the topic "Creating Bitmaps for AIX NetView for AIX Symbols."
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Defining a Symbol Subclass in
the Symbol Registration File

NetView for AIX extensively uses field definitions, stored in Symbol Registration
files. You can find these files in the directory /usr/OV/symbols/$LANG, where
$LANG represents language-specific information. For default installations,
$LANG is defined as “C”. You can usually find the Symbol Registration files in
the directory /usr/OV/symbols/C.

You can find several files for symbol classes here, including one for the
Computer class. Edit the Computer Symbol Registration file to add the
following subclass definitions:

SymbolType "Computer" : "Cpqsrvr"
{
        Filebase "cpqsrvr";
        CursorSize 38;
        Capabilities {
                isPC = 1;
                isCpqInsight = 1;
        }
}

SymbolType "Computer" : "Cpqwkst"
{
        Filebase "cpqwkst";
        CursorSize 38;
        Capabilities {
                isPC = 1;
                isCpqInsight = 1;
        }
}

NOTE:  The filebase name must match the filebase name of the bitmap files you
created earlier.
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Incorporating the Changes

After making your changes, verify them by entering the following command:

nv6000 -verify

The screen scrolls with the verified items, until it displays a "Verification
complete" message.

To prevent the screen from scrolling by too fast for you to read the messages,
you can use the more command:

nv6000 -verify | more

If you have any errors, fix them and try again. You can also compile your
previously defined bitmap files by entering the following command:

nv6000 -config

For further details, refer to the NetView for AIX Programmer’s Guide under
the topic "Defining Symbol Subclasses."
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Modifying the Configuration Files

NetView for AIX uses configuration files to map the SNMP MIB-II
system.sysObjectID variable to symbol types. The two configuration files of
interest are oid_to_sym and oid_to_type. Read the NetView for AIX
Installation and Configuration Guide under the topic “Editing the oid_to_sym
file” and “Editing the oid_to_type file” for more details of the contents of the
files. Before editing these files, ensure that the NetView for AIX End User
Interface (EUI) is not running.

IMPORTANT:  Compaq servers without Insight Agents and other Intel-based servers
running SNMP agents that return MIB-II information, incorrectly identify themselves as
Compaq servers with Insight Management capabilities. This occurs because the
system.sysObjectID returned by the agent is network operating system dependent, not
hardware dependent. For such servers, you must manually modify their symbols to
represent computers with no Insight Management capabilities. This affects only new
servers you add to the network after making changes.
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The oid_to_sym File

This file is in the $LANG subdirectory under the directory /usr/OV/conf, where
$LANG represents a language-specific configuration. By default, the file
oid_to_sym is in the directory /usr/OV/conf/C.
The NetView for AIX process ipmap uses this file to match against the
system.sysObjectID returned by an agent. Because Insight Agents are based on
the network operating system, you must add entries for each operating system
that has Insight Agents available. For example, for NetWare, Windows NT,
SCO UNIX, UnixWare, Win 95, and OS/2, you must edit the file and append
these entries:

1.3.6.1.4.1.23.1.6:Computer:Cpqsrvr # NetWare
1.3.6.1.4.1.23.1.6.3.11:Computer:Cpqsrvr # NetWare 3.11
1.3.6.1.4.1.23.1.6.3.12:Computer:Cpqsrvr # NetWare 3.12
1.3.6.1.4.1.23.1.6.4.10:Computer:Cpqsrvr # NetWare 4.10
1.3.6.1.4.1.311.1.1.3.1:Computer:Cpqsrvr # Windows NT
1.3.6.1.4.1.232:Computer:Cpqsrvr # SCO UNIX
1.3.6.1.4.1.23.1.13.2:Computer:Cpqsrvr # UnixWare 2.10
1.3.6.1.4.1.311.1.1.3.2:Computer:Cpqwkst # Win 95
1.3.6.1.4.1.2.6.46:Computer:Cpqsrvr # OS/2

NOTE:  The fields Cpqsrvr and Cpqwkst must match the new symbol types defined
earlier.
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The oid_to_type File

This file is in the /usr/OV/conf directory. The NetView for AIX process
netmon uses it to match against the system.sysObjectID returned by an agent.
Because Insight Agents are based on the network operating system, you must
add entries for each operating system that has Insight Agents available. For
example, for NetWare, Windows NT, SCO UNIX, and OS/2, you must edit
the file and append these entries:

1.3.6.1.4.1.23.1.6:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.6.3.11:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.6.3.12:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.6.4.10:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.311.1.1.3.1:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.311.1.1.3.2:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.232:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.13.2:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.2.6.46:Compaq:Compaq Insight Management Agents

NOTE:  The fields Compaq and Compaq Insight Management Agents must match the
vendor and SNMP agent field enumerations defined earlier in the Field Registration files.

Incorporating the Changes

After you make the changes, reinitialize NetView for AIX to startup. The
changes that you made are now incorporated into your NetView for AIX
configuration. For each Compaq server, change the symbol subclass to
represent the server bitmap defined earlier. If you have not done so, change
any generic computer symbols to represent any PC clients in your network.
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Adding Custom Applications
Through the use of registration files, you can add items to the NetView for
AIX menus which can display and graph collected information to suit your
needs. Applications can design simple on-screen reports or more sophisticated
reports that place specific information in a window.  You can also build MIB
applications for on-screen reporting using the Application Builder or use the
Application Registration files for complex operations that require other
background processes to run.

Some examples are given in the following sections. One example uses the
Application builder, the other uses the Application Registration file. You can
use these as sample applications to build your own.

In addition, Compaq has included several Application Registration files in the
Compaq Systems Management Toolkit. When integrated into the NetView for
AIX system, these files allow you to gather and display important information
about your Compaq systems.
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Adding the Compaq Query Files

Compaq includes Application Registration files in the Compaq Systems
Management Toolkit. These files implement queries for the data that is
described in Appendix A, “Using the Compaq MIB Information.” An
explanation of data contained in these items is given in this Appendix.

The Application Registration files for Compaq servers and desktops are in the
subdirectories in \NV_AIX\ARF in the Systems Management Toolkit.  These files
are named <filename>.ARF where <filename> denotes an MS-DOS filename
base. The path that NetView for AIX uses to store Application Registration files
is /usr/OV/registration/C. You can transfer these files to your NetView console
by using one of the methods described previously in this chapter.

After you copy the MIB Query Application Registration Files to the NetView
for AIX console, you must restart the NetView for AIX application to activate
the files. When NetView for AIX restarts there are two new menu items under
the Monitor menu item:  Compaq Server and Compaq Workstation.

To use the queries, select a Compaq system from a map then choose an item
from the Monitor→Compaq Server or the Monitor→Compaq Workstation
menu. A window displays the information in a labeled table that corresponds
to the item you selected.  The menu items correspond with the various
categories of information described in Appendix A, “Using the Compaq MIB
Information”.

If you choose not to use the query files, the following sections provide
examples of obtaining the information manually.
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Slot Configuration Information

One common requirement is to obtain configuration information on your
Compaq server; for example, information on the controllers you installed in a
server. Because the Insight Agents provide you with EISA slot information, it
is easy to build an application that retrieves the configuration information and
displays it as a table. To do this, follow these steps:

1. Select Tools→Application Builder: SNMP ... from the Main menu bar.
The MIB Application Builder dialog box appears.

2. Type the name of the application in the Application ID field:

Compaq.SlotCfg

 The information is stored in this file.

3. Select Table from the choices displayed to specify the application type.

4. Enter a suitable title for your application, such as:

EISA Slot Configuration

5. Select the Add button. The MIB Application Builder/Add MIB Objects
dialog box displays.

6. Navigate the MIB tree to select elements from the appropriate table.
The path to the information is:

Private
Compaq

Standard Equipment
Component

EISA NVRAM
EISA Slot Table

EISA Slot Entry
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7. Select the following fields from the table:

EISA Slot Index
EISA Slot Board ID
EISA Slot Board Name

 These fields identify the slot number, EISA ID, and board description
respectively. For each highlighted field, select Apply. This adds the
field to the Display Fields list. (You have the option to edit the label
and width fields to suit your needs.)

8. Specify the menu path using "→" to create cascading menus. For
instance:

Monitor→Compaq→EISA Slot Configuration

9. Enter the selection rule to determine the conditions for highlighting
menu items that are available to the user to execute. The default is:

(isSNMPSupported) || (isSNMPProxied)

 You can override this to specify only servers with Insight Agents as in:

(isSNMPSupported) && (isCpqInsight)

10. You can also add help text to provide assistance for using this
application. When completed, you should see a window similar to
Figure 4-3:
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Figure 4-3.   Building an application for EISA configuration information

11. Click on the OK button to add the application.
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12. Return to the menu bar to view the application menu choice in the path
set up in step 8 of this procedure.

13. Highlight a Compaq server and execute the application to verify the
application. You should see a display similar to the following.

Slot Ind   Board ID    Board Name

 0 CPQ0109 COMPAQ SYSTEMPRO System Board (ASSY # 001981)
 1 CPQ4001 COMPAQ 32-Bit Intelligent Drive Array Controller
 2 NVL0701 Novell NE3200 Bus Master Ethernet
 3 (Empty)
 4 (Empty)
 5 (Empty
 6 (Empty)
 7 CPQ6100 COMPAQ 32-Bit NetFlex Controller
 8 CPQFA0D COMPAQ 32-Bit 4-Socket System Memory Board
 9 (Empty)
10 (Empty)
11 CPQ9999 COMPAQ 486/33 System Processor Board used as Primary

Getting Contact Information
From an Offline Device

Another common requirement is the need to retrieve node contact information
on an offline device, such as location, contact person, and so on. SNMP MIB-
II compliant agents provide this information, which you can easily retrieve
when the managed device is online. However, this method does not work when
the device is offline.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
4-26    Integration with IBM NetView for AIX

NetView for AIX provides a solution: The NetView for AIX IP Topology
database contains information, on a per-object basis, of the IP address, contact
name, location, and so on. This database continually updates, even if a
particular managed device is offline. You can print out the corresponding
object information based on the last time NetView for AIX established contact
to that device. You can "dump" out the contents of the database for any object
by using the ovtopodump command as follows:

ovtopodump -l <object name> | more

You should see a display similar to the following (example shows only the
first few lines):

HOSTNAME: test311
NODE ID: 569
CREATE TIME: 05/20/93 11:55:40
MODIFIED TIME: 06/07/93 09:16:24
SYMBOL CHANGE TIME: 06/04/93 12:34:00
STATUS: Up
FLAGS:
DESCRIPTION: Novell NetWare v3.11 (250 user)  2/20/91
DESCRIPTION: Compaq DeskPro 386, 16 MHz, 8 Meg
LOCATION: Room 69
LOCATION: 1234 Main Street
LOCATION: City, State, Country
LOCATION: The Universe
CONTACT: Jane Doe
CONTACT: 1.555.1234
CONTACT: jane.doe@company.com
SNMP OBJECT ID: 1.3.6.1.4.1.23.1.6
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The database dump provides you with useful contact information when the
managed device is offline. You can now build an application to do the
following:

■ Redirect the output to a temporary file.

■ Filter out selected information to a second temporary file.

■ Put up an X Window with the contents of the second file.

■ Wait for user input to clear the window.

■ Clean up the temporary files.

To build this application, you must first "register" the application with NetView
for AIX. NetView for AIX stores Application Registration files in the directory
/usr/OV/registration/$LANG, where $LANG represents a language-specific
configuration. By default, these files are in the directory /usr/OV/registration/C.

For details on building Application Registration Files and integrating applications
to the NetView for AIX menu bar, refer to the NetView for AIX Programmer’s
Guide under the topic "Understanding Application Registration Files."
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The following list illustrates an Application Registration File:

/*
**
**  NetView for AIX Node Information
**
**  @(#)$Revision: 1.0 $
*/
Application "NetView for AIX Node Information"
{
    Version "Revision 1.0";
    Description {
        "Dump the topo database information for the selected node."
    }
    Copyright {
      "(c)Copyright 1994 Compaq Computer Corp."
    }
    /*
    **  Monitor
    */
    MenuBar "Monitor"
    {
        "Node Info"    f.action "Topo Dump";
    }
    Action "Topo Dump"
    {
        MinSelected 1;
        MaxSelected 1;
        SelectionRule isNode;
        Command 'xterm -bg cyan -geo 115x20 \
           -sb -title "$OVwMenuItem - ($OVwSelection1)" -e sh -c \
           "/usr/OV/bin/ovtopodump -l ${OVwSelection1} > /tmp/topo.dmp;\
           awk -f /usr/OV/bin/node /tmp/topo.dmp;more /tmp/topo.prn;\
           rm /tmp/topo.* > /dev/null;read x"';
    }  }



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
4-29

Integrating Compaq Insight Manager with Enterprise Management Platforms

This application lets you select a Compaq server, even one that is offline, and
view the contact information for that server. The application uses an AWK
(programming language) script file to include only required information in the
file topo.prn. The following list contains script for the "node" file. Include this
file in the directory /usr/OV/bin:

BEGIN {
print " " > "/tmp/topo.prn"
eof = getline
while (eof > 0)
 {
  if ($1 ==  "HOSTNAME:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "STATUS:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "DESCRIPTION:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "LOCATION:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "CONTACT:" )
   { print $0 > "/tmp/topo.prn" }
|  if ($1 == "NODE" )
   {
     if ($2 == "LABEL:" )
      { print $0 > "/tmp/topo.prn" }
     if ($2 == "AGENT:" )|
      { print $0 > "/tmp/topo.prn" }
     if ($2 == "VENDOR:" )
      { print $0 > "/tmp/topo.prn" }
   }
  if ($1 == "SUPPORTS" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "NUMBER" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "INTERFACE:" )

   { print $0 > "/tmp/topo.prn" }
continued
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if ($1 == "IP" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "PHYSICAL" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "LAST" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "CONSECUTIVE" )
   { print $0 > "/tmp/topo.prn" }
  eof = getline }

Rigure 4-4 illustrates a sample output from the application.

Figure 4-4.  Contact information application
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Using the Information
Once you integrate the Insight MIBs and build your applications with
NetView for AIX, you can manage your Compaq servers in the same manner
as your other managed devices.

NetView for AIX provides the following methods to obtain and use the
information in the MIBs:

■ Browsing the MIB

■ Predefined and custom monitor applications

■ Event configuration and monitoring

The following sections describe each of these methods in detail.

Browsing the MIB

NetView for AIX provides a quick method of browsing up and down the MIB
tree. To invoke the MIB browser, select the Tools→Browse MIB: SNMP...
menu item.  Start at the root, traversing up and down any branch until you get
to a MIB variable of interest. Select the Start Query button to retrieve
information about that variable.

NOTE:  Once you load the Insight MIB files, the MIB values are available for any
selected Compaq system with the Insight Agent operational.

Figure 4-5 displays available Insight MIBs (the exact screen content depends
on your installation):
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Figure 4-5.  Browsing the Compaq MIB subtree

NOTE:  You can also SET Insight MIB variable values when browsing the MIB subtree.

IMPORTANT:  Insight Agents for each operating system might have different levels
of SET support. Refer to the appropriate Compaq Insight Management Agents User
Guide for more information.

For example, select the subtree and start a query to retrieve the existing value
to update the contact information. Select the value you want to change, then
enter a new value. When you click on the Set button the MIB value updates.
Figure 4-6 illustrates an example.
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Figure 4-6.  Setting MIB values

For details on browsing the MIB and setting values, see the NetView for AIX
User’s Guide under the topic "Browsing MIBs."
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Predefined and Custom Monitor Applications

Browsing MIB values is just one example of the predefined applications
available to you on the Monitor menu of the NetView for AIX menu bar.  In
addition, Compaq has included several custom MIB query files in the Compaq
Systems Management Toolkit which provide important configuration,
statistical, and condition information.

As discussed in "Adding Custom Applications" of this chapter, you can further
enhance the predefined suite of applications by building your own.

Applications on the Monitor menu not only provide you with on-screen
reports, they can also graph trends in MIB variables. For example, to monitor
the traffic of a particular network interface controller in a server:

1. Highlight the server symbol on the map.

2. Select Monitor→Network Activity→Interface: Traffic ... from the menu
bar. When the data processing completes, a window displays the
network traffic graph.

For more details on using these applications, refer to the NetView for AIX
User’s Guide under the topic "Using NetView for AIX Predefined
Applications."
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Event Monitoring

An event is a notification of a change in your network. NetView for AIX
categorizes events into:

■ Threshold Events

■ Network Topology Events

■ Error Events

■ Status Events

■ Node Configuration Events

■ Application Alert Events

■ All of the above

You can use the Event Notification window to view selectively a particular
category of events, or all events. You can further narrow your selection to a
particular highlighted symbol (for example, a specific Compaq server).

You can proactively monitor the health of your network using events. This
TechNote does not include a detailed discussion of event monitoring. For
guidelines on establishing baselines, monitoring trends, setting up thresholds
on MIB values, and so on, refer to the NetView for AIX User’s Guide under
the topic "Working with Events and Event Filters."
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Handling Traps
Traps are a method of reducing network traffic. An agent can send information to
a management PC when requested, or unsolicited. Traps, unsolicited information,
indicate that something changed at the agent which requires attention.

If you do not specify the NetView for AIX console as a trap destination, the
traps remain locally at the agent. This means that the NetView for AIX console
does not know about an impending problem until it polls the agent about the
specific problem area. Excessive polling generates heavy network traffic and
degrades performance. Therefore, Compaq strongly recommends that you set up
at least one trap destination at each critical server as the IP address or hostname
of your NetView for AIX console.

Trap IDs have a generic part and a specific part. The generic part of a Compaq
trap is always six (for Enterprise-Specific traps), and zero through five are
used as part of the SNMP definition for other trap types. The specific part
depends on the type of error.
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Setting Up Compaq Traps

Compaq provides a script file, CPQTRAP.SH, in the Compaq Systems
Management Toolkit. This file is provided to help you configure NetView for
AIX to receive and process Compaq traps. Refer to the README.TXT file in the
\NV_AIX directory in the Toolkit for more information.

NOTE:  If you use the files provided in the Compaq Systems Management Toolkit, the
following steps are not required.

To set up Compaq traps manually, perform the following steps:

1. Select Options→Trap Customization: SNMP...

2. Select the Add New Enterprise dialog box button in the dialog box.

3. Add a new enterprise for Compaq, using the following ID:

Compaq 1.3.6.1.4.1.232

4. Add the generic trap ID (six) and specific trap IDs you want for each
enterprise. For details on Compaq trap IDs, refer to Appendix A,
"Using the Compaq MIB Information."

Insight Agents version 1.x defines one enterprise per subsystem, for example,
Compaq-IDA = 1.3.6.1.4.1.232.3, Compaq-SCSI = 1.3.6.1.4.1.232.5, and so on.

Insight Agents versions 2.x and 3.x define a single enterprise, for example,
Compaq = 1.3.6.1.4.1.232, and the specific ID of the trap type defines the
subsystem, for example, 30xx for IDA, 50xx for SCSI.

IMPORTANT:  For compatibility with older systems, you must configure your NetView
for AIX console to handle traps from both the older and newer NetWare Agents.
Windows NT, SCO UNIX, UnixWare, and IBM OS/2 agents follow the Compaq Insight
Manager 2.x and 3.x format.

Figure 4-7 illustrates an example configuration for a Compaq Intelligent Drive
Array enterprise ID, and a specific trap ID of four, implying that the physical
drive threshold was exceeded.
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NOTE:  This example displays an Insight Agent version 1.x trap.

Figure 4-7.  Setting up a Compaq IDA trap definition

Once the trap definitions are set up, you can view new traps through the
Events Notification window, similar to other events. The following displays a
sample event list with Compaq IDA traps.

NOTE:  The following example illustrates a version 1.x trap.

Wed Jun 02 08:09:37 1993 remote_as A Trap #6, specific: 4, args (1):
Wed Jun 02 08:09:37  remote_as A [1] cpqDaPhyDrvEntry.cpqDaPhyDrvThresh

Passed.1.4   (Integer): 2
Wed Jun 02 08:09:38 1993 remote_as A Trap #6, specific: 4, args (1):

Wed Jun 02 09:08:38  remote_as A [1] cpqDaPhyDrvEntry.cpqDaPhyDrvThresh
Passed.1.3   (Integer): 2

Troubleshooting

If you do not receive traps at your NetView for AIX console when your
network is operational, check the following:

■ Verify the configuration of the managed devices to ensure they are
forwarding traps to your NetView for AIX console.

■ Verify the read and read-write community settings.
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Integration to Other Systems
IBM and other third party systems provide NetView for AIX platform support
with products in several areas of network management such as problem
solving, configuration management, capacity planning, trouble ticketing, and
so on. For details about additional products, contact:

NetView Association from IBM and Digital
3039 Cornwallis Rd.
Research Triangle Park, NC  27709

You can also build custom applications using the NetView for AIX APIs. This
TechNote does not discuss these techniques in detail. However, you can
integrate NetView for AIX to other systems with limited programming. For
example, sending e-mail messages from NetView for AIX as a result of
receiving a trap from a Compaq server.

Event Notification via E-Mail
Significant events often require some action from an administrator. One way
to notify an administrator is to send a message to the administrator's mailbox.

To set up NetView for AIX to send e-mail messages, ensure that:

■ Your domain name is set correctly and matches the domain name of
other computers on the network. The following is an example format of
domain name: Yourcompanyname.com.

■ You can send e-mail. As a test, try to send mail to your login ID at the
NetView for AIX console. If you logged in as root, use root as the mail ID.
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For each event that you forward to the mail gateway, you must set up the Optional
Command and Argument Format field on the Event Configuration screen as follows
(replace the "Admin@Sysmgtpo" with your own mail address):

/usr/local/bin/mailevent "Compaq IDA trap received from node: $A with $# args:\n$*" "Admin@Sysmgtpo"

Figure 4-8 shows an example of configuring an event to send mail:

Figure 4-8.  Configuring an event to send mail
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When the event occurs, it invokes the mailevent script, sending the mail
message. The contents of the mailevent script include:

MSG=$1
TO=$2
echo "${MSG}" | /usr/lib/sendmail "${TO}"

Refer to the NetView for AIX the online help for the Options→Event
Configuration: SNMP... screen for details on the $A, $#, and $* parameters in
the trap notification message.

Some points regarding setting up events:

■ Choose events carefully. Do not flood the administrator's mailbox with
an e-mail message for every event occurring in the network.

■ Try to route different classes of events to different people. For
instance, one person might be notified about critical events for routers,
another might be notified only of server events, and so on.
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Chapter 5
Integration with
SunNet Manager

This chapter discusses the integration of Compaq server management with
SunNet Manager from SunConnect (a Sun Microsystems, Inc. Business). The
information is based on tests performed in the Compaq Integration Lab using
a test network.

NOTE:  In this chapter, several examples involve IP addresses. IP addresses are
denoted for example purposes as X.Y.<number>.<number>, where X.Y. represents a
Class B network address, and <number> is a value from 0 to 255.

Feature Summary
SunNet Manager is an internetwork and enterprise-wide management platform
that manages a variety of devices such as hubs, bridges, routers, and servers.

The following are some key features of SunNet Manager:

■ Support of industry-standard protocols such as SNMP, TCP/IP, and
RPC. This includes tools such as a MIB compiler that translates MIB
definitions into schemas used by SunNet Manager.

■ Communication capability with private network management protocols
through a proxy agent. SunNet Manager provides manager and agent
services and topology map APIs.

■ Node discovery that can seek out, identify, and display managed TCP/IP
devices.

■ Results browsing and graphing tools.

■ Auto-management feature that lets you set up predefined events that
start up automatically for specific elements on your network.
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Integration Environment
Compaq tested the SunNet Manager integration using the following hardware
and software configuration:

■ Sun SPARCstation 1+ with 32 megabytes of memory, an external
600-megabyte disk drive, a CD-ROM drive, and a mouse.

■ SunOS, Version 5.3, configured with Sun OpenWindows, Version 3.3

■ SunNet Manager, Version 2.2.

NOTE:  For specific hardware and software requirements, consult your SunConnect
representative.
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Adding Compaq
Insight Agent Support

The Compaq Management CD includes the Compaq Systems Management
Toolkit which can be found in the \TOOLKIT\ directory.  The Systems
Management Toolkit includes several files which can be used to integrate the
management of Compaq Insight Agents into SunNet Manager.  Please refer to
the file README.TXT in the \SUNNET directory in the Systems Management
Toolkit for additional integration information.

NOTE:  If you will be accessing the files in the Systems Management Toolkit
using a Compaq Integration Server the directory tree is:
\\servername\CPQIS1\CPQIS\TOOLKIT\ver_no\

where servername is the name of the Integration Server

and ver_no is the version of the Toolkit.

This section assumes that your SunNet Manager console is running successfully.
If this is a new installation, you can use a copy of your sample database to add
Compaq servers. If you are an experienced SunNet Manager user, you can begin
with a database of other managed devices displayed on the screen.  For further
details, refer to the SunNet Manager User's Guide.

Adding support for Compaq Insight Agents consists of the following steps:

1. Transfer the MIB or schema to the SunNet Manager.

2. Compile the Insight MIB files into schemas that SunNet Manager can use.

NOTE:  Skip this step if you use the predefined schemas supplied by Compaq.
Refer to the file README.TXT for more information.

3. Copy the schema to the proper directory.

4. Discover or add your Compaq Systems to the SunNet Manager network
subview.

5. Associate the proper schema with your systems.

6. Add new managed device types for Compaq systems.

7. Create icons for the Compaq systems.

8. Add the final touches (format or clean up the display).
The following sections discuss each of these steps in detail.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
5-4    Integration with SunNet Manager

MIB Files and Schema Files

The Compaq Systems Management Toolkit contains the Insight MIB files.
Compiled MIB files, called schemas, define the information structure that the
SunNet Manager console requires to retrieve the agents.

Transferring the MIB Files
to SunNet Manager

Transfer the Insight MIB files from the Compaq Systems Management Toolkit
to your SunNet Manager station.

NOTE:  Alternately, you can use the predefined schemas in the Toolkit, and transfer
COMPAQ.SCH rather than the MIB files. To integrate the sample files, refer to the
README.TXT file in the \SUNNET\ directory in the Compaq Systems Management Toolkit.

There are several ways to transfer the Insight MIB files from the Compaq
Management CD to your Sun workstation.  If you have a CD-ROM drive on
your console you may mount the CD to a local file system and then copy the
files directly from the CD.  Alternatively, the CD may be mounted remotely
as an exported file system using the Network File System (NFS). Consult the
SunOS or Solaris documentation for information on using the CD-ROM drive
and NFS.

Another method for transferring files between systems is to use the File
Transfer Protocol (FTP).

NOTE:  In addition to most UNIX systems, FTP is available with Windows NT, SCO
UNIX, and IBM OS/2 installations. For NetWare, you must transfer the files from a
NetWare client that has TCP/IP support using software such as LAN Workplace for
DOS. Ensure that you choose the ASCII file transfer mode.
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The following is a display of a sample FTP transfer:

C:\users\default>ftp hostname
Connected to hostname.
220 hostname FTP server (SunOS 4.1) ready.
User (hostname:): root
331 Password required for root.
Password:
230 User root logged in.
ftp> send
(local-file) D:\TOOLKIT\MIBS\CPQIDA.MIB
(remote-file) /usr/snm/cpqmibs/CPQIDA.MIB
200 PORT command successful.
150 ASCII data connection for /usr/snm/cpqmibs/CPQIDA.MIB (X.Y.24.20,1031).
226 ASCII Transfer complete.
128553 bytes sent in 8.21 seconds (15.67 Kbytes/sec)
ftp> quit
221 Goodbye.
C:\users\default>

In the above example, the file was transferred from the CD in drive D to the
/usr/snm/cpqmibs directory on the Sun.

Compiling the MIB Files

The following procedure is not required if you use the predefined schemas
from the Systems Management Toolkit.

1. Enter the mib2schema command to compile the Insight MIBs:

mib2schema CPQIDA.MIB
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 This command causes the following to display:

Translating ....
Translation Complete.
Schema file in "CPQIDA.MIB.schema"
Oid file in "CPQIDA.MIB.oid"
Traps in "CPQIDA.MIB.traps"

 This example compiles the Insight MIB file for the following Compaq
products:

 ■ Compaq SMART and SMART-2 SCSI Array Controller

 ■ Compaq Intelligent Drive Array-2 (IDA-2) Controller

 ■ Compaq Intelligent Drive Array (IDA) Controller

 ■ Compaq 32-Bit Intelligent Array Expansion Controller

2. Check for messages.

 The Insight MIB files should compile without any errors. If the console
displays error messages, check them to determine the line(s) in the file
containing the error(s). Also, check your file transfer procedure to
verify that you transferred the file without problems.

 For example, you might have transferred the files in binary format
rather than ASCII. Use the dos2unix command (refer to your UNIX
documentation for the proper syntax) to convert DOS file formats to
UNIX formats, once you have the files on the UNIX system.

3. Repeat the mib2schema procedure for all Insight MIBs. Ensure that
you provide the correct MIB file names.
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Copying the Schemas to
the Proper Directory

Copy the schemas to the directory referenced by SunNet Manager to load the
schemas. The default directory is /usr/snm/agents. The following example
illustrates this procedure. However, create a new directory for schemas created for
local devices and add this new directory name to the search path for schema files.

NOTE:  This prevents schema file loss when you update SunNet Manager to the next version.

The SunNet Manager automatically loads the new schemas when you bring up
SunNet Manager for initialization with the -i option:

snm  -i /usr/snm/db/compaq.db &
[1] 282
Copyright (c) 1989,1992 Sun Microsystems, Inc.

snm: loading /usr/snm/struct/snm.glue
snm: loading /usr/snm/struct/elements.schema
snm: loading /usr/snm/struct/cpqsrvr.schema
snm: loading /usr/snm/agents/diskinfo.schema
snm: loading /usr/snm/agents/etherif.schema
snm: loading /usr/snm/agents/hostif.schema
snm: loading /usr/snm/agents/hostmem.schema
snm: loading /usr/snm/agents/hostperf.schema
snm: loading /usr/snm/agents/iostat.schema
snm: loading /usr/snm/agents/ippath.schema
snm: loading /usr/snm/agents/iproutes.schema
snm: loading /usr/snm/agents/layers.schema
snm: loading /usr/snm/agents/lpstat.schema
snm: loading /usr/snm/agents/ping.schema
snm: loading /usr/snm/agents/rpcnfs.schema
snm: loading /usr/snm/agents/sample.schema
snm: loading /usr/snm/agents/snmp-mibII.schema
snm: loading /usr/snm/agents/snmp.schema
snm: loading /usr/snm/agents/sun-snmp.schema
snm: loading /usr/snm/agents/sync.schema
snm: loading /usr/snm/agents/traffic.schema
snm: loading /usr/snm/agents/compaq.schema
snm: loading /usr/snm/additions/struct/sun-system.schema
snm: loading /usr/snm/db/compaq.db
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Adding the Compaq Systems
to the Database

You can add the Compaq systems to the database manually or automatically
with the Discover tool. The sections that follow contain instructions for both
processes.

Using the Discover Tool

You can use the Discover tool to add Compaq systems to a network subview.
For details on this tool, refer to the SunNet Manager User's Guide,
Chapter 2, "Creating and Modifying the Management Database," under the
topic "Letting the Discover Tool Build Your Database."

The Discover tool adds new elements to the view. Glyphs representing
Compaq systems are automatically added to the view if you just installed the
systemss on the network. This assumes that:

■ The systems are operational and configured with TCP/IP, SNMP, and
the Insight Agents.

■ SunNet Manager can translate the IP addresses of the systems to
hostnames, either through a DNS or from the host's file.

As the Discover tool runs, it places each element into one of three categories:
servers, workstations, or routers. The tool automatically selects appropriate
glyphs for each category.

IMPORTANT:  In this context, the terms server and workstation apply to computers
based on the SunOS platform, not on the Intel PC architecture.

Because the Discover tool cannot distinguish computers based on the PC
architecture, it associates the workstation glyph with any Compaq systems on
your network.
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Adding a System Manually

You can manually create a glyph representing a Compaq system using the
Create command from the Edit menu. Temporarily create a glyph representing a
PC and change it after you create a new managed device specifically for a
Compaq system (discussed later in this chapter). To create a glyph, refer to the
SunNet Manager User's Guide, Chapter 2, "Creating and Modifying the
Management Database," under the topic "Creating Elements."

Changing the Glyph Type

You can change the glyphs to represent PC servers and clients accurately on the
screen. For servers, you can change the glyph type after you create the glyph. For
clients, you can change the glyph type from a workstation to a PC. SunNet
Manager includes a glyph representing a PC client. To change the glyph type,
refer to the SunNet Manager User's Guide, Chapter 2, "Creating and Modifying
the Management Database," under the topic "Changing Element Types."

NOTE:  The glyph type only represents an element; it does not affect how you manage
the element. For example, you can represent a particular PC client on screen as
either a workstation or as a PC. In either case, you manage it as you would any other
element. When you change the glyph type, only the screen representation and some
description fields change.

Associating the Appropriate Schemas

To associate the appropriate schemas with your Compaq systems, you must
modify the properties associated with the glyphs representing them. When you
bring up the properties window for a glyph, the middle portion of the window
contains a list of the schemas recognized by SunNet Manager. This should
include the Compaq schemas you added.
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X.Y.109.16

Figure 5-1.   Associating the appropriate schemas

For details on setting and modifying properties, refer to the SunNet Manager
User's Guide, Chapter 2, "Creating and Modifying the Management Database,"
under the topics "Creating Elements" and "Modifying Element Properties."



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
5-11

Integrating Compaq Insight Manager with Enterprise Management Platforms

1. Verify your setup by running "quick dump" reports on the Insight MIB
attribute groups associated with your Compaq servers. For details on
this report, refer to the SunNet Manager User's Guide, Chapter 3,
"Requesting Data from Agents," under the topic "Making a One-Time
Request for Data." If your configuration is successful and the Insight
Agents run on the servers, you should see a window on your console
containing the MIB attribute group variables and their current values.

2. Save your current configuration in a management database file and exit
the console before the next step. For details, refer to the SunNet
Manager 2.0 User's Guide, Chapter 2, "Creating and Modifying the
Management Database," under the topics "Saving the Management
Database" and "Quitting the Console."

IMPORTANT:  If you started with the sample database, save the file under a new
name to avoid overwriting the original.

Adding a New Managed Device Type

The elements.schema file contains the element types recognized by SunNet
Manager. You can usually find this in the /usr/snm/struct directory. To add a
new managed device type, you must provide an appropriate schema.

Though you can edit elements.schema to add a new element, we recommend
that you create a separate file in the same directory. For example, to define a
Compaq server type, create a file named cpqsrvr.schema. The following
example shows the typical contents of this file.
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record component.cpqsrvr (     # Compaq Server
        string[64]      Name
        string[40]      IP_Address
        string[40]      User
        string[40]      Location
        string[80]      Description
        string[50]      Server_Type
        string[40]      SNMP_RdCommunity
        string[40]      SNMP_WrCommunity
        string[64]      SNMP_Vendor_Proxy
        int             SNMP_Timeout

)
instance elementGlyph(
        ( component.cpqsrvr             cpqsrvr.icon))

Each of the fields defined in the record component.cpqsrvr definition displays
when you bring up the properties window of a glyph representing a Compaq
server. Certain fields, such as the IP address field included for convenience,
cannot be used to manage the device.

You can customize the field definition to include useful fields. For example, to
include a phone number, modify the record definition to add the appropriate
string. The display shows that the phone number string is now part of the field
definition.

record component.cpqsrvr (     # Compaq Server
        string[64]      Name
        string[40]      IP_Address
        string[40]      User
        string[40]      Location
        string[80]      Description
        string[20]      Phone
        string[50]      Server_Type
        string[40]      SNMP_RdCommunity
        string[40]      SNMP_WrCommunity
        string[64]      SNMP_Vendor_Proxy
        int             SNMP_Timeout
)
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For a detailed description on element type definition, refer to the SunNet
Manager 2.0 Reference Guide, Chapter 6, "Management Database," under the
topic "Element Type Definition."

In the description above, you associate a glyph with the element by including
the instance elementGlyph statement in the cpqsrvr.schema file. This assumes
that you have an icon file that you can use to display as the glyph. The
following section explains how to create the icon file.

Creating an Icon File

In SunNet Manager, glyphs represent elements. A glyph has an associated icon
file. To create an icon file for a Compaq server, you can either create it on a PC
and import it, or you can create an icon on the SunNet Manager console using the
Icon Editor tool. The following applies to the icon files used by SunNet
Manager:

■ Icons are black and white. SunNet Manager can color the
corresponding glyphs by applying a mask, as discussed later.

■ The icon size can be 32, 48, or 64 pixels wide and any reasonable height.
Typically, 32 x 32, 32 x 64, 64 x 32, or 64 x 64 pixel sizes are used.

■ The file format must be compatible with X Windows. If you create the
file on a PC, you need an appropriate conversion utility to generate the
proper format.
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You can use the Icon Editor tool to create the icon file. A quick way is to
modify an existing icon file and save it with the new name cpqsrvr.icon. Figure
5-3 illustrates how to use the Icon Editor to create an icon for a Compaq server.

Figure 5-2.  Using the Icon Editor to create an icon for a Compaq server
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You can also create an icon mask file and use it as a stencil for coloring or
inverting an icon. This is useful when you want the glyph to dim or blink on
the screen when a significant event occurs. You must save the mask file with
the same name as the original, but with an iconmask extension. For a Compaq
server, create an icon mask file called cpqsrvr.iconmask.

Figure 5-3.  Compaq server iconmask example

For details, refer to the SunNet Manager 2.0 User's Guide, Chapter 8, "SunNet
Manager Examples," under the topic "Creating a New Glyph for an Element
Type."
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Adding the Final Touches

Once you create a new element type and an icon to represent a Compaq
server, you can bring up your previously saved database and add some of the
final touches to make it visually appealing. Perform the following procedure:

1. Invoke SunNet Manager to load your database file by entering a
command similar to the following:

snm -i /usr/snm/db/compaq.db &

2. Change the element type of the glyph to cpqsrvr for each Compaq server.
If you have not done so, change any workstation glyphs to PC glyphs to
represent any PC clients in your network.

NOTE:  Optionally, you can change the properties of the glyph to a new color.
For example, use a simple color-coding scheme to categorize servers by
application or by operating system such as red for NetWare servers, blue for
Windows NT or OS/2 servers, yellow for SCO UNIX servers, and so on.

3. Move the glyphs around, add connections, and create subviews as
appropriate. Save the database file when completed. Refer to the
SunNet Manager 2.0 User's Guide, Chapter 2, "Creating and Modifying
the Management Database," for complete details.

4. Use a text editor to edit your saved database file to include background
images for your views. Add an instance viewBackground record for
each event view with a background, enclosing view names in quotation
marks if they contain spaces:

instance viewBackground (
( Home world.im1)
("Houston Servers" texas.im1)
)
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Customizing the Schemas
Although the schemas generated by the mib2schema compiler are adequate
for most installations, you can modify them to suit your needs. The following
discusses some possible modifications.

IMPORTANT:  Modifying schemas requires a thorough understanding of the layout
and Abstract Syntax Notation One (ASN.1) format.

NOTE:  The Compaq Systems Management Toolkit includes some of the following
customization tips in the predefined schemas. Consult the documentation and the
files to determine if they suit your needs before making any changes.

Consolidating Several
Schema Files Into One

Compaq supplies several Insight MIB files that relate to the general
information about the server. These are:

■ CPQSINFO.MIB -- provides system information specific to Compaq servers

■ CPQSTDEQ.MIB -- provides EISA configuration information

■ CPQHLTH.MIB -- provides server health information such as memory error

You might want to combine the equivalent schemas into a single schema called
CPQSRVINFO.MIB.schema. (This schema name is provided only as an example.)

IMPORTANT:  Compaq does not recommend editing or modifying the Insight MIB files. If
you must make changes, make changes to the schemas and not to the MIB files.

Because the schemas are regular text files, you can use a text editor to combine
them. A schema file has a layout quite similar to a MIB definition file.
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# Proxy name and description
# Enumerations
# Group and table declarations
# Trap definitions
# Agent errors

When combining schema files, you must repeat the Enumerations, Group and
table declarations, and Trap definitions for each Insight MIB that you wish to
consolidate into a single schema. However, you have only one section for
Proxy name and description and Agent errors.

Using the above example, the layout of the combined file might look similar
to the following display:

proxy CompaqServerInformation
description "Compaq Server Information"
serial 2
rpcid 100122
(
## Enumerated Type Definitions
## Standard Equipment

<enumerations for Standard Equipment follow>
## System Info

<enumerations for System Information follow>
##   Health

<enumerations for Health follow>
## Group and Table Declarations
## Standard Equipment

<declarations for Standard Equipment follow>
## System Info

<declarations for System Information follow>
##   Health

<declarations for Health follow>
## Traps
##   Health

<declarations for Health follow>
## Agent errors

<agent errors follow>
## End of Agent Definitions
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Modifying the Enumeration Strings

To modify the enumeration strings to your preference, edit them to the new,
more readable, values. For example, when you compile the file
CPQSINFO.MIB, the corresponding schema file has the following enumeration
for memory board type:

enum cpqSiMemModuleTypeE (
   1 "other"
   2 "board"
   3 "cpqSingleWidthModule"
   4 "cpqDoubleWidthModule"
   5 "simm"

You can change these enumerations to:

enum cpqSiMemModuleTypeE (
   1 "Other"
   2 "Board"
   3 "Compaq Single Width Module"
   4 "Compaq Double Width Module"
   5 "SIMM"
)

IMPORTANT:  Modify only the enumeration strings, not the attribute name.
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Modifying the Insight Agents
Name and Description

As you did with enumeration strings, you might want to change the default values
from the MIB compilation to suit your preference to enhance readability. You can
change them by editing the file to the new strings, as in the following example.

The following display shows the header of the CPQSINFO.MIB.schema file
created from the mib2schema program (some lines have been omitted for clarity):

## THIS FILE WAS GENERATED BY MIB2SCHEMA
proxy Compaq-SYSTEM-INFO
description "Compaq-SYSTEM-INFO agent"
serial 2
rpcid 100122

You can edit this header to look like the following:

## THIS FILE WAS GENERATED BY MIB2SCHEMA
proxy CompaqInfo
description "Compaq System Information agent"
serial 2
rpcid 100122

Additional Customization

For additional tips and ideas on customization, refer to the SunNet Manager
2.0 Reference Guide, Chapter 7, "SNMP Support."
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Using the Information
Once you integrate the Insight MIBs and the corresponding schemas with
SunNet Manager, you can manage your Compaq servers in the same manner as
your other managed devices. SunNet Manager provides you with various
reporting methods to obtain and use the information in the Insight MIBs. This
includes:

■ Quick dump

■ Data report

■ Event report

■ Set request

■ Automatic management

The following sections provide detailed descriptions of these reporting methods.

Producing a Quick Dump

Quick dump displays all the values in an attribute group or table. The attribute
group or table must be part of a schema, and you must have associated the
schema with the target Compaq server you wish to manage. If the agent is
running on the server and the network is operational, a window should display
on your SunNet Manager console with the appropriate information.

To retrieve the EISA configuration information for a particular server:

1. Select the glyph representing the server and bring up its glyph menu.

2. Select the schema containing the EISA Slot Table configuration
information such as Compaq StdEquip.
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3. Highlight the EISA configuration attribute table, and make your request.
Figure 5-5 displays a list of schemas containing EISA information.

Figure 5-4.  Requesting a quick dump for EISA configuration information

If your request is successful, your screen should look similar to Figure 5-6
(only a portion of the screen is shown):
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...................................

...................................
Figure 5-5.  Sample quick dump report

For further details about requesting quick dumps, refer to the SunNet Manager
2.0 User's Guide, Chapter 3, "Requesting Data from Agents," under the topic
"Making a One-Time Request for Data."

Requesting a Data Report

A Data Report collects periodic information about a specific attribute group or
table. The attribute group must be part of a schema, and you must have
associated the schema with the target Compaq server you wish to manage.
Unlike a quick dump report that gives you all the attributes in a group, a Data
Report lets you specify the ones you need and how often you want them.

Once you receive the information, you can view it in several ways. This
includes a Results Grapher that lets you view the values of a specified
attribute. You can graph either absolute or relative values to look at the trends.

If the Insight Agents are running on the server and the network is operational,
you can use the View menu to retrieve the Data Report. For example, you can
retrieve the Logical Drive information about a drive array for a particular server.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
5-24    Integration with SunNet Manager

For this example, only the following items are of interest:

■ Fault Tolerance

■ Drive Status

■ Drive Size

■ Physical Drive IDs (mapping to a single Logical Drive)

■ Logical Drive Condition

Perform the following steps:

1. Select the glyph representing the particular server and bring up the
glyph menu for the server.

2. Select the schema containing the drive array logical drive information
such as Cpq-IDA.

3. Highlight the Logical Drive attribute group and make your request for
the specific attributes of your interest. The following figure illustrates
this example.

Figure 5-6.  Requesting a data report for logical drive information on a drive array
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If your request is successful, you can retrieve a report similar to the following
display.

Mon May 10 13:44:02 1993 [ ctc_as ]  Data: cpqIDA.LogicalDriveTable

cpqLogDrvFaultTol  cpqLogDrvStatus  cpqLogDrvSize  cpqLogDrvPhyDrvIDs  cpqLogDrvCondition

     None                          OK                         1295                   01020304                    OK

For further details, refer to the SunNet Manager 2.0 User's Guide, Chapter 3,
"Requesting Data from Agents," under the topics "Requesting Periodic Data"
and "Viewing Incoming Data."

Requesting an Event Report

You can request an event report periodically to monitor an attribute value or
when you want notification of a change. The attribute group must be part of a
schema, and you must have associated the schema with the target Compaq
server you wish to manage.

Like a data report, you can use the event report to specify which attributes you
want to monitor. You can also specify up to two thresholds for each attribute.
When the event occurs, you can specify several actions that should take place.
If the agent is running on the server and the network is operational, you can go
to the View menu and retrieve the event report.

For example, the event report notifies you when an error condition occurs on
one of your servers. When an error condition occurs at the server, the Insight
Agents send the trap to the specified destination and log the information in a
trap log file. The values of the log file index change when the traps occur. You
can monitor for this change and request that an e-mail message be sent to you.
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The following figure illustrates a typical example.

Figure 5-7.  Requesting an event report for trap log index changes

The glyph representing the server blinks according to the specified action in your
request when the event occurs. The event also sends an e-mail message to the
specified address. This address can be an e-mail gateway, as discussed in the
"Integration to Other Systems" section later in this chapter. For further details,
refer to the SunNet Manager 2.0 User's Guide, Chapter 4, "Specifying Events,"
under the topics "Specifying an Event" and "Checking the Cause of an Event."

Performing a Set Request

For SNMP devices, you can perform a Set Request to modify SNMP attribute
groups. The attribute group must be part of a schema, and you must have
associated the schema with the target Compaq server you want to manage.

IMPORTANT:  Insight Agents for each operating system may have differing levels of
SET support. Refer to the appropriate Compaq Insight Management Agents User Guide for
more information.
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For example, to modify the contact information for a server, you need to
include a phone number. Select the server, then use your mouse to select the
snmp-mibII schema and the system group within that schema. If the agent is
running on the server and the network is operational, you should see a window
similar to the one in the following figure.

Figure 5-8.  Performing a set request to change the contact name

You can change the contact name as shown in the previous figure and then
press the Set button to execute your request. To verify that the change was
successful, retrieve the information again by pressing the Get button. You
should see the updated information.

Refer to the SunNet Manager User's Guide, Chapter 7, "Managing SNMP
Devices," under the topics "Using the Set Tool to Retrieve SNMP Attribute
Values" and "Using the Set Tool to Change SNMP Attribute Values" for details.
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Using Automatic Management

Automatic management is a method you can use to set up predefined event
requests for elements in your management database. The default setting for
automatic management is OFF, because frequent polling imposes network
traffic when your SunNet Manager console polls the elements for events.
However, under certain circumstances, you might want to enable this feature
for your critical servers.

Because the Insight Agents support SNMP MIB-II, the Automatic
management feature creates predefined events for each Compaq server that
monitors the sysUpTime variable. This variable indicates how long the agent
has been up. If this variable does not increase by more than eight minutes (a
value computed from the default settings), the event condition becomes
TRUE. Once created and started, you can modify an automatic event request
just like any other.

When you enable the Automatic management feature, SunNet Manager
creates predefined events for every element in your database that supports one
of the following:

■ SNMP

■ hostperf

■ ping

You might not want to have predefined events for certain managed devices.
You can select the glyph menu for these elements and turn off the Automatic
management feature.

IMPORTANT:  Do not enable too many requests with Automatic management. Each
request causes your SunNet Manager console to poll the agent to check status.
Excessive requests and polling can affect your network performance. The default
interval is ten minutes.

For further details, refer to the SunNet Manager 2.0 Reference Guide, Chapter 3,
"Console Configuration," under the topic "Automatic Management."
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Handling Traps
Traps are a method of reducing network traffic. An agent can send information to
a management PC either when requested or unsolicited. Unsolicited information
is known as a trap; this is an indication that something has changed and the
server requires attention.

If you do not specify the SunNet Manager console as a trap destination of the
Insight Agents, it is unaware of an impending problem until it polls the agent
for the specific problem area. Frequent polling can generate excessive
network traffic and degrade performance. Therefore, Compaq strongly
recommends that you set up at least one trap destination at each of your
critical servers as the IP address or hostname of your SunNet Manager
console. Refer to your Compaq Insight Management Agents User Guide to set
up trap destinations. For details on Compaq Traps, refer to Appendix A of this
TechNote, "Using the Compaq MIB Information."

Insight Agents version 1.x defines one enterprise per subsystem, for example,
Compaq-IDA = 1.3.6.1.4.1.232.3, Compaq-SCSI = 1.3.6.1.4.1.232.5, and so on.

Insight Agents version 2.x defines a single enterprise, for example,
Compaq = 1.3.6.1.4.1.232, and the specific ID of the trap type defines the
subsystem, for example, 30xx for IDA, 50xx for SCSI.

IMPORTANT:  For compatibility with older systems, you must configure your
SunNet Manager console to handle traps from both the older and newer NetWare
agents. Windows NT, SCO UNIX, and IBM OS/2 agents follow the Compaq Insight
Manager 2.x format.
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Processing Traps

The SunNet Manager trap daemon processes traps in the following order:

1. SunNet Manager looks in the SNMP hosts file called snmp.hosts to find
a match for the managed device name generating the trap. You can
usually find the snmp.hosts file in the /var/adm/snm directory.

NOTE:  This directory is often linked through SunOS to another directory, for
example /usr/snm/db.

2. If the SunNet Manager finds a match, it consults the trap file specified
in snmp.hosts to translate trap type numbers to meaningful strings.

3. If the SNMP hosts file does not contain an entry, or the entry name
does not specify a trap file, the daemon defaults to the default trap file
called snmp.traps. You can find this file in the /var/adm/snm directory.

To integrate trap types from your Insight Agents with SunNet Manager, edit your
default trap file to include the agents from Compaq. Be sure to combine the
various trap files generated as a result of the mib2schema compilation into a
single file and append it to your existing snmp.traps file. The following display
shows a typical snmp.traps file (some lines have been removed for clarity).

NOTE:  COMPAQ.TRP is a sample trap file located in the directory \SUNNET\README.TXT
in the Compaq Systems Management Toolkit. Look in the README.TXT file for complete
instructions on integrating this file with an existing SNMP trap file.
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#
# snmp.traps - per-enterprise SNMP traps

# Copyright (c) 1989-1992 by Sun Microsystems Inc
#

### THIS FILE WAS GENERATED BY MIB2SCHEMA
enterprise 1.3.6.1.4.1.232

3001 cpqDa2LogDrvStatusChange
3002 cpqDa2SpareStatusChange
3003 cpqDa2PhyDrvStatusChange
3004 cpqDa2PhyDrvThreshPassedTrap
3005 cpqDa2AccelStatusChange
3006 cpqDa2AccelBadDataTrap
3007 cpqDa2AccelBatteryFailed
6001 cpqHeCorrectableMemoryError
6002 cpqHeCorrectableMemoryLogDisabled
6004 cpqHeThermalTempDegraded
6005 cpqHeThermalTempOk
6006 cpqHeThermalSystemFanFailed
6007 cpqHeThermalSystemFanDegraded
6008 cpqHeThermalSystemFanOk
6009 cpqHeThermalCpuFanFailed
6010 cpqHeThermalCpuFanOk
6011 cpqHeAsrConfirmation
6012 cpqHePostError

IMPORTANT:  Do not include more than one trap definition per trap.
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If you want the trap daemon to discard certain trap types, include the word
discard on the line that defines the trap type. For example, you can modify
your trap file to include the following lines if you do not want to receive traps
for system reboots (cold starts):

# Generic traps

enterprise 0

        0      cold-start      discard

To override the default trap file for some critical devices, include the trap
handling for those devices in the snmp.hosts file. Because the trap daemon
searches the snmp.hosts file before the default trap file, any devices defined in
the hosts file are processed first.

IMPORTANT:  Be sure that your snmp.hosts and snmp.traps files are configured
properly to receive events and trap notifications. If you have problems receiving
notifications, refer to the online reference (man pages) for instructions on configuring
these files.

Once you enable the traps, you should see an indication of an incoming trap
on the console. Typically, this is a blinking glyph. You can go to the View
Menu to look up a trap report. The following display shows a typical report.

Tue May 18 09:46:53 1993 [ primary_as] : Trap:

 sequence=2
 receive-time=Tue May 18 09:46:53 1993
 version=0
 community=public
 enterprise=compaq.cpqDriveArray
 source-time=176:28:04.91
 trap-type=cpqDaPhyDrvStatus Change

KEY=1.2
cpqDaPhyDrvStatus=Failed

For additional information, refer to the SunNet Manager Reference Guide,
Chapter 7, "SNMP Support," under the topic "Asynchronous Event
Reports (Traps)."
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Troubleshooting

If you do not receive traps at your SunNet Manager console when your
network is operational, check the following items:

■ Verify the configuration of the managed devices to ensure that they are
forwarding traps to your SunNet Manager console.

■ Verify the read and read-write community settings.

■ Verify the location and content of the snmp.hosts and snmp.trap files.

■ Edit the /etc/snm.conf file to ensure that the na.snmp-trap.rendez
parameter configuration forwards traps to the Event Dispatcher running
on your SunNet Manager console. For example:

na.snmp-trap.rendez   localhost
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Integration to Other Systems
Many vendors support SunNet Manager with network management
products in areas such as problem solving, configuration management,
capacity planning, trouble ticketing, and so on. SunConnect provides a
"SunNet Manager Solutions Portfolio" that categorizes the various products
and services offered by companies for the SunNet Manager platform. Contact
your Sun Microsystems representative at 1-800-241-CONX (U.S. only) for
details. Outside the U.S., call 1-415-960-1300.

You can also build custom applications using SunNet Manager APIs. A
detailed discussion of these techniques is beyond the scope of this TechNote.
However, you can integrate SunNet Manager to other systems without
programming. A specific example is sending mail messages from SunNet
Manager to your LAN-based e-mail application. The following discussion
uses Microsoft Mail as an example.

NOTE:  You can replace Microsoft Mail with your own e-mail application, as long as
it supports a Simple Mail Transfer Protocol (SMTP) gateway.

Event Notification via E-Mail

To set up SunNet Manager to send e-mail messages, you do not need a special
configuration. You must, however, make certain that:

■ Your domain name is set correctly and matches the domain name of
other computers on the network. The following is an example format of
domain name Yourcompanyname.com.

■ You can send e-mail. As a test, try to send mail to your login ID at the
SunNet Manager console. If you are logged in as root, use root as the mail ID.
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■ You set up the event properties to send mail to an address for every
event that you want to notify via e-mail. Use the Internet addressing
format, such as:

YourName@Yourorganization.OrganizationType

■ If you must specify more than one recipient, separate each recipient
with spaces. You could also include group names (for example, user
lists) if your gateway supports them.

When setting up events, choose your events with care. Do not flood the
administrator's mailbox with an e-mail message for every event occurring in
the network.

Select how many times you want to send the message, including sending it
only once. Try to route different classes of events to different people. For
instance, one person might receive notification about critical events for
routers, while another might look only at server events.

Once you have set up SunNet Manager, you must set up a gateway from your
LAN-based e-mail to SMTP. The integration lab set up at Compaq involved a
Microsoft Mail SMTP gateway. The following steps are provided using
Microsoft Mail as an example (your implementation might be slightly different).

Setting Up the Gateway
1. Set up a DOS-based computer with LAN connectivity and TCP/IP utilities

loaded. For Microsoft Mail, this can be Microsoft LAN Manager
configured for TCP/IP. Check your mail gateway documentation to ensure
that you are using the proper version of the networking software.

2. Verify that the IP address, subnet mask, and default gateway values are
configured properly.

3. Set up the AUTOEXEC.BAT file to load the STREAMS protocol (this
is often required by the gateway).

4. Install the gateway computer on the network so that it has access to the
local postoffice.
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5. Run the installation program to set up the gateway computer. Using the
mail administration program, configure mail for the gateway. In
particular, be sure to provide information to map an Internet domain
name to a local postoffice. This domain name must match the domain
name specified on the SunNet Manager console.

6. Start your gateway and verify that it is functioning properly.

7. Generate a test event to send e-mail to your gateway at your SunNet
Manager console. If your setup is functioning properly, log into your
LAN based e-mail system, and see the event as an e-mail message.

 Figure 5-19 illustrates an example of a message.

Figure 5-9.  Receiving SunNet Manager events in Microsoft Mail
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Chapter 6
Integration with HP OpenView

This chapter discusses the integration of Compaq server management
information into Hewlett-Packard (HP) OpenView Network Node Manager.
The information is based on tests performed with version 3.31 in the Compaq
Systems Management Solutions Lab.

NOTE:  Several examples in this chapter involve IP addresses. These examples denote
the addresses as X.Y.<number>.<number>, where X.Y. represents a Class B network
address, and <number> is a value from 0 to 255.

Feature Summary
The Hewlett-Packard Company markets HP OpenView products for UNIX
and DOS environments. In the UNIX environment, HP OpenView runs either
on HP hardware under HP-UX or on Sun hardware under Solaris or SunOS. In
the DOS environment, HP OpenView runs under Microsoft Windows.

NOTE:  This chapter describes integration with the UNIX product only.

HP OpenView provides a management platform for managing devices that use
the Internet Protocol (IP) suite. The key features of HP OpenView include:

■ A distributed management infrastructure that supports various
management protocols such as SNMP, CMIP, and CMOT. (For a brief
explanation of these protocols, see Chapter 2, “Overview”.)

■ Network Node Manager (NNM) -- a management application used to
manage a variety of devices such as hubs, bridges, routers, and servers.
The platform architecture allows HP and/or third parties to add other
management applications. For example, HP OpenView Windows for
UNIX provides a graphical user interface.

■ Management services such as event management services and object
recognition services. You can use Application Program Interfaces
(APIs) to access some of these services.
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The following are some key features of HP OpenView NNM:

■ Support for industry-standard protocols such as Simple Network
Management Protocol (SNMP) and IP. This includes a Management
Information Base (MIB) load utility that lets you add MIB definitions
for new device types in your network.

■ Node discovery that can seek out, identify, and display managed IP devices.

■ A graphical map representing the topology and status of the managed devices.

■ MIB browsing and results graphing tools.

■ Methods to integrate new applications without programming.
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Adding Compaq Insight Agent Support
The Compaq Management CD includes the Compaq Systems Management
Toolkit which can be found under \TOOLKIT.  The Systems Management
Toolkit includes files which can be used to integrate the management of
Compaq Insight Agents into HP OpenView Network Node Manager.  These
include the Compaq MIBs, icon files, trap definitions, and files to add
Compaq-specific query applications.  Please refer to the file README.TXT in
the \OV_UX directory in the Systems Management Toolkit for additional
integration information

NOTE:  If you will be accessing the files in the Systems Management Toolkit
using a Compaq Integration Server the directory tree is:
\\servername\CPQIS1\CPQIS\TOOLKIT\ver_no\

where servername is the name of the Integration Server

and ver_no is the version of the Toolkit.

This section presumes that your HP OpenView console is running successfully.

Adding support for Compaq Insight Agents into HP OpenView consists of the
following steps:

1. Transfer the MIB files to the HP OpenView console.

2. Load the MIB files into HP OpenView.

3. Discover or add your servers and desktops to the network map.

4. Add new managed device types for Compaq servers and desktops.

5. Transfer the Compaq server and desktop icon files to the HP
OpenView console.

6. Transfer the custom MIB query application files to the HP OpenView console.

7. Setup Compaq traps in OpenView.

The following sections discuss each of these steps in detail.
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Transferring MIB Files to
the HP OpenView Console

Compaq includes Insight MIB files with the Insight Agents for your operating
system. These files define the information structure that the HP OpenView
console requires to retrieve information from the agents. The file names are
CPQ?????.MIB where ????? denotes four or five unique characters. Two
optional MIB files, ETHER.MIB and TOKEN.MIB, are included with the
Compaq Systems Management Toolkit in the \MIBS directory.

There are several ways to transfer the Insight MIB files from the Compaq
Systems Management Toolkit  to your HP OpenView console.  If you have a
CD-ROM drive on your console you may mount the CD to a local file system
and then copy the files directly from the CD.  Alternatively, the CD may be
mounted remotely as an exported file system using the Network File System
(NFS). Consult the HP-UX documentation for information on using the CD-
ROM drive and NFS.

Another method for transferring files between systems is to use the File
Transfer Protocol (FTP) which most UNIX systems support. The default path
that OpenView uses for MIBs is /usr/OV/snmp_mibs.

NOTE:  FTP is available with Windows NT, SCO UNIX, UNIXWare, and IBM OS/2
installations. For NetWare, you must transfer the files from a NetWare client that has
TCP/IP support using software such as LAN Workplace for DOS. Be sure to choose ASCII
file transfer mode.
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The following is an example of a typical FTP transfer.

C:\users\default>ftp hostname
Connected to hostname
220 hostname FTP server ready.
User (hostname:): root
331 Password required for root.
Password:
230 User root logged in.
ftp> send
(local-file) D:\TOOLKIT\MIBS\CPQIDA.MIB
(remote-file) /usr/OV/snmp_mibs/CPQIDA.MIB
200 PORT command successful.
150 ASCII data connection for /usr/OV/snmp_mibs/CPQIDA.MIB
X.Y.24.20,1031).
226 ASCII Transfer complete.
128553 bytes sent in 8.21 seconds (15.67 Kbytes/sec)
ftp> quit
221 Goodbye.
C:\users\default>

In the example above, the file was transferred from the CD in drive D to the
directory /usr/OV/snmp_mibs on the target system.

Loading the MIB Files

Once you have the MIB files on your HP OpenView console, you can load
them from the OpenView Menu by following these steps:

1. Select the Option→Load/Unload MIBs: SNMP... menu item.  A dialog
box displays listing the currently loaded MIBs.

2. Click on the Load button. A dialog box displays listing the MIB files in
the default directory. If you transferred the Insight MIBs to this
directory, they are listed here (otherwise, specify the pathname where
you put the files).
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3. Select the desired MIB file, then click OK. The Insight MIB
automatically loads and the Load/Unload MIBs dialog box redisplays.
Repeat this step until you load all the Insight MIB files.

4. Select the Close button to exit.

 The Insight MIB files should compile without any errors. If the console
displays error messages, perform the following steps:

(a) Check the messages to determine which line(s) in the file contain
the error(s).

(b) Check your file transfer procedure to verify you transferred the file
without problems.  For example, you might have transferred them
in binary format rather than in ASCII. In this case you must
convert the DOS file formats to UNIX formats. Refer to your
UNIX documentation for the appropriate command and its syntax.

Refer to the HP OpenView Network Node Manager Administrator's Reference,
Chapter 4, "Troubleshooting," under the topic "Loading MIBs" for additional
information.

NOTE:  HP OpenView NNM ships with several preloaded MIBs (both enterprise and
standard). These MIBs are in the default directory /usr/OV/snmp_mibs.
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Discovering or Adding Compaq Systems
to the Submap

You can add Compaq systems to your database manually or automatically with
the Discover tool. The following sections contain instructions for both methods.

Using the Discover Tool

The HP OpenView NNM netmon process discovers (and subsequently polls
for status) new managed devices on the network. Typically, this process does
not require your intervention except to ensure that the routing tables at the HP
OpenView console are set up properly with the default gateway enabled.

The initial management region contains only the networks directly connected
to the management station. You may expand this region two ways:

■ Interactively expand the management region using the graphical map’s
Options→Manage Objects operation.

■ Provide a “seed file” containing the IP address of SNMP-based routers
on your network.

For further details, refer to the netmon Reference Page (man page) or to the
HP OpenView Network Node Manager Administrator's Reference, Chapter 3,
"Configuration," under the topic "Configuring netmon."

As the netmon process executes, it automatically adds new managed devices
to the appropriate submaps. For instance, when you install Compaq servers on
the network, the tool automatically adds symbols to the view representing
them as managed devices. This assumes that the servers are operational and
configured to use IP, SNMP, and the Insight Agents.

If the new device appears in the /etc/hosts file, the tool translates the IP
addresses of the servers to hostnames. Otherwise, the symbol label on screen
contains only the IP address.
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The netmon process uses, by default, the file /usr/OV/conf/oid_to_type to
determine the topological role of the discovered managed devices (gateway,
bridge, hub, and so on). The netmon process queries the SNMP MIB-II variable
system.sysObjectID to find a match between the value returned by the SNMP
agent running on the managed device and an entry in the file. If there is a
match, the symbol on the submap displays with the proper icon representing the
properties (gateway, bridge, hub, and so on). If there is no match, the discovery
process tries to classify the discovered managed devices into generic symbol
classes representing computers, connectors, network devices, and so on.

NOTE:  Each symbol class has subclasses that provide further description. For
example, the Computer class can have subclasses that describe PCs, workstations,
minis, and mainframes.

The discovery process automatically represents Compaq servers on screen as a
square symbol. This is a generic subclass of the Computer class. Details on
modifying the subclass to a Compaq server are provided later in this chapter.

Using Manual Discovery

You can manually add a symbol representing a Compaq server using the
Edit→Add Object... command. Temporarily create a symbol representing a
generic subclass in the Computer class, and change the subclass after you create
a subclass specifically for a Compaq server. This is described in the section,
"Adding a New Subclass to the Computer Class.” To add a symbol, add the
object first (an on-screen representation of the object). Refer to the HP
OpenView Network Node Manager User's Guide, Chapter 3, "Managing Network
and System Configuration," under the topic "Adding a Node Object."

Changing the Subclass Icon

You can change the subclass to represent servers and clients accurately. For
the servers, you must create the subclass first (discussed in the next section).
For clients, you can change the subclass type from generic to a PC. HP
OpenView NNM ships with a subclass icon representing a PC. To change the
subclass icon, refer to the HP OpenView Windows User's Guide, Chapter 4,
"Managing Your Network," under the topic "Changing the Symbol Type."
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Adding a New Subclass
to the Computer Class

To add a new subclass for a Compaq system, you must perform the following:

■ Modify Field Registration files

■ Create bitmap files to represent Compaq systems

■ Define a Symbol Subclass in the Symbol Registration file

■ Modify the configuration files

The following sections discusses each of these tasks in detail.

Modifying Field Registration Files

HP OpenView Windows extensively uses field definitions, stored in Field
Registration files.  You can find these files in the /usr/OV/fields/$LANG
directory, where $LANG represents language-specific information.  For default
installations, $LANG is defined as “C”.  You can usually find the Field
Registration files in the directory /usr/OV/fields/C.  The two Field Registration
files of interest are ovw_fields and snmp_fields.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
6-10    Integration with HP OpenView

The ovw_fields File

This defines the overall field definitions used by the HP OpenView NNM.
Edit this file to update the vendor enumeration listing by adding "Compaq" to
the list as follows:

Field "vendor" {
Type    Enumeration;
Flags   capability, general, locate;
Enumeration "Unset",

"Hewlett-Packard",
"ACC",
"Cayman",
"cisco Systems",
"CMC",

"Compaq", ← Add this line.
"Data General",
"DEC",
   <other names follow here>
"Xyplex"
;

}

Edit the file by adding a new field called isCpqInsight.  This field signifies if a
given managed device is running the Insight Agents. Append the following to
the end of the file:

/*****
 ***
 *      This field defines if the system is running
 *      Compaq Insight Management Agents

 ***
 *****/
Field "isCpqInsight" {

Type Boolean;
Flags capability, locate;

}
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The snmp_fields File

This file contains various SNMP-related fields. Update the SNMP Agent
enumeration listing automatically, adding "Compaq Insight Management
Agents" to the list as follows:

Field "SNMPAgent" {
Type Enumeration;
Flags   capability, general, locate;
Enumeration
"Unset",
"HP 3000/XL",

<various HP agents follow here>
"ACC 4140 Bridge/Router",
"cisco Gateway Server",
"cisco Terminal Server",
"cisco T-Router",
"cisco Protocol Translator",
"Cayman GatorSystem",
"CMC",

"Compaq Insight Management Agents", ←← Add this line
"DECstation",
"DG Aviion",

<other vendor agent names follow>
"Xyplex Remote Ethernet Bridge",
"4BSD ISODE";

}
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Incorporating the Changes

After making your changes, verify them by entering the following command:

ovw -verify

The screen scrolls with the verified items, until it displays a "Verification
complete" message.

To prevent the screen from scrolling by too fast for you to read the messages,
use the more command:

ovw -verify | more

If you have any errors, correct them and try again. When you have no errors, you
can add the new fields to the database by entering the following command:

ovw -fields

This command verifies the field syntax for fields that already exist in the
database, and adds the new ones. For further details, refer to the HP
OpenView Network Node Manager Administrator's Reference, Appendix B,
"Creating and Using Application Registration Files."
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Creating Bitmap Files to
Represent Compaq Systems

Compaq provides bitmap files to represent Compaq servers and desktops in
the subdirectories located in \OV_UX\ICONS in the Compaq Systems
Management Toolkit.  Refer to the README.TXT file in the \OV_UX
directory of the Toolkit for more information.  You can transfer these files to
your HP OpenView console by using one of the methods described previously
in this chapter.  If you use these files, the following procedure to create
bitmaps manually is not required.

HP OpenView Windows represents objects as symbols. Each symbol has a
class (such as Computer) and a subclass (such as a PC). The class has a shape
associated with it. For example, computers display as squares, networks as
circles, and so on. Within each class, the subclass has a bitmap representation,
enclosed by the class shape. A PC bitmap surrounded by a square represents a
PC, denoting that it is a member of the Computer class.

Bitmap files are always in pairs, containing the bitmap and a bitmap mask
used as a stencil. These files follow the name syntax:

filebase.size.type

Where filebase is the name of the subclass, size is the size in pixels, and type
denotes if this is a bitmap or a bitmap mask. The type is always a "p" for
bitmaps or an "m" for masks.

You can find bitmap files in the directory /usr/OV/bitmaps/$LANG, where
$LANG represents language-specific information. For default installations,
$LANG is defined as “C”. Typically, you can find the Field Registration files in
the directory /usr/OV/bitmaps/C.

You can use the icon or bitmap editor program supplied with your system,
such as bitmap(1), to create the icon files and their masks. Consult the
documentation for your UNIX system for the details using the utility. The
following figures illustrate the bitmap and its corresponding mask for a
Compaq server with a size of 38 x 38 pixels.
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Figure 6-1.   Bitmap for a Compaq server (38 x 38 pixels)



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
6-15

Integrating Compaq Insight Manager with Enterprise Management Platforms

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8
1 � � � � � � � � � � � � � � � � �

2 � � � � � � � � � � � � � � � � � �

3 � � � � � � � � � � � � � � � � � � �

4 � � � � � � � � � � � � � � � � � � � �

5 � � � � � � � � � � � � � � � � � � � �

6 � � � � � � � � � � � � � � � � � � � �

7 � � � � � � � � � � � � � � � � � � � �

8 � � � � � � � � � � � � � � � � � � � �

9 � � � � � � � � � � � � � � � � � � � �

0 � � � � � � � � � � � � � � � � � � � �

1 � � � � � � � � � � � � � � � � � � � �

2 � � � � � � � � � � � � � � � � � � � �

3 � � � � � � � � � � � � � � � � � � � �

4 � � � � � � � � � � � � � � � � � � � �

5 � � � � � � � � � � � � � � � � � � � �

6 � � � � � � � � � � � � � � � � � � � �

7 � � � � � � � � � � � � � � � � � � � �

8 � � � � � � � � � � � � � � � � � � � �

9 � � � � � � � � � � � � � � � � � � � �

0 � � � � � � � � � � � � � � � � � � � �

1 � � � � � � � � � � � � � � � � � � � �

2 � � � � � � � � � � � � � � � � � � � �

3 � � � � � � � � � � � � � � � � � � � �

4 � � � � � � � � � � � � � � � � � � � �

5 � � � � � � � � � � � � � � � � � � � �

6 � � � � � � � � � � � � � � � � � � � �

7 � � � � � � � � � � � � � � � � � � � �

8 � � � � � � � � � � � � � � � � � � � �

9 � � � � � � � � � � � � � � � � � � � �

0 � � � � � � � � � � � � � � � � � � � �

1 � � � � � � � � � � � � � � � � � � � �

2 � � � � � � � � � � � � � � � � � � � �

3 � � � � � � � � � � � � � � � � � � � �

4 � � � � � � � � � � � � � � � � � � � �

5 � � � � � � � � � � � � � � � � � � � �

6 � � � � � � � � � � � � � � � � � � �

7 � � � � � � � � � � � � � � � � � �

8 � � � � � � � � � � � � � � � � �

Figure 6-2.   Bitmap mask for a Compaq server (38 x 38 pixels)

NOTE:  Hewlett-Packard recommends defining bitmap files with the following sizes
(in pixels): 20 x 20, 26 x 26, 32 x 32, and 38 x 38. You must have at least one pair
of bitmap files (icon and mask file) of a particular size.

For further details, refer to the HP OpenView Network Node Manager
Administrator's Reference, Appendix B, "Creating and Using Application
Registration Files" in the "Defining Symbol Subclasses" section.
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Defining a Symbol Subclass in
the Symbol Registration File

HP OpenView Windows extensively uses field definitions, stored in Symbol
Registration files. You can find these files in the directory
/usr/OV/symbols/$LANG, where $LANG represents language-specific
information. For default installations, $LANG is defined as “C”. You can
usually find the Symbol Registration files in the directory /usr/OV/symbols/C.

You can find several files for symbol classes here, including one for the
Computer class. Edit the Computer Symbol Registration file to add the
following subclass definitions:

SymbolType "Computer" : "Cpqsrvr"
{
        Filebase "cpqsrvr";
        CursorSize 38;
        Capabilities {
                isPC = 1;
                isCpqInsight = 1;
        }
}

 SymbolType "Computer" : "Cpqwkst"
{
        Filebase "cpqwkst";
        CursorSize 38;
        Capabilities {
                isPC = 1;
                isCpqInsight = 1;
        }
}

NOTE:  The filebase name must match the filebase name of the bitmap files you
created earlier.
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Incorporating the Changes

After making your changes, verify them by entering the following command:

ovw -verify

The screen scrolls with the verified items, until it displays a "Verification
complete" message.

To prevent the screen from scrolling by too fast for you to read the messages,
you can use the more command:

ovw -verify | more

If you have any errors, fix them and try again. You can also compile your
previously defined bitmap files by entering the following command:

ovw -config

For further details, refer to the HP OpenView Network Node Manager
Administrator's Reference, Appendix B, "Creating and Using Application
Registration Files" in the "Defining Symbol subclasses" section.

Modifying the Configuration Files

The following section presumes that you know the system.sysObjectID values
of the Insight Agents for the various operating systems running on your
servers. You can determine these values quickly by using the snmpwalk
utility provided with HP OpenView NNM. Use this utility to query a server
that you know is running the agents for a specific operating system.
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For example, enter:

snmpwalk unix1 | more

Your results should be similar to the following display:

system.sysDescr.0 : DISPLAY STRING- (ascii):
  SNMPD Version 3.0 For SCO UNIX
system.sysObjectID.0 : OBJECT IDENTIFIER:
  iso.org.dod.internet.private.enterprises.32.1.0

IMPORTANT:  When editing files, replace the iso.org.dod.internet.private.enterprises
portion of the sysObjectID with the numeric value 1.3.6.1.4.1.

HP OpenView Windows uses configuration files to map the SNMP MIB-II
system.sysObjectID variable to symbol types. You can find configuration files
in the directory /usr/OV/conf.

The two configuration files of interest are oid_to_sym and oid_to_type. Before
editing these files, ensure that HP OpenView NNM is not active. Carefully
read the procedures to edit the files in theHP OpenView Network Node
Manager Administrator's Reference, Chapter 3, "Configuration," under the
topic "Configuring the Mapping from sysObjectID to Types."

The following changes presume that you have Compaq systems on your
network running Insight Agents for various operating systems.

IMPORTANT:  Compaq systems without Insight Agents and other Intel-based
systems running SNMP agents that return MIB-II information incorrectly identify
themselves as Compaq systems with Insight Management capabilities. This occurs
because the system.sysObjectID returned by the agent is network operating system
dependent, not hardware dependent. For such systems, you must manually modify
their symbols to represent computers with no Insight Management capabilities. This
affects only new systems you add to the network after making changes.
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The oid_to_sym File

This file is in the $LANG subdirectory under the directory /usr/OV/conf, where
$LANG represents a language-specific configuration. By default, the file
oid_to_sym is in the directory /usr/OV/conf/C.

The HP OpenView NNM ipmap process uses this file to match against the
system.sysObjectID returned by an agent. Because Insight Agents are based on the
network operating system, you must add entries for each operating system that has
Insight Agents available.  For example, for NetWare, Windows NT, SCO UNIX,
UNIXWare, Windows 95, and OS/2 you must edit the file as follows to append
the entries:

1.3.6.1.4.1.23.1.6:Computer:Cpqsrvr # NetWare
1.3.6.1.4.1.23.1.6.3.11:Computer:Cpqsrvr # NetWare 3.11
1.3.6.1.4.1.23.1.6.3.12:Computer:Cpqsrvr # NetWare 3.12
1.3.6.1.4.1.23.1.6.4.10:Computer:Cpqsrvr # NetWare 4.10
1.3.6.1.4.1.311.1.1.3.1:Computer:Cpqsrvr # Windows NT
1.3.6.1.4.1.311.1.1.3.2:Computer:Cpqwkst # Win 95
1.3.6.1.4.1.232:Computer:Cpqsrvr # SCO UNIX
1.3.6.1.4.1.23.1.13.2:Computer:Cpqsrvr # UNIXWare 2.10
1.3.6.1.4.1.2.2.1.2.2:Computer:Cpqsrvr # OS/2

NOTE:  The fields Cpqsrvr and Cpqwkst must match the new symbol types defined earlier.
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The oid_to_type File

This file is in the directory /usr/OV/conf. The HP OpenView NNM netmon
process uses it to match against the system.sysObjectID returned by an agent.
Because agents are based on the network operating system, you must add
entries for each operating system that has Insight Agents available. For
example, for NetWare, Windows NT, SCO UNIX, UNIXWare, Windows 95,
and OS/2 you must edit the file as follows and append the entries:

1.3.6.1.4.1.23.1.6:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.6.3.11:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.6.3.12:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.6.4.10:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.311.1.1.3.1:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.311.1.1.3.2:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.232:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.23.1.13.2:Compaq:Compaq Insight Management Agents
1.3.6.1.4.1.2.6.46:Compaq:Compaq Insight Management Agents

NOTE:  The fields Compaq and Compaq Insight Management Agents must match the
vendor and SNMP agent field enumerations defined earlier in the Field Registration files.

Incorporating the Changes

After you make the changes, reinitialize HP OpenView NNM to startup. Refer
to the HP OpenView Network Node Manager Administrator's Reference,
Chapter 3, "Configuration," under the topic "Configuring the Mapping from
sysObjectID to Types" for details.

Adding the Final Touches

Once you make the changes described above, you can bring up HP OpenView
NNM and add some final touches to make it visually appealing. Perform the
following procedure:

1. Change the symbol subclass for each Compaq server to represent the
server bitmap defined earlier. If you have not done so, change any
generic computer symbols to represent any PC clients in your network.
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2. Partition your network, as appropriate, into submaps. For more details,
refer to the HP OpenView Network Node Manager User's Guide,
Chapter 3, "Managing Network and System Configuration."

3. Go to the Edit menu and choose Submap→Description to include
background images for your submaps.  Add the full pathname of the
graphic file in the Background Graphic field. OpenView Windows
supports the following formats for backgrounds:

❏ GIF  --  CompuServe Graphics Interchange Format

❏ XBM  --  X11 monochrome bitmap format

For more details, refer to the HP OpenView Windows User's Guide, Chapter 5,
"Maps, Submaps and Snapshots," under the topic "Adding a Background
Graphic."
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Adding Custom Applications
Through the use of registration files, you can add items to the OpenView
menus which can display and graph collected information to suit your needs.
Applications can design simple on-screen reports or more sophisticated reports
that place specific information in a window. You can also build MIB
applications for on-screen reporting using the Application Builder or use the
Application Registration files for complex operations that require other
background processes to run.

Some examples are given in the following sections.  One example uses the
Application builder, the other uses the Application Registration file. You can
use these as sample applications to build your own.

In addition, Compaq has included several Application Registration files in the
Compaq Systems Management Toolkit.  When integrated into the OpenView
system, these files allow you to gather and display important information about
your Compaq systems.
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Adding the Compaq Query Files

Compaq includes Application Registration files on the Compaq Systems
Management Toolkit.  These files implement queries for the data that is
described in Appendix A, “Using the Compaq MIB Information.”  An
explanation of data contained in these items is given in that Appendix.

The Application Registration files for Compaq servers and desktops are in the
subdirectories in \OV_UX\ARF in the Toolkit.  These files are named
<filename>.ARF where <filename> denotes an MS-DOS filename base. The
path that HP OpenView uses to store Application Registration files is
/usr/OV/registration/C. You can transfer these files to your NetView console
by using one of the methods described previously in this chapter.

After you copy the MIB Query Application Registration Files to the HP
OpenView console, you must restart the OpenView application to activate the
files.  When OpenView restarts, you see two new menu items under the Monitor
menu item: Compaq Servers and Compaq Workstations.

To use the queries, select a Compaq system from a map then choose an item
from the Monitor→Compaq Server or Monitor→Compaq Workstation menu. A
window displays the information in a labeled table that corresponds to the item
you selected.  The menu items correspond with the various categories of
information described in Appendix A, “Using the Compaq MIB Information.”

If you choose not to use the query files, the following section provide examples
of obtaining the information manually.
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Slot Configuration Information

One common requirement is to add the configuration information on your
Compaq server -- what controllers have you installed in any given server?
Because the Insight Agents provide you with EISA slot information it is easy
to build an application that retrieves the configuration information and
displays it as a table. The steps are described below:

1. Select Option→Application Builder: SNMP ... from the menu bar in the HP
OpenView Windows. The MIB Application Builder dialog box displays.

2. Click on the Add button and type the name of the application in the
Application ID field:

Compaq.SlotCfg

 The information is stored in this file.

3. Select Table from the choices displayed to specify the application type.

4. Enter a suitable title for your application, such as:

EISA Slot Configuration

5. Click on the Add button. The MIB Application Builder/Add MIB Objects
dialog box displays.

6. Navigate the MIB tree to select elements from the appropriate table.
The path to the information is:

Private
Compaq

Standard Equipment
Component

EISA NVRAM
EISA Slot Table

EISA Slot Entry
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7. Select the following fields from the table:

 EISA Slot Index
EISA Slot Board ID
EISA Slot Board Name

 These fields identify the slot number, EISA ID, and board description,
respectively. For each field selected, click on the Apply  button. This
adds the field to the Display Fields list. (Optionally, you can edit the
label and width fields to suit your needs.)

8. Specify the menu path using "→" to create cascading menus. For example:

Monitor→Compaq→EISA Slot Configuration

9. Enter the selection rule to determine the conditions for highlighting
menu items that are available to the user to execute. The default is:

(isSNMPSupported) || (isSNMPProxied)

10. You can override this to specify only servers with Insight Agents as in:

(isSNMPSupported) && (isCpqInsight)

11. You can also add help text to provide assistance for using this application.
When completed, you should see a window similar to Figure 6-3.
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Figure 6-3.  Building an application for EISA configuration information

12. Click on the OK button to add the application.

13. Return to the menu bar to view the application menu choice in the path
set up in step 8 of this procedure.
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14. To verify the application, highlight a Compaq server and execute the
application. You should see a display similar to the following.

Slot Ind   Board ID    Board Name

 0 CPQ0109 COMPAQ SYSTEMPRO System Board (ASSY # 001981)
 1 CPQ4001 COMPAQ 32-Bit Intelligent Drive Array Controller
 2 NVL0701 Novell NE3200 Bus Master Ethernet
 3 (Empty)
 4 (Empty)
 5 (Empty
 6 (Empty)
 7 CPQ6100 COMPAQ 32-Bit NetFlex Controller
 8 CPQFA0D COMPAQ 32-Bit 4-Socket System Memory Board
 9 (Empty)
10 (Empty)
11 CPQ9999 COMPAQ 486/33 System Processor Board used as Primary

Getting Contact Information
From an Offline Device

Another common requirement is the need to contact node information on an
offline device, such as location, contact person, and so on. SNMP MIB-II
compliant agents provide this information, which you can easily retrieve when
the managed device is online. However, this method does not work when the
device is offline. Unfortunately, in this situation you must retrieve the
information so you can notify the contact person to investigate the failure.
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HP OpenView NNM provides a way to solve this problem:  the OpenView IP
Topology database contains information, on a per-object basis, of the IP
address, contact name, location, and so on. This database continually updates,
even if a particular managed device is offline. You can print out the
corresponding object information based on the last time HP OpenView NNM
established contact to that device. You can "dump" out the contents of the
database for any object by using the ovtopodump command as follows:

ovtopodump -l <object name> | more

You should see a display similar to the following (this example shows only
the first few lines):

HOSTNAME: test311
NODE ID: 569
CREATE TIME: 05/20/93 11:55:40
MODIFIED TIME: 06/07/93 09:16:24
SYMBOL CHANGE TIME: 06/04/93 12:34:00
STATUS: Up
FLAGS:
DESCRIPTION: Novell NetWare v3.11 (250 user)  2/20/91
DESCRIPTION: Compaq DeskPro 386, 16 MHz, 8 Meg
LOCATION: Room 69
LOCATION: 1234 Main Street
LOCATION: City, State, Country
LOCATION: The Universe
CONTACT: Jane Doe
CONTACT: 1.555.1234
CONTACT: jane.doe@company.com
SNMP OBJECT ID: 1.3.6.1.4.1.23.1.6
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The database dump provides you with useful contact information when the
managed device is offline. You can now build an application to do the following:

■ Redirect the output to a temporary file.

■ Filter out selected information to a second temporary file.

■ Put up an X Window with the contents of the second file.

■ Wait for user input to clear the window.

■ Clean up the temporary files.

To build this application, you must first "register" the application with HP
OpenView. HP OpenView stores Application Registration files in the directory
/usr/OV/registration/$LANG, where $LANG represents a language-specific
configuration. By default, these files are in the directory /usr/OV/registration/C.

For details on building Application Registration files and integrating
applications to the HP OpenView Windows menu bar, refer to the HP
OpenView Network Node Manager Administrator's Reference, Appendix B,
"Creating and Using Application Registration Files."
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The following list illustrates a sample Application Registration File:

/*
**
**  OpenView Windows Node Information
**
**  @(#)$Revision: 1.0 $
*/
Application "OpenView Windows Node Information"
{
    Version "OpenView 3.1";
    Description {
        "Dump the topo database information for the selected node."
    }
    Copyright {
      "(c)Copyright 1993 Compaq Computer Corp."
    }
    /*
    **  Monitor
    */
    MenuBar "Monitor"
    {
        "Node Info"    f.action "Topo Dump";
    }
    Action "Topo Dump"
    {
        MinSelected 1;
        MaxSelected 1;
        SelectionRule isNode;
        Command 'xterm -bg cyan -geo 115x20 \
           -sb -title "$OVwMenuItem - ($OVwSelection1)" -e sh -c \
           "/usr/OV/bin/ovtopodump -l ${OVwSelection1} > /tmp/topo.dmp;\
           awk -f /usr/OV/bin/node /tmp/topo.dmp;more /tmp/topo.prn;\
           rm /tmp/topo.* > /dev/null;read x"';
    }  }
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This application lets you select a Compaq server, even one that is offline, and view
the contact information. The application uses an AWK (programming language)
script file to include only required information in the file topo.prn. The following
list contains script for the "node" file. Include this file in your directory
/usr/OV/bin:

BEGIN {
print " " > "/tmp/topo.prn"
eof = getline
while (eof > 0)
 {
  if ($1 ==  "HOSTNAME:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "STATUS:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "DESCRIPTION:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "LOCATION:" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "CONTACT:" )
   { print $0 > "/tmp/topo.prn" }
|  if ($1 == "NODE" )
   {
     if ($2 == "LABEL:" )
      { print $0 > "/tmp/topo.prn" }
     if ($2 == "AGENT:" )|
      { print $0 > "/tmp/topo.prn" }
     if ($2 == "VENDOR:" )
      { print $0 > "/tmp/topo.prn" }
   }
  if ($1 == "SUPPORTS" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "NUMBER" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "INTERFACE:" )
   { print $0 > "/tmp/topo.prn" }
if ($1 == "IP" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "PHYSICAL" )
   { print $0 > "/tmp/topo.prn" }

continued
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if ($1 == "LAST" )
   { print $0 > "/tmp/topo.prn" }
  if ($1 == "CONSECUTIVE" )
   { print $0 > "/tmp/topo.prn" }
  eof = getline }

Figure 6-4 illustrates a sample output from the application.

Figure 6-4.  Contact information application
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Using the Information
Once you integrate the Insight MIBs and build your applications with HP
OpenView NNM, you can manage your Compaq systems in the same manner
as your other managed devices.

HP OpenView provides various methods to obtain and use the information in
the MIBs. They are:

■ Browsing the MIB

■ Predefined and custom monitor applications

■ Event configuration and monitoring

The following sections describe each of these in detail.

Browsing the MIB

HP OpenView Windows provides a quick method of browsing up and down
the MIB tree. To invoke the MIB browser, select the Monitor→MIB Values→
Browse MIB: SNMP... menu item. Start at the root, traversing up and down
any branch until you get to a MIB variable of interest. Click on the Start
Query button to retrieve information about that variable.

NOTE:   Once you load the Insight MIB files, the MIB values are available for any
selected Compaq system with the Insight Agents operational.
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Figure 6-5 displays available Insight MIBs (the exact screen content depends
on your installation):

Figure 6-5.  Browsing the Compaq MIB subtree

You can also SET Insight MIB variable values when browsing the MIB subtree.

IMPORTANT:  Insight Agents for each operating system might have different levels of
SET support. Refer to the appropriate Compaq Insight Management Agents User Guide for
more information.

For example, select the subtree and start a query to retrieve the existing value
to update the contact information. Select the value you want to change, and
enter a new value. When you click on the Set button, the MIB value updates.
Figure 6-6 illustrates an example.
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Figure 6-6.  Setting MIB values

For details on browsing the MIB and setting values, see the HP OpenView
Network Node Manager User's Guide, Chapter 6, "Using Network Node Manager
Operations," under the topics "Viewing MIB Values" and "Setting MIB Values."
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Predefined and Custom Monitor Applications

Browsing MIB values is just one example of the many predefined applications
available to you on the Monitor menu of the HP OpenView Windows menu
bar. Compaq has included several custom MIB query files in the Compaq
Systems Management Toolkit which provide important configuration,
statistical, and condition information.

As discussed in "Adding Custom Applications" of this chapter, you can further
enhance the predefined suite of applications by building your own.

Applications on the Monitor menu only provide you with on-screen reports.
They can also graph trends in MIB variables. For example, to monitor the traffic
of a particular network interface controller in a server, follow these steps:

1. Highlight the server symbol on the map.

2. Select Monitor→Network Activity→Interface: Traffic ... from the menu
bar. When the data processing completes, a window displays the
network traffic graph.

For more details on using these applications, refer to the HP OpenView
Network Node Manager User's Guide, Chapter 6, "Using Network Node
Manager Operations."
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Event Monitoring

An event is a notification of change in your network. HP OpenView NNM
categorizes events into:

■ Threshold events

■ Network topology events

■ Error events

■ Status events

■ Node configuration events

■ Application alert events

■ All of the above

You can use the Event Notification window to view selectively a particular
category of events, or all events. You can further narrow your selection to a
particular highlighted symbol (for example, a specific Compaq server).

You can proactively monitor the health of your network using events. This
TechNote does not include a detailed discussion of event monitoring. For
guidelines on establishing baselines, monitoring trends, setting up thresholds
on MIB values, and so on, refer to the HP OpenView Network Node Manager
User's Guide, Chapter 4, "Monitoring Your Network."
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Handling Traps
Traps are a method of reducing network traffic. An agent can send information
to a management PC when requested, or unsolicited. Traps, unsolicited
information, indicate something changed at the agent that requires attention.

If you do not specify the HP OpenView console as a trap destination, the traps
remain locally at the agent. This means that the HP OpenView NNM does not
know about an impending problem until it polls the agent about the specific
problem area. Excessive polling generates heavy network traffic and degrades
performance. Therefore, Compaq strongly recommends that you set up at least
one trap destination at each critical server to the IP address or hostname of
your HP OpenView NNM console.

Trap IDs have a generic part and a specific part. The generic part of a Compaq
trap is always six (for Enterprise-Specific traps). Zero through five are used as
part of the SNMP definition for other trap types. The specific part depends on
the type of error.
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Setting Up Compaq Traps

Compaq provides files in the Compaq Systems Management Toolkit that enable
OpenView to save Compaq enterprise traps to the OpenView event log. Refer to
the README.TXT file in the \OV_UX directory in the Toolkit for more
information.

NOTE:  If you use the files provided in the Compaq Systems Management Toolkit,
the following steps are not required.

If you wish to set up Compaq traps manually, perform the following steps:

1. Select Options→Event Configuration: SNMP.

2. Press the Add button in the dialog box.

3. Add a new enterprise for Compaq, using the following ID:

 Compaq             1.3.6.1.4.1.232

4. For each enterprise, add the generic trap ID (six) and specific trap IDs
that you want. For details on Compaq trap IDs, refer to Appendix A,
"Using the Compaq MIB Information."

Insight Agents version 1.x defines one enterprise per subsystem, for example,
Compaq-IDA = 1.3.6.1.4.1.232.3, Compaq-SCSI = 1.3.6.1.4.1.232.5, and so on.

Insight Agents versions 2.x and 3.x define a single enterprise, for example,
Compaq = 1.3.6.1.4.1.232, and the specific ID of the trap type defines the
subsystem, for example, 30xx for IDA, 50xx for SCSI.

IMPORTANT:  For compatibility with older systems, you must configure your HP
OpenView console to handle traps from both the older and newer NetWare Agents.
Windows NT, SCO UNIX, and OS/2 agents follow the Compaq Insight Manager 2.x and
3.x format.
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The following figure illustrates a sample configuration for a Compaq
Intelligent Drive Array enterprise ID, and a specific trap ID of four, implying
that the physical drive threshold was exceeded.

NOTE:  Figure 6-7 displays an Insight Agent, version 1.x trap.

Figure 6-7.  Setting up a Compaq IDA trap definition

Once the trap definitions are set up, you can view new traps through the
Events Notification window, similar to other events. The following displays a
sample event list with Compaq IDA traps.

NOTE:  The following example illustrates a version 1.x trap.

Wed Jun 02 08:09:37 1993 remote_as A
Trap #6, specific: 4, args (1):

Wed Jun 02 08:09:37  remote_as A
[1] cpqDaPhyDrvEntry.cpqDaPhyDrvThresh

Passed.1.4   (Integer): 2
Wed Jun 02 08:09:38 1993 remote_as A
Trap #6, specific: 4, args (1):

Wed Jun 02 09:08:38  remote_as A
[1] cpqDaPhyDrvEntry.cpqDaPhyDrvThresh

Passed.1.3   (Integer): 2
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Troubleshooting

If you do not receive traps at your HP OpenView console when your network
is operational, check the following:

■ Verify the configuration of the managed devices to ensure they are
forwarding traps to your HP OpenView console.

■ Verify the read and read-write community settings.

Refer to the HP OpenView Network Node Manager Administrator's Reference,
Chapter 4, "Troubleshooting," under the topic "Configuring Events" for more
troubleshooting tips.

Integration to Other Systems
Hewlett-Packard and other third parties provide HP OpenView platform
support with products in several areas of network management such as
problem solving, configuration management, capacity planning, trouble
ticketing, and so on. For details about additional products, contact:

Hewlett-Packard Company
3404 East Harmony Road
Fort Collins, CO  80525  USA

You can also build custom applications using the HP OpenView APIs.
This TechNote does not discuss these techniques in detail. However, it is
possible for you to integrate HP OpenView NNM to other systems with
limited programming. For example, sending e-mail messages from
HP OpenView NNM as a result of receiving a trap from a Compaq server.
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Event Notification via E-Mail
Significant events often require some action from an administrator. One way
to notify an administrator is to send a message to the administrator's mailbox.

To set up HP OpenView NNM to send e-mail messages, ensure that:

■ Your domain name is set correctly and matches the domain name of
other computers on the network. The following is an example format of
domain name: Yourcompanyname.com.

■ You can send e-mail. As a test, try to send mail to your login ID at the
HP OpenView console. If you logged in as root, use root as the mail ID.

For each event that you forward to the mail gateway, you must set up the
optional command argument field on the Event Configuration screen as
follows (replace the "Admin@Sysmgtpo" with your own mail address):

/usr/local/bin/mailevent "Compaq IDA trap received from node: $A with $# args:\n$*" "Admin@Sysmgtpo"
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Ffigure 6-8 shows an example of configuring an event to send mail:

Figure 6-8.  Configuring an event to send mail
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When the event occurs, it invokes the mailevent script, sending the mail message.
The contents of the mailevent script include:

MSG=$1
TO=$2
echo "${MSG}" | /usr/lib/sendmail "${TO}"

For further details on configuring, refer to the HP OpenView Network Node
Manager 3.0 User's Guide, Chapter 4, "Monitoring Your Network," under the
topic "Setting up Event-Triggered Actions." Refer to HP OpenView online help
for details on the $A, $#, and $* parameters in the trap notification message.

Some points about setting up events:

■ Choose the events carefully. Do not flood the administrator's mailbox
with an e-mail message for every event occurring in the network.

■ Try to route different classes of events to different people. For
instance, one person might be notified about critical events for routers,
another might be notified only of server events, and so on.
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Appendix A  
Using the Compaq MIB
Information

This appendix provides you with information that will help you use Insight
MIBs in your SNMP environment. It includes an overview of the Insight MIBs
organization and identifies and describes categories of information contained
within the MIBs. This information provides common types of information that
you may want to know about the servers in your network.

  Organization of Compaq Insight MIBs
As stated in Chapter 3 of this TechNote, “Compaq Server Management
Technology,” Compaq fully supports the SNMP standard. The assigned
enterprise ID for Compaq is 232. Therefore, all MIB variables maintained by
Compaq begin with the ASN.1 syntax 1.3.6.1.4.1.232.

Compaq has defined several MIBs in the Compaq enterprise. The MIBs are
classified, where appropriate, according to the subsystem of a Compaq server.
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The following table lists all the current Insight MIBs and a description of each.

Table A-1
Compaq Insight Management MIBs

MIB Name: Standard Equipment
Object ID: 1.3.6.1.4.1.232.1
MIB File Name: CPQSTDEQ.MIB

Purpose:  Contains information that is available on any ISA or EISA system, including system
processor, memory, ISA CMOS, EISA NVRAM, serial port, parallel port, ROM, diskette drives, and
IDE-compatible hard drive information.

MIB Name: System Information
Object ID: 1.3.6.1.4.1.232.2
MIB File Name: CPQSINFO.MIB

Purpose:  Contains information about Compaq specific features, including Compaq security
features, memory module information, board revision information, asset management
information, and other system board specific information.

MIB Name: Intelligent Drive Array
Object ID: 1.3.6.1.4.1.232.3
MIB File Name: CPQIDA.MIB

Purpose:  Contains information about the Compaq Drive Array Controllers and drives connected
to these controllers, including the SMART Controller, IDA-2 Controller, IDA Expansion Controller,
and IDA Controller.

MIB Name: Server Manager
Object ID: 1.3.6.1.4.1.232.4
MIB File Name:  CPQSRVMN.MIB

Purpose:  Contains information about the Compaq Server Manager/R board.

MIB Name: SCSI Device System
Object ID: 1.3.6.1.4.1.232.5
MIB File Name:  CPQSCSI.MIB

Purpose:  Contains information about the Compaq SCSI interface products, including SCSI drives
and generic SCSI device and controller information. This MIB also includes SCSI tape and CD-
ROM information. It does not include SMART controller information, which is incorporated into
the Intelligent Drive Array MIB.

continued
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Compaq Insight Management MIBs   continued

MIB Name: Health
Object ID: 1.3.6.1.4.1.232.6
MIB File Name:  CPQHLTH.MIB

Purpose:  Contains information about system health features, including Critical Error Log,
Correctable Error Log, ASR feature, Thermal (temperature and fan) sensing features, POST
Message tracking, System lifetime, and EISA bus utilization.

MIB Name: SCSI Storage System
Object ID: 1.3.6.1.4.1.232.8
MIB File Name:  CPQSTSYS.MIB

Purpose:  Contains information about the Compaq ProLiant Storage System.

MIB Name: Remote Insight Board
Object ID: 1.3.6.1.4.1.232.9
MIB File Name:  CPQSM2.MIB

Purpose:  Contains information about the Compaq Remote Insight Board.

MIB Name: Threshold Management
Object ID: 1.3.6.1.4.1.232.10
MIB File Name:  CPQTHRSH.MIB

Purpose:  Contains information about the Insight software components that can generate alarms
based on user defined thresholds and can track statistics on attributes based on user input.

MIB Name: Host Operating System
Object ID: 1.3.6.1.4.1.232.11
MIB File Name: CPQHOST.MIB

Purpose:  Contains information about host operating system information. This information
includes host OS identification information, system processor utilization information, file system
information, NIC interface to hardware mapping information, and loaded modules information.

MIB Name: UPS
Object ID: 1.3.6.1.4.1.232.12
MIB File Name:  CPQUPS.MIB

Purpose:  Contains information about the Compaq Uninterrruptible Power Supply (UPS) product.

continued
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Compaq Insight Management MIBs   continued

MIB Name: Recovery
Object ID: 1.3.6.1.4.1.232.13
MIB File Name: CPQRECOV.MIB

Purpose: Contains information about the Compaq Recovery Server option.

MIB Name: IDE Drive
Object ID: 1.3.6.1.4.1.232.14
MIB File Name:  CPQIDE.MIB

Purpose:  Contains information about manageable Compaq IDE Drives

NOTE:  Object ID 232.7 is not currently in use.
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Key MIB Information
The Insight MIBs contain many attributes that provide you with a
comprehensive picture of the configuration, operating statistics, and general
status aspects of the operation of your Compaq servers. However, since there are
several hundred MIB attributes, the following discussion focuses on several
categories which contain key attributes on major subsystems within your
servers. Once you identify a potential problem area, you can retrieve additional
information to assist you with a specific problem resolution.

The key MIB information falls into the following general categories:

■ Configuration

■ Operating Statistics

■ Condition Attributes

The following sections describe each general category and provide detailed
subsets within each main category. Detailed information about each item is found
in the referenced MIB file for each item. The MIB files are in the \MIBS
directory in the Systems Management Toolkit on the Compaq Management CD.

These items are provided to enable you to construct queries which will
provide specific details in monitoring your systems. Compaq has included
files in the Compaq Systems Management Toolkit for HP OpenView and IBM
NetView for AIX which implement queries based upon these items. Refer to
Chapter 6 for instructions on how to integrate the query files into HP
OpenView. Refer to Chapter 4 for instructions on how to integrate the query
files into IBM NetView for AIX.
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Configuration

The MIB items in the following configuration categories describe information
that is determined at system configuration or operating system load time.
They typically do not change as a result of ongoing operation of the hardware
or software. MIB items in these categories provide you with information about
the static configuration of the hardware and software of your system.

  General System Description

The items in this category describe several items which come from the
standard SNMP MIB-II (RFC1213) that are of interest in generally identifying
the system. Consult this MIB, which is included with your management
console software, for more information on these items.

Table A-2
General System Description Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

System Name sysName 1.5 RFC1213

System Description sysDesc 1.1 RFC1213

System Contact sysContact 1.4 RFC1213

System Location sysLocation 1.6 RFC1213

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.2.1. to construct the full
ASN.1 number for the item.
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Hardware Asset Descriptions

The items in this category describe items of a general hardware inventory
nature. Consult the referenced MIB file(s) for more information on these
items.

Table A-3
Hardware Asset Descriptions

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Total System Memory cpqSeTotalMem 1.2.3.2 CPQSTDEQ.MIB

Keyboard Description cpqSeKeyboardDesc 1.2.7.1 CPQSTDEQ.MIB

Video System
Description

cpqSeVideoDesc 1.2.8.1 CPQSTDEQ.MIB

Product Name cpqSiProductName 2.2.4.2 CPQSINFO.MIB

System Serial Number cpqSiSysSerialNum 2.2.2.1 CPQSINFO.MIB

CPU Index cpqSeCpqUnitIndex 1.2.2.1.1.1 CPQSTDEQ.MIB

CPU Name cpqSeCpuName 1.2.2.1.1.3 CPQSTDEQ.MIB

CPU Speed cpqSeCpuSpeed 1.2.2.1.1.4 CPQSTDEQ.MIB

Floppy Disk Type cpqSeFloppyDiskType 1.2.11.1.1.2 CPQSTDEQ.MIB

IDE/ESDI Disk Size(s) cpqSeFixedDiskCapacity 1.2.12.1.1.6 CPQSTDEQ.MIB

SCSI Disk Size(s) cpqScsiPhyDrvSize 5.2.4.1.1.7 CPQSCSI.MIB

Drive Array Disk Size(s) cpqDaPhyDrvSize 3.2.5.1.1.45 CPQIDA.MIB

SCSI Tape Type(s) cpqTapePhyDriveType 5.4.1.1.1.4 CPQSCSI.MIB

IDE Drive Identification
Table

cpqIdeIdentIndex 14.2.2.1.1 CPQIDE.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.
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Compaq Software Inventory

The items in this category provide information about the Compaq device
drivers, Insight agents, and system utilities installed on your system. Consult
the referenced MIB file(s) for more information on these items.

Table A-4
Compaq Software Inventory Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Software Type cpqHoSwVerType 2.7.2.1.3 CPQHOST.MIB

Software Name cpqHoSwVerName 2.7.2.1.4 CPQHOST.MIB

Software Version cpqHoSwVerVersion 2.7.2.1.8 CPQHOST.MIB

Software Description cpqHoSwVerDescription 2.7.2.1.5 CPQHOST.MIB

Software Location cpqHoSwVerLocation 2.7.2.1.7 CPQHOST.MIB

Software Status cpqHoSwVerStatus 2.7.2.1.2 CPQHOST.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.11. to construct
the full ASN.1 number for the item.
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Operating System

The items in this category provide general information about the operating
system (OS) running on your system. Consult the referenced MIB file(s) for
more information on these items.

Table A-5
Operating System Configuration Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

OS Name cpqHoName 2.2.1 CPQHOST.MIB

OS Version cpqHoVersion 2.2.2 CPQHOST.MIB

OS Description cpqHoDesc 2.2.3 CPQHOST.MIB

File System Description cpqHoFileSysDesc 2.4.1.1.2 CPQHOST.MIB

Total File Space cpqHoFileSysSpaceTotal 2.4.1.1.3 CPQHOST.MIB

Total File Names cpqHoFileSysAllocUnitsTotal 2.4.1.1.6 CPQHOST.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.11. to construct
the full ASN.1 number for the item.
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Detailed Hardware Configuration

The items in this category provide detailed information about the hardware
configuration of your system. Consult the referenced MIB file(s) for more
information on these items.

Table A-6
Hardware Configuration Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Total System Memory cpqSeTotalMem 1.2.3.2 CPQSTDEQ.MIB

System ROM Version cpqSeSysRomVer 1.2.6.1 CPQSTDEQ.MIB

CPU Name cpqSeCpuName 1.2.2.1.1.3 CPQSTDEQ.MIB

CPU Speed cpqSeCpuSpeed 1.2.2.1.1.4 CPQSTDEQ.MIB

Floating Point
Co-processor Name

cpqSeFpuName 1.2.2.2.1.4 CPQSTDEQ.MIB

Floating Point
Co-processor Speed

cpqSeFpuSpeed 1.2.2.2.1.5 CPQSTDEQ.MIB

CPU Cache Index cpqSeCacheLevelIndex 1.2.2.3.1.2 CPQSTDEQ.MIB

CPU Cache Size cpqSeCpuCacheSize 1.2.2.3.1.3 CPQSTDEQ.MIB

CPU Cache Speed cpqSeCpuCacheSpeed 1.2.2.3.1.4 CPQSTDEQ.MIB

CPU Cache Status cpqSeCpuCacheStatus 1.2.2.3.1.5 CPQSTDEQ.MIB

Serial Port Address cpqSeSerialPortAddr 1.2.9.1.1.2 CPQSTDEQ.MIB

Serial Port Description cpqSeSerialPortDesc 1.2.9.1.1.3 CPQSTDEQ.MIB

Parallel Port Address cpqSeParallelPortAddr 1.2.10.1.1.2 CPQSTDEQ.MIB

Parallel Port Description cpqSeParallelPortDesc 1.2.10.1.1.3 CPQSTDEQ.MIB

Floppy Disk Type cpqSeFloppyDiskType 1.2.11.1.1.2 CPQSTDEQ.MIB

Continued
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Hardware Configuration Items  continued

Data Item Description MIB Item Name ASN.1 No. MIB File Name

IDE/ESDI Disk Size cpqSeFixedDiskCapacity 1.2.12.1.1.6 CPQSTDEQ.MIB

SCSI Disk Model cpqScsiPhyDriveModel 5.2.4.1.1.4 CPQSCSI.MIB

SCSI Disk Firmware Revision cpqScsiPhyDrvFWRev 5.2.4.1.1.5 CPQSCSI.MIB

SCSI Disk ID cpqScsiPhyDrvScsiID 5.2.4.1.1.8 CPQSCSI.MIB

SCSI Disk Size cpqScsiPhyDrvSize 5.2.4.1.1.7 CPQSCSI.MIB

SCSI Tape Model cpqTapePhyDrvType 5.4.1.1.1.5 CPQSCSI.MIB

SCSI Tape Magazine Size cpqTapePhyDrvMagSize 5.4.1.1.1.7 CPQSCSI.MIB

Drive Array Disk Model cpqDaPhyDrvModel 3.2.5.1.1.3 CPQIDA.MIB

Drive Array Disk Firmware
Revision

cpqDaPhyDrvFWRev 3.2.5.1.1.4 CPQIDA.MIB

Drive Array Disk Size cpqDaPhyDrvSIze 3.2.5.1.1.45 CPQIDA.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.

  Operating Statistics

The MIB items in the following operating statistics categories describe the
ongoing operation of your system hardware and software.

  Hard Drive Read/Write/Seek

The items in this category provide information about the number of read,
write and seek operations that are occurring on your system. This information
is available for SCSI, IDA, IDA-2 and SMART devices. Over time, this
information can be used to determine rates of hard drive usage. Consult the
referenced MIB file(s) for more information on these items.
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Table A-7
Hard Drive Read/Write/Seek Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Drive Array Drive Index cpqDaPhyDrvIndex 3.2.5.1.1.2 CPQIDA.MIB

Drive Array Sectors Read
(high)

cpqDaPhyDrvHReads 3.2.5.1.1.10 CPQIDA.MIB

Drive Array Sectors Read
(low)

cpqDaPhyDrvReads 3.2.5.1.1.11 CPQIDA.MIB

Drive Array Sectors Written
(high)

cpqDaPhyDrvHWrites 3.2.5.1.1.12 CPQIDA.MIB

Drive Array Sectors Written
(low)

cpqDaPhyDrvWrites 3.2.5.1.1.13 CPQIDA.MIB

Drive Array Seeks (high) cpqDaPhyDrvHSeeks 3.2.5.1.1.14 CPQIDA.MIB

Drive Array Seeks (low) cpqDaPhyDrvSeeks 3.2.5.1.1.15 CPQIDA.MIB

SCSI Drive Index cpqScsiPhyDrvIndex 5.2.4.1.1.3 CPQSCSI.MIB

SCSI Drive Sectors Read
(high)

cpqScsiPhyDrvHighRead
Sectors

5.2.4.1.1.11 CPQSCSI.MIB

SCSI Drive Sectors Read
(low)

cpqScsiPhyDrvLowRead
Sectors

5.2.4.1.1.12 CPQSCSI.MIB

SCSI Drive Sectors Written
(high)

cpqScsiPhyDrvHighWrite
Sectors

5.2.4.1.1.13 CPQSCSI.MIB

SCSI Drive Sectors Written
(low)

cpqScsiPhyDrvLow
WriteSectors

5.2.4.1.1.14 CPQSCSI.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.
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Hard Drive Errors

The items in this category provide information about a variety of errors that
can occur in the SCSI, IDA, IDA-2 or SMART disk subsystems. This
information can be used to pinpoint errors that may occur in the ongoing
operation of your system. Consult the referenced MIB file(s) for more
information on these items.

Table A-8
Hard Drive Error Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Drive Array Drive Index cpqDaPhyDrvIndex 3.2.5.1.1.2 CPQIDA.MIB

Drive Array Hard Read Errors cpqDaPhyDrvHardReadErrs 3.2.5.1.1.16 CPQIDA.MIB

Drive Array Recovered Read
Errors

cpqDaPhyDrvRecvReadErrs 3.2.5.1.1.17 CPQIDA.MIB

Drive Array Recovered Write
Errors

cpqDaPhyDrvRecvWriteErrs 3.2.5.1.1.19 CPQIDA.MIB

Drive Array Seek Errors (high) cpqDaPhyDrvHSeekErrs 3.2.5.1.1.20 CPQIDA.MIB

Drive Array Seek Errors (low) cpqDaPhyDrvSeekErrs 3.2.5.1.1.21 CPQIDA.MIB

Drive Array Data Request
Timeout

cpqDaPhyDrvDrqTimeouts 3.2.5.1.1.26 CPQIDA.MIB

Drive Array Other Timeouts cpqDaPhyDrvOtherTimeouts 3.2.5.1.1.27 CPQIDA.MIB

Drive Array Format Errors cpqDaPhyDrvFormatErrs 3.2.5.1.1.31 CPQIDA.MIB

Drive Array POST Errors cpqDaPhyDrvPostErrs 3.2.5.1.1.32 CPQIDA.MIB

Drive Array Not Ready Errors cpqDaPhyDrvNotReadyErrs 3.2.5.1.1.33 CPQIDA.MIB

Drive Array Spin Up Errors cpqDaPhyDrvSpinUpErrs 3.2.5.1.1.42 CPQIDA.MIB

Continued
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Hard Drive Error Items  continued

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Drive Array Bus Faults cpqDaPhyDrvBusFaults 3.2.5.1.1.46 CPQIDA.MIB

Drive Array Accelerator Index cpqDaAccelCntlrIndex 3.2.2.2.1.1 CPQIDA.MIB

Drive Array Accelerator Read
Errors

cpqDaAccelReadErrs 3.2.2.2.1.7 CPQIDA.MIB

Drive Array Accelerator Write
Errors

cpqDaAccelWriteErrs 3.2.2.2.1.8 CPQIDA.MIB

SCSI Drive Index cpqScsiPhyDrvIndex 5.2.4.1.1.3 CPQSCSI.MIB

SCSI Drive Hard Read Errors cpqScsiPhyDrvHardReadErrs 5.2.4.1.1.15 CPQSCSI.MIB

SCSI Drive Hard Write Errors cpqScsiPhyDrvHardWriteErrs 5.2.4.1.1.16 CPQSCSI.MIB

SCSI Drive Seek Errors cpqScsiPhyDrvSeekErrs 5.2.4.1.1.20 CPQSCSI.MIB

SCSI Drive Timeouts cpqScsiPhyDrvTimeouts 5.2.4.1.1.23 CPQSCSI.MIB

SCSI Drive POST Errors cpqScsiPhyDrvPostErrs 5.2.4.1.1.24 CPQSCSI.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.

  Tape Drive Read/Write Items

The items in this category provide information about the number of bytes that
have been read or written to the tape device(s) on your system.  Consult the
referenced MIB file(s) for more information on these items.

Table A-9
Tape Drive Read/Write Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

SCSI Tape Index cpqTapeCountersScsiIdIndex 5.4.2.1.1.3 CPQSCSI.MIB

SCSI Tape Read/Write
Bytes

cpqTapeCountersTotalBytes 5.4.2.1.1.9 CPQSCSI.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.
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SCSI Tape Drive Errors

The items in this category provide information about a variety of errors that
can occur in the SCSI tape subsystems. This information can be used to
pinpoint errors that might occur in the ongoing operation of your system.
Consult the referenced MIB file(s) for more information on these items.

Table A-10
SCSI Tape Drive Error Items

Data Item Description MIB Item Name ASN.1 No. MIB File
Name

SCSI Tape Index cpqTapeCountersScsiIdIndex 5.4.2.1.1.3 CPQSCSI.MIB

SCSI Tape Re-Writes cpqTapeCountersReWrites 5.4.2.1.1.5 CPQSCSI.MIB

SCSI Tape Re-Reads cpqTapeCountersReReads 5.4.2.1.1.6 CPQSCSI.MIB

SCSI Tape Total Errors cpqTapeCountersTotalErrors 5.4.2.1.1.7 CPQSCSI.MIB

SCSI Tape Uncorrectable
Errors

cpqTapeCountersTotalUncorrectable 5.4.2.1.1.8 CPQSCSI.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-16    Using the Compaq MIB Information

Network Interface Card

The items in this category provide information about the operation of the
network interface cards (NICs) in your system. Over time, these can be used
to determine rates of use and to identify potential network problems. The
items in this category are from the standard MIB RFC1213 (MIB-II) which is
included with your management console software. Consult this MIB for
further information on these items.

Table A-11
NIC Information Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Interface Index ifIndex 2.2.1.1 RFC1213

Bytes Received ifInOctets 2.2.1.10 RFC1213

Bytes Transmitted ifOutOctets 2.2.1.16 RFC1213

Broadcast Packets Received ifInNUcastPkts 2.2.1.12 RFC1213

Broadcast Packets Transmitted ifOutNUcastPkts 2.2.1.18 RFC1213

Packets Received with Errors ifInErrors 2.2.1.14 RFC1213

Packets Transmitted with Errors ifOutErrors 2.2.1.20 RFC1213

Received Packets Discarded ifInDiscards 2.2.1.13 RFC1213

Transmitted Packets Discarded ifOutDiscards 2.2.1.19 RFC1213

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.2.1. to construct the full
ASN.1 number for the item.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-17

Integrating Compaq Insight Manager with Enterprise Management Platforms

Operating System Resource Utilization

The items in this category provide information about operating system
resource usage of several key system components. Consult the referenced MIB
file(s) for more information on these items.

Table A-12
Operating System Resource Usage Items

Data Item Description MIB Item Name ASN.1 No. MIB File
Name

CPU Index cpqHoCpuUtilUnitIndex 2.3.1.1.1 CPQHOST.MIB

CPU Utilization - One Minute cpqHoCpuUtilMin 2.3.1.1.2 CPQHOST.MIB

CPU Utilization - Five Minute cpqHoCpuUtilFiveMin 2.3.1.1.3 CPQHOST.MIB

CPU Utilization - Thirty Minute cpqHoCpuUtilThirtyMin 2.3.1.1.4 CPQHOST.MIB

CPU Utilization - One Hour cpqHoCpuUtilOneHour 2.3.1.1.5 CPQHOST.MIB

File System Description cpqHoFileSysDesc 2.4.1.1.2 CPQHOST.MIB

File System Size cpqHoFileSysSpaceTotal 2.4.1.1.3 CPQHOST.MIB

File System Space Used (MB) cpqHoFileSysSpaceUsed 2.4.1.1.4 CPQHOST.MIB

File System Space Used (%) cpqHoFileSysPercentSpaceUsed 2.4.1.1.5 CPQHOST.MIB

Total Files Allowed cpqHoFileSysAllocUnitsTotal 2.4.1.1.6 CPQHOST.MIB

Total Number of Files cpqHoFileSysAllocUnitsUsed 2.4.1.1.7 CPQHOST.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.11. to construct
the full ASN.1 number for the item.
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Hardware Utilization

The items in this category provide information about the utilization of the
system hardware resources. Consult the referenced MIB file(s) for more
information on these items.

Table A-13
Hardware Utilization Items

Data Item Description MIB Item Name ASN.1 No. MIB File
Name

System Lifetime Power On Time cpqHeSysUtilLifetime 2.8.1 CPQHLTH.MIB

EISA Bus Utilization - One Minute cpqHeSysUtilEISABusMin 2.8.2 CPQHLTH.MIB

EISA Bus Utilization - Five Minute cpqHeSysUtilEISABusFiveMin 2.8.3 CPQHLTH.MIB

EISA Bus Utilization - Thirty
Minute

cpqHeSysUtilEISABusThirtyMin 2.8.4 CPQHLTH.MIB

EISA Bus Utilization - One Hour cpqHeSysUtilEISABusHour 2.8.5 CPQHLTH.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.6. to construct
the full ASN.1 number for the item.
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Fault Identification

The items in this category provide the information recorded by the fault
recording features of your system. Consult the referenced MIB file(s) for more
information on these items.

Table A-14
Fault Identification Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Critical Error Type cpqHeCriticalErrorType 2.2.4.1.3 CPQHLTH.MIB

Critical Error Description cpqHeCriticalErrorDesc 2.2.4.1.6 CPQHLTH.MIB

Correctable Memory Error
Description

cpqHeCorrMemErrDesc 2.3.4.1.6 CPQHLTH.MIB

POST Error Code cpqHePostMsgCode 2.7.2.1.2 CPQHLTH.MIB

POST Error Description cpqHePostMsgDesc 2.7.2.1.3 CPQHLTH.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.6. to construct
the full ASN.1 number for the item.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-20    Using the Compaq MIB Information

Condition Attributes

To help you focus on the important factors that ensure reliable operation of your
server, Compaq has developed condition MIB attributes. These attributes are a
composite of several other attributes related to a specific subsystem. If you
monitor the condition variables, they reveal an accurate picture of the health of
your server.  The following sections describe these condition attributes.

  Drive Array

The items in this category provide information about the general condition of
your Compaq Drive Array Subsystem. When one of these status items
becomes set to “Degraded” or “Failed,” you should then query the items
specified in the “Hard Drive Errors” section in this appendix to pinpoint the
error. Consult the referenced MIB file(s) for more information on these items.

Table A-15
Drive Array Status Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Drive Array Index cpqDaCntlrIndex 2.2.1.1.1 CPQIDA.MIB

Controller Condition cpqDaCntlrCondition 2.2.1.1.6 CPQIDA.MIB

Drive Array Accelerator Index cpqDaAccelCntlrIndex 2.2.2.1.1 CPQIDA.MIB

Drive Array Accelerator Condition cpqDaAccelCntlrCondition 2.2.2.1.9 CPQIDA.MIB

Spare Drive Controller Index cpqDaSpareCntlrIndex 2.4.1.1.1 CPQIDA.MIB

Spare Drive Index cpqDaSparePhyDrvIndex 2.4.1.1.2 CPQIDA.MIB

Spare Drive Condition cpqDaSpareCondition 2.4.1.1.6 CPQIDA.MIB

Drive Controller Index cpqDaPhyDrvControllerIndex 2.5.1.1.1 CPQIDA.MIB

Drive Index cpqDaPhyDrvIndex 2.5.1.1.2 CPQIDA.MIB

Drive Condition cpqDaPhyDrvCondition 2.5.1.1.37 CPQIDA.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.3. to construct
the full ASN.1 number for the item.
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SCSI Disk

The items in this category provide information about the general condition of the
SCSI disks attached to the SCSI channel(s) of your system. When one of these
status items becomes set to “Degraded” or “Failed,” you should then query the
items specified in the “Hard Drive Errors” section in this appendix to pinpoint the
error. Consult the referenced MIB file(s) for more information on these items.

Table A-16
SCSI Disk Status Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

SCSI Controller Index cpqScsiCntlrIndex 2.2.1.1.1 CPQSCSI.MIB

SCSI Controller Bus Index cpqScsiCntlrBusIndex 2.2.1.1.2 CPQSCSI.MIB

SCSI Controller Status cpqScsiCntlrStatus 2.2.1.1.7 CPQSCSI.MIB

SCSI Controller Condition cpqScsiCntlrCondition 2.2.1.1.12 CPQSCSI.MIB

SCSI Drive Controller Index cpqScsiPhyDrvCntlrIndex 2.4.1.1.1 CPQSCSI.MIB

SCSI Bus Index cpqScsiPhyDrvBusIndex 2.4.1.1.2 CPQSCSI.MIB

SCSI Drive Index cpqScsiPhyDrvIndex 2.4.1.1.3 CPQSCSI.MIB

SCSI Drive Status cpqScsiPhyDrvStatus 2.4.1.1.9 CPQSCSI.MIB

SCSI Drive Condition cpqScsiPhyDrvCondition 2.4.1.1.26 CPQSCSI.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.5. to construct
the full ASN.1 number for the item.
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SCSI Tape Drive

The items in this category provide information about the general condition of
the SCSI tape drive(s) attached to the SCSI channel(s) of your system. When
one of these status items becomes set to “Degraded” or “Failed,” you should
then query the items specified in the “SCSI Tape Drive Errors” section in this
appendix to pinpoint the error. Consult the referenced MIB file(s) for more
information on these items.

Table A-17
SCSI Tape Drive Status Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

SCSI Controller Index cpqTapePhyDrvCntlrIndex 5.4.1.1.1.1 CPQSCSI.MIB

SCSI Tape ID cpqTapePhyDrvScsiIdIndex 5.4.1.1.1.3 CPQSCSI.MIB

SCSI Tape Drive Condition cpqTapePhyDrvCondition 5.4.1.1.1.6 CPQSCSI.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.
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System Environment

The items in this category provide information about the general condition of
the environment associated with your system and external storage system.
Consult the referenced MIB file(s) for more information on these items.

Table A-18
System Environment Status Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Overall Thermal Condition cpqHeThermalCondition 6.2.6.1 CPQHLTH.MIB

System Temperature Status cpqHeThermalTempStatus 6.2.6.3 CPQHLTH.MIB

System Fan Status cpqHeThermalSystemFanStatus 6.2.6.4 CPQHLTH.MIB

CPU Fan Status cpqHeThermalCpuFanStatus 6.2.6.5 CPQHLTH.MIB

Storage System Type cpqSsBoxType 8.2.1.1.3 CPQSTSYS.MIB

Storage System Index cpqSsBoxBusIndex 8.2.1.1.2 CPQSTSYS.MIB

Storage System Fan Status cpqSsBoxFanStatus 8.2.1.1.7 CPQSTSYS.MIB

Storage System Temperature
Status

cpqSsBoxTempStatus 8.2.1.1.9 CPQSTSYS.MIB

Storage System Side Panel
Status

cpqSsBoxSidePanelStatus 8.2.1.1.10 CPQSTSYS.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232. to construct the
full ASN.1 number for the item.
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Fault Identification and Recovery

The items in this category provide information about the general condition of
the fault identification and recovery features of your system. The logs that
record any events are described by the items in the “Fault Identification”
section in this appendix. Consult the referenced MIB file(s) for more
information on these items.

Table A-19
Fault and Recovery Features Status Items

Data Item Description MIB Item Name ASN.1 No. MIB File Name

Automatic Server Recovery
Status

cpqHeAsrCondition 2.5.17 CPQHLTH.MIB

POST Error Message Recording
Status

cpqHePostMsgCondition 2.7.1 CPQHLTH.MIB

Correctable Memory Log Status cpqHeCorrMemLogCondition 2.3.2 CPQHLTH.MIB

Critical Error Log Condition cpqHeCritLogCondition 2.2.2 CPQHLTH.MIB

NOTE:  The ASN.1 numbers should be prefixed by 1.3.6.1.4.1.232.6. to construct
the full ASN.1 number for the item.
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Using the MIB Information

The primary usage of the condition attributes is to provide a high-level status of
major subsystems within your system. You can monitor these items on a
periodic basis. Any change in status from “OK” indicates that you should
investigate the subsystem further. The following sections provide some
examples of the kinds of activities that can be supported by using the
information provided by the MIBs.

  Environment

The environment condition items provide information about the
environmental conditions in and around your system. If one of them becomes
set to “Degraded” or “Failed,” you should examine the conditions surrounding
your system for a lack of cool air flow or a possible failure of a cooling fan.

  System Performance

You can use the items in the Hard Drive Read/Write/Seek and Network
Interface Card categories to monitor general system usage. Since many of
these items are counts, you may want monitor them on a periodic basis and
convert them to rates to better use this information. If you notice continuous
high rates, it may be an indication of a potential system overload.

  Resource Usage

The usage of system resources can be seen by monitoring the Operating System
Resource Utilization and Hardware Utilization categories. If you notice that the
operating system file system usage is approaching your acceptable minimum for
available space, you may want to plan to archive some files, examine the file
systems for unused files that might be candidates for deletion, or consider
adding more physical disk drives to increase disk space.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
B-1

Integrating Compaq Insight Manager with Enterprise Management Platforms

Appendix B  
Trap Overview

Insight Agents generate traps to notify you of events that require action. Some
traps enable you to be proactive by warning you of status changes or degraded
states. Others require immediate attention.

Depending on the version of Insight Agents loaded on a particular server, you
could receive a version 1.x type trap or a version 2.x type trap.

The version 1.x traps defined in the MIBs have a different base identifier,
called the enterprise ID, for each MIB file (Intelligent Drive Array, SCSI
Devices, and so on). The MIB enterprise IDs are the “Object ID” items in
the descriptions of the MIBs shown in Table 4-1. For example, the version
1.x trap for Intelligent Drive Array is 1.3.6.1.4.1.232.3. The version 2.x traps
have the same enterprise ID (1.3.6.1.4.1.232) for all traps defined in all
of the MIBs.

The enterprise ID combined with the specific trap ID uniquely identify
the trap.

NOTE:  Insight Agents for NetWare prior to version 2.60 may generate both version 1
and version 2 trap formats. Beginning with version 2.60, all Insight Agents generate
version 2 trap formats.

Each trap message lists the trap name, the identification number, the
description, and the values for the trap variables. The trap variables appear
in alphabetical order with a descriptive title indicating an important event has
occurred. Immediately following the title is the numerical equivalence for the
trap variable listed. By providing you with this message, you can quickly and
easily translate the trap variables you receive from your management platform
to determine if the trap requires immediate attention.
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Beginning with version 2.60, two additional variables are included in all
Insight Agent traps:   The first variable is the originating system’s hostname
and the second variable identifies the system as either a server or client.  The
remaining variables are identical to those generated by previous versions.  To
maintain compatibility with older agents,  the updated traps were added as
“new” traps in the Compaq MIB.  For example, Trap 3008, an IDA Logical
Drive Status Change trap, supersedes Trap 3001.  Version 2.6 and later agents
will generate a 3008 trap for this event instead of a 3001 trap.

The Compaq traps described in the following tables are grouped by subject as
well as Trap IDs.  The Trap ID listed in parentheses is the identifier for the
superseded (pre-2.60) trap.

Table B-1
Drive Array Traps

Trap Name: cpqDa3LogDrvStatusChange
Trap ID: 3008   (3001)
Description:
A logical drive status change has occurred. The current status is indicated by the included
status variable.
“Bad Connection” status (9) - The physical drive in a Compaq Drive Array is not responding
to commands from the array controller. Several causes are possible:
• A drive was removed from the system.
• The data cable connecting the drive to the array has failed.
IMPORTANT:  Do not attempt to re-seat any cables while the server is on. Damage to the
drives or array controller will result.
• The cable connecting the drive to the array has become loose at either end and must

be reseated.
• The cable connecting an external storage subsystem to the server has become loose.
• The power to the drive has been interrupted. This can be caused by a loosened drive

power supply cable or a failed power supply in the server or disk subsystem.

continued
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Drive Array Traps   Continued    

“Failed” status (3) - One or more physical drives have failed. Data is no longer protected on the
drive array.

“OK” status (2) - This alarm is typically issued upon completion of repairs to a Compaq Drive
Array logical drive. This alarm occurs whenever the logical drive status has returned to a normal
state from any other state. In fault tolerant configurations, it is issued following the resolution of
the Drive Array Logical Drive Status Change - Rebuilding alarm. In non-fault tolerant
configurations, it is issued following the Drive Array Logical Drive Status Change - Failed alarm,
after the failed drive has been replaced.

“Overheating” status (10) - The temperature inside an external drive array enclosure has risen
above factory preset levels. If the temperature continues to rise, damage to the drives within the
enclosure may result. Elevated temperatures may cause erratic operation of a physical drive
within the array, causing data loss. This alarm may be caused by the removal of the enclosure
cover, which impairs the cooling system performance significantly, or by a cooling fan failure in
the drive array enclosure.

NOTE: Do not operate Compaq server and storage products with the chassis covers removed.
Airflow inside the unit is interrupted, and proper cooling is not possible. Removing the chassis
covers also violates the FCC certification and UL listing.

“Ready for Rebuild” status (6)-A failed drive has been replaced, and the system is ready to begin
Automatic Data Recovery on the logical drive. This alarm is issued after a failed drive has been
replaced or if a drive that previously failed appears to work again after the power is turned on.

NOTE:  The system is ready to begin Automatic Data Recovery. Perform an orderly shutdown of the
operating system and server, and turn the server off. Turn it on again to begin Automatic Data
Recovery.

“Rebuilding” status (7) - Automatic Data Recovery is underway.
“Recovering” status (5) - A physical drive failed within the Compaq Drive Array. The drive array
is in a recovery mode. No data has been lost, due to the fault tolerant mode currently in use.

NOTE: At the first available opportunity, replace the failed drive.

continued
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“Shutdown” status (11) - The external drive array has stopped operating because of elevated
temperatures. Do not attempt to operate the disk storage subsystem while temperatures are
elevated. Severe damage to the disk drives will occur. Elevated temperatures will cause erratic
operation of a physical drive within the array, causing data loss. The elevated temperatures can
cause physical changes to a hard drive, leading to data corruption. This alarm may be caused by
the removal of the enclosure cover, which impairs the cooling system performance significantly, or
by a cooling fan failure in the drive array enclosure.

IMPORTANT:  If a logical drive shuts down due to high temperatures, data may no longer be
available from the server or storage subsystem containing the logical drive. In this case, you may
need to physically examine the server or storage subsystem to understand the cause of the
alarm. Do not operate Compaq server and storage products with the chassis covers removed.
Airflow inside the unit will be interrupted, and proper cooling is not possible. Removing the
chassis covers also violates the FCC certification and UL listing.

“Wrong Drive” status (8) - During remedial hardware maintenance, the incorrect physical drive
was replaced in an array.

IMPORTANT: Do not return the removed drive or the drive indicated as "wrong" for repair.
Perform an orderly shutdown of the system, and run Compaq Drive Array Advanced Diagnostics
if you need further assistance in identifying failed drives and/or drives installed in the wrong
location.  You must bring the system down, turn it off, and return the removed drive to its
original location. Turn the system back on.  After you reinstall the removed drive, identify the
correct failed drive.

continued
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Drive Array Traps   Continued    

“Inactive” status (4) - This alarm signifies that the spare is in a ready state. This alarm is
typically issued if you install or replace a spare drive in a Compaq Drive Array. It is issued after you
replace a failed spare drive with a new one. This alarm may also occur when a drive fails and the
spare becomes active, the failed drive is replaced, and the spare eventually becomes inactive
again. In fault tolerant configurations, when a drive fails and a spare drive is available, the storage
subsystem begins building data onto that spare. If the failed drive is replaced before restoration
has completed, the process halts and the data is restored to the replacement drive instead. If the
failed drive is replaced after the build process is complete, the system reconstructs the data to the
replacement drive, and the spare will reverts to its original inactive state. This keeps a spare drive
available. If you have installed or replaced a failed drive in the drive array, this alarm is to be
expected.
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Trap Name: cpqDa3SpareStatusChange
Trap ID: 3009   (3002)
Description:  A spare drive status change has occurred.  The current status is indicated by the
included status variable.
"Active" status (6) - A physical drive failed. The array successfully restored data onto a spare.
That spare drive has now become active and replaces the failed drive. In fault tolerant
configurations, when a spare drive is available, the storage subsystem begins building data onto
that spare. If the failed drive is replaced before restoration has completed, the process halts, and
the data is restored to the replacement drive instead. If the failed drive is replaced after the build
process is complete, the system reconstructs the data to the replacement drive, and the spare
reverts to its original inactive state. This keeps a spare drive available.
"Building" status (5) - This alarm is issued when a spare drive is brought online to replace a
failed drive and the drive array subsystem begins to build data onto the spare. In fault tolerant
configurations, when a spare drive is available, the storage subsystem begins building data onto
that spare. If the failed drive is replaced before restoration has completed, the process halts, and
the data is restored to the replacement drive instead. If the failed drive is replaced after the build
process is complete, the system reconstructs the data to the replacement drive, and the spare
reverts to its original inactive state. This keeps a spare drive available. When a spare drive is
available, this alarm is usually issued after the Drive Array Physical Drive Status Change - Failed
alarm. This alarm indicates that a drive has failed. When the building is complete, the Drive Array
Spare Drive Status Change - Active alarm is issued, indicating that the drive array is utilizing the
spare drive in the array in place of a failed drive. Replace the failed physical drive as soon as
possible. WARNING:  Do not interrupt the drive building process.
 "Failed" status (3) - This alarm indicates that a spare drive in a drive array failed. Replace the
spare as soon as possible. Until you replace it, no spare is available in case of array failure.
"Inactive" status (4) - This alarm signifies that the spare is in a ready state. This alarm is
typically issued if you install or replace a spare drive in a Compaq Drive Array. It is issued after
you replace a failed spare drive with a new one. This alarm may also occur when a drive fails and
the spare becomes active, the failed drive is replaced, and the spare eventually becomes inactive
again. In fault tolerant configurations, when a drive fails and a spare drive is available, the
storage subsystem begins building data onto that spare. If the failed drive is replaced before
restoration has completed, the process halts and the data is restored to the replacement drive
instead. If the failed drive is replaced after the build process is complete, the system reconstructs
the data to the replacement drive, and the spare reverts to its original inactive state. This keeps a
spare drive available. If you installed or replaced a failed drive in the drive array, this alarm is to
be expected.
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Trap Name: cpqDa3PhyDrvStatusChange
Trap ID: 3010   (3003)
Description:
A physical drive status change has occurred. The current status is indicated by the included
status variable.

“Failed” status (3) - A physical drive has failed in a mass storage subsystem. In configurations
that are not fault tolerant, this alarm is critical. The mass storage
subsystem failed, and server operation stopped. You must replace the failed drive before system
operation can begin again. In a fault tolerant configuration, the overall system condition is
degraded, but still operational. You may receive additional alarms, such as Drive Array Logical
Drive Status Change - Recovering, or Drive Array Spare Drive Status Change - Active.

“OK” status (2) - This alarm indicates an improving condition and is issued after a physical drive
fault has been corrected or when you add a new hot pluggable physical drive.

continued
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Trap Name: cpqDa3PhyDrvThreshPassedTrap
Trap ID: 3011   (3004)
Description:
The server issuing this alarm has a drive that exceeded one or more factory preset
thresholds for functional degradation. Many Compaq high performance drive array hard
drives are "stamped" by the drive manufacturer with minimum functional characteristics.
As a result of normal wear and tear, the operation of a hard drive may gradually
deteriorate. If certain thresholds are exceeded, the drive may not perform to specified
levels, and may be subject to hardware failure sometime in the future. Drives that exceed
these thresholds are considered "failed," although true catastrophic failure has not yet
occurred. Compaq will replace drives that have exceeded these thresholds if these drives
are still under warranty.

Trap Name: cpqDa3AccelStatusChange
Trap ID: 3012   (3005)
Description:
This trap indicates a status change event concerning the drive array accelerator. The current
status is indicated by the included status variable.

“Enabled” status (3) - This alarm typically occurs when a Compaq Array Accelerator battery
set has fully recharged from a discharged condition. The array accelerator is ready to accept
posted writes.

“Permanently Disabled” status (5) - The write cache operations of the Array Accelerator are
permanently disabled. Consult the cpqDaAccelErrCode MIB item for further information about
why this trap occurred. You can perform an orderly shutdown, and run Compaq Drive Array
Advanced Diagnostics if you need further information.

“Temporarily Disabled” status (4) - The Array Accelerator on the drive array controller has
been temporarily disabled, due to one of the following reasons:
• The accelerator is holding data, and is configured for a different Drive Array Controller. 

Make sure the accelerator is installed on the original controller.
• Battery charge level is below 75 percent.
• Sufficient resources to perform posted writes are not available. This may be due to a 

current rebuilding process.
• The accelerator has failed or has been detached from the IDA-2 Controller.
• The host operating system has temporarily disabled posted writes.
Consult the cpqDaAccelErrCode MIB item for further information about why this trap occurred.

continued
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Drive Array Traps   Continued    

Trap Name: cpqDa3AccelBadDataTrap
Trap ID: 3013   (3006)
Description:
This trap indicates an event concerning the contents of the drive array accelerator. The
current accelerator data status is indicated by the included status variable.

“None” status (2) - A power loss to the server occurred. The battery-backed Array
Accelerator functioned properly and saved all data stored in the cache. When the system
is restarted, the stored data will be written to disk.

“Possible” status (3) - When the system was powered up, the battery set was not
sufficiently charged. When the batteries are not sufficiently charged, and the system
resumes power, the board does not retain stored data. If no data was stored, no data
was lost.
Several causes of this alarm are possible:
• If the system was without power for eight days, and the battery packs were on 

 (battery sets activate only if the system loses power unexpectedly), any data stored 
in the cache was lost.

• The battery set may have a problem. Check the Battery Status for more information.
• The Array Accelerator board has been replaced with a new board that has discharged

batteries. No data is lost, and the Array Accelerator will automatically be enabled 
when the batteries reach full charge.

Trap Name: cpqDa2AccelBatteryFailed
Trap ID: 3014   (3007)
Description:
This trap signifies that the Insight Agent has detected a battery status change
associated with the array accelerator. The current battery status is indicated by the
included status variable.

“Charging” status (3) - The battery set power is below 75% of nominal and is
being charged.

continued
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“Degraded” Status (5) - The battery set in the Array Accelerator is operating, but one of
the batteries has failed to recharge correctly. This condition jeopardizes the integrity of
the battery-backed cache. Replace the Array Accelerator as soon as possible. If allowed to
continue, the battery set might fail, and the drive array controller will no longer write data
to the Array Accelerator. Server performance may be affected during this time. After the
Array Accelerator is replaced, the Drive Array Accelerator Battery Status - Recharging
alarm is issued. Once recharged, the alarm Drive Array Accelerator Battery Status - OK is
issued, indicating that the array accelerator subsystem is operational.

“Failed” Status (4) - The Array Accelerator can no longer protect data in the cache in the
event of a power interruption to the server. Replace the Array Accelerator as soon as
possible. The replaced Array Accelerator batteries must reach full charge before the
controller will allow data to be written to the Array Accelerator subsystem. Server
performance may be affected during this time.

“OK” status (2) - The battery set has reached a fully charged condition.
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Table B-2
SCSI Traps

Trap Name: cpqScsi3CntlrStatusChange
Trap ID: 5005   (5001)
Description:
A SCSI controller status change has occurred. The current status is indicated by the
included status variable.

“Failed” status (3) - A SCSI Controller failed. This alarm may be issued with physical
drive alarms if the controller cannot communicate with the system.

“OK” status (2) - A SCSI Controller has been replaced. This alarm indicates an
improving condition.

continued
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Trap Name: cpqScsi3PhyDrvStatusChange
Trap ID: 5006   (5003)
Description:
A status change has occurred to a physical drive attached to the SCSI controller. The
current status is indicated by the included status variable.

“Failed” status (3) - A physical drive failed in a SCSI mass storage subsystem. Replace
the drive.

“OK” status (2) - This alarm indicates an improving condition. When a physical drive
error is corrected, this alarm is issued.

“Removed while Failed” status (7) - A SCSI drive installed in the mass storage
subsystem has been removed. The removed drive has failed and must be replaced to
restore the system to its original configuration. This alarm may be issued if the removed
drive was not replaced prior to the time the status was polled by the software.

“Removed while OK” status (6) - A SCSI drive installed in the mass storage subsystem
has been removed while operating properly. If the drive was inadvertently removed, return
it to its original position.

Trap Name: cpqTapePhyDrvStatusChange
Trap ID: 5007   (5004)
Description:
A status change has occurred to a tape drive attached to the SCSI controller. The current
status is indicated by the included status variable.

“Degraded” status (3) - This alarm indicates that a reread or rewrite threshold has been
exceeded; backup integrity might have been compromised. Follow steps listed under
“Failed” status.

“Failed” status (4) - A SCSI tape drive failed. For additional details, check the error status
of the backup application. Follow these steps:

1. Clean the tape drive head and try the backup again (refer to your tape hardware user
manual for more details on this procedure).

2. If step #1 fails, replace the tape media with new tape media and try the backup again.
3. If step #2 fails, cycle the power on the tape drive and try the backup again.
4. If the above steps fail, replace the drive.

“OK” status (2) - A SCSI tape drive has been replaced. This alarm indicates that the tape
drive is now ready for operation.

continued
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Table B-3
System Health Traps

Trap Name: cpqHe3CorrectableMemoryError
Trap ID: 6015   (6001)
Description:
This alarm indicates that a block of memory has failed or is failing and must be replaced
soon. This condition is not generally critical since the memory controller is able to correct
the problem; however, an error of this type indicates that a memory component is failing
or has failed in the server issuing the alarm. The system continues to correct any errors it
can. Correct the problem as soon as possible. Further degradation of the memory
components may occur, and then errors may no longer be correctable.

Trap Name: cpqHe3CorrectableMemoryLogDisabled
Trap ID: 6016   (6002)
Description:
Correctable memory error tracking has been disabled due to excessive alerts. Logging of
correctable memory errors ceases when the error count exceeds a factory preset value
since continuing to log errors after the preset number is reached affects performance of
the server. This alarm indicates a failing or failed memory module. Though this alarm is
not critical, an error of this type indicates that a memory component is failing or has failed
in the server issuing the alarm. The system continues to correct any errors it can.

Trap Name: cpqHe3ThermalTempFailed
Trap ID: 6017   (6003)
Description:
The temperature status has been set to "Failed." The server will be gracefully shut down.
You should monitor the room temperature and air conditioning. Verify that the covers to
the servers are properly installed as this ensures proper air flow within the server box.
Verify that all fans within the server unit are operational.

continued
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Trap Name: cpqHe3ThermalTempDegraded
Trap ID: 6018   (6004)
Description:
The temperature status has been set to "Degraded." The server’s temperature is outside
of the normal operating range. The included status variable indicates how the system will
react to this temperature degradation.

“Continue” status (2) - The system is configured to continue operation when this alarm
is received. NOTE:  If the system continues to operate in this degraded condition, the
hardware may initiate an immediate and unexpected shutdown.

“Shutdown” status (3) - The system has been configured to initiate a system shutdown
when this alarm is received to protect hardware and data from damage or loss.

Trap Name: cpqHe3ThermalTempOk
Trap ID: 6019   (6005)
Description:
Previously abnormal temperatures have returned to a normal state. This is an improving
condition.

Trap Name: cpqHe3ThermalSystemFanFailed
Trap ID: 6020   (6006)
Description:
A required system fan status has been set to "Failed." The included status variable
indicates how the system will react to this failure.

“Continue” status (2) - The system is configured to continue operation when this alarm
is received.

NOTE:  If the system continues to operate in this degraded condition, the hardware might
initiate an immediate and unexpected shutdown.

“Shutdown” status (3) - The system has been configured to initiate a system shutdown
when this alarm is received to protect hardware and data from damage or loss.

continued
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Trap Name: cpqHe3ThermalSystemFanDegraded
Trap ID: 6021   (6007)
Description:
The system fan status has been set to “Degraded.” An optional system fan is not
operating properly.

Trap Name: cpqHe3ThermalSystemFanOk
Trap ID:   6022   (6008)
Description:
A system fan returned to a normal state from a failed state. This alarm is to be expected
after you replace a failed system fan.

Trap Name: cpqHe3ThermalCpuFanFailed
Trap ID: 6023   (6009)
Description:
A system CPU fan failed. The system is configured to continue operation when this alarm
is received.

Trap Name: cpqHe3ThermalCpuFanOk
Trap ID: 6024   (6010)
Description:
The CPU fan status has been set to OK. Any previous non-operational processor fans have
returned to normal operation.

Trap Name: cpqHe3AsrConfirmation
Trap ID: 6025   (6011)
Description:
This alarm indicates a return to normal operation. Automatic Server Recovery (ASR) shut
the system down and then restarted the server, which has returned to normal operation.
Other alarms that were issued before this alarm may require action.

NOTE: An ASR reboot does not mean the system is free of faults. The server may be
running in a degraded condition, and must be corrected soon to prevent the fault
condition from escalating into a critical event. If the fault is not corrected, expect another
Automatic Server Recovery reboot at any time.

continued
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Trap Name: cpqHe3ThermalConfirmation
Trap ID: 6026   (6012)
Description:
This alarm is issued when server temperature has returned to acceptable levels, and the
server automatically resumed operation. Ensure that you have corrected the problem that
caused the elevated temperature.

Trap Name: cpqHe3PostError
Trap ID: 6027   (6013)
Description:
A Power-On Self Test error occurred during a reboot of the server. This error may have
been noted during the Automatic Server Recovery reboot. The subsystem responsible for
the error may also be responsible for the ASR reboot. The error might include
non-correctable memory errors, fatal hard drive and/or controller failures, and system
board failures. It may not be possible to view the server issuing the alarm, as the network
operating system may have failed to load properly.

Trap Name: cpqHe3FltTolPwrSupplyDegraded
Trap ID: 6028   (6014)
Description:
The redundant power supply subsystem has become degraded. Although the server will
continue to operate, take corrective action soon to restore power redundancy.

Trap Name:  cpqHe3CorrMemReplaceMemModule
Trap ID: 6029
Description:
This alarm indicates that the number of correctable memory errors for a particular
memory module on the server has crossed a set threshold, indicating that the module
needs to be replaced. This condition is generally noncritical since the memory controller
is able to correct the problem; however, it should be corrected as soon as possible.
Although the system continues to correct any errors it can, an error of this type indicates
that a memory component is failing or has failed in the server issuing the alarm. Further
degradation of the memory components may occur, and then errors may no longer be
correctable.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
B-17

Integrating Compaq Insight Manager with Enterprise Management Platforms

Table B-4
Storage Systems Traps

Trap Name: cpqSs3FanStatusChange
Trap ID: 8008   (8001)
Description:
The status of a storage system fan has changed. The current status is indicated by the
included status variable.

“Failed” status (3) - The storage subsystem's internal fan(s) failed. The temperature may
soon rise beyond factory preset levels. The storage system may shut down automatically
to prevent damage to hardware and data loss.

“OK” status (2) - This alarm is issued when a change occurs in the operating condition
of a monitored server's external storage system fan. A fan has been replaced, or has
otherwise returned to normal operation. This alarm typically follows the Storage System
Fan Status Change - Failed alarm.

Trap Name: cpqSs3TempFailed
Trap ID: 8009   (8002)
Description:
The internal temperature has risen beyond factory preset levels and the storage system
may shut down automatically to prevent damage to hardware and data loss. One or more
fans may have failed, or a cover is off the storage system issuing the alarm.

NOTE:  This alarm is unlikely to occur. If temperatures rise beyond factory preset safety
levels, the storage system may shut down. In this case, no data is available to view.

Trap Name: cpqSs3TempDegraded
Trap ID: 8010   (8003)
Description:
The temperature inside a storage subsystem is outside normal operating range. A fan may
have failed. If a fan failed, an additional alarm, Storage System Fan Status Change -
Failed may also be issued. The storage subsystem is operating without the proper cooling
capacity, and internal unit temperatures may soon rise beyond safe levels.

continued
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Storage Systems Traps   Continued    

Trap Name: cpqSs3TempOk
Trap ID: 8011   (8004)
Description:
Previously abnormal temperatures inside a storage subsystem returned to a normal state.
This is an improving condition, and generally requires no further action.

Trap Name: cpqSs3SidePanelInPlace
Trap ID: 8012   (8005)
Description:
The side panel status has been set to “In Place.” The storage system’s side panel has
returned to a properly installed state.

Trap Name: cpqSs3SidePanelRemoved
Trap ID: 8013   (8006)
Description:
The side panel status has been set to “Removed.” The storage system’s side panel is not
in a properly installed state. This situation may result in improper cooling of the drives in
the storage system due to air flow changes caused by the missing side panel.

Trap Name: cpqSs3PwrSupplyDegraded
Trap ID: 8014   (8007)
Description:
The storage system redundant power supply subsystem has become degraded.
Although the storage system will continue to operate, take corrective action soon to
restore power redundancy.
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Table B-5
Remote Insight Board Traps

Trap Name: cpqSm2ServerReset
Trap ID: 9001
Description:
The Remote Insight firmware has detected a server reset.

Trap Name: cpqSm2ServerPowerOutage
Trap ID: 9002
Description:
The Remote Insight firmware has detected server power failure.

Trap Name: cpqSm2UnauthorizedLoginAttempts
Trap ID: 9003
Description:
The Remote Insight firmware has detected unauthorized login attempts.

Trap Name: cpqSm2BatteryFailed
Trap ID: 9004
Description:
The Remote Insight battery has failed and needs to be replaced.

Trap Name: cpqSm2SelfTestError
Trap ID: 9005
Description:
The Remote Insight firmware has detected a board self test error.

continued



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
B-20    Trap Overview

Remote Insight Board Traps  continued

Trap Name: cpqSm2InterfaceError
Trap ID: 9006
Description:
The host OS has detected an error in the Remote Insight board interface.  The firmware is
not responding.

Trap Name: cpqSm2BatteryDisconnected
Trap ID: 9007
Description:
The Remote Insight battery cable has been disconnected.

Trap Name: cpqSm2KeyboardCableDisconnected
Trap ID: 9008
Description:
The Remote Insight keyboard cable has been disconnected.
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Table B-6
User Threshold Traps

Trap Name: cpqMeFallingAlarm
Trap ID: 10002
Description:
Falling threshold passed. One of the monitored objects has passed the falling threshold.
The instances of those objects contained within the variable list are those of the alarm
entry that generated this trap.

Trap Name: cpqMe2RisingAlarm
Trap ID: 10003   (10001)
Description:
Rising Threshold passed. One of the monitored objects has passed the rising threshold.
The instances of those objects contained within the variable list are those of the alarm
entry that generated this trap.

Trap Name: cpqMe2FallingAlarm
Trap ID: 10004   (10002)
Description:
Falling threshold passed. One of the monitored objects has passed the falling threshold.
The instances of those objects contained within the variable list are those of the alarm
entry that generated this trap.
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Table B-7
 Host Operating System Traps

Trap Name: cpqHo2GenericTrap
Trap ID: 11003
Description:
A generic trap used to test Insight Agents.  A text message is generally passed with this
trap.

Trap Name: cpqHo2AppErrorTrap
Trap ID: 11004
Description:
An application has generated an exception.  Specific error information is contained in the
variable cpqHoSwPerfAppErrorDesc which is passed with this trap.

Trap Name: cpqHo2NicStatusOk
Trap ID: 11005
Description:
This trap is sent any time the status of a Network Interface Card changes to the OK
condition.  Slot information for the card is passed as a variable in the trap.

Trap Name: cpqHo2NicStatusFailed
Trap ID: 11006
Description:
This trap is sent any time the status of a Network Interface Card changes to the Failed
condition.  Slot information for the card is passed as a variable in the trap.

Trap Name: cpqHo2NicSwitchoverOccurred
Trap ID: 10007
Description:
This trap is sent any time the configured redundant network interface card becomes the
active card.  The data passed with this trap is the slot information for the active and
inactive cards.
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Table B-8
Uninterruptible Power Supply Traps

Trap Name: cpqUps2LineFailed
Trap ID: 12006   (12001)
Description:  The AC power has failed. Once this alarm is issued, power to the server is
provided by the Compaq Uninterruptible Power Supply (UPS). Depending on the capacity,
the load, and the battery charge level of the UPS, the amount of time the UPS can supply
conditioned AC power will vary. If you have enabled Automatic Shutdown, the UPS support
software will begin an automatic orderly shutdown of the system when the UPS batteries
reach the Shutdown Threshold limit. At this time, the UPS Shutdown in Progress alarm is
issued to indicate the shutdown process has begun. If Automatic Shutdown is not enabled,
the UPS continues to operate until the power returns or the battery power is exhausted.

Trap Name: cpqUps2LineOk
Trap ID: 12007   (12002)
Description:  The AC line is now active. All electrical devices previously supported by the
Compaq Uninterruptible Power Supply (UPS) are now reconnected to the main AC line.
The Compaq UPS indicates that it is no longer operating on internal batteries.

Trap Name: cpqUps2Shutdown
Trap ID: 12008   (12003)
Description:  This alarm is the result of an extended power loss.  The Compaq
Uninterruptible Power Supply (UPS) is about to shut down.  If the operating system is
configured for automatic shutdown, this process has begun and should be inspected to
make sure it will complete prior to the shutdown of the UPS.

Trap Name: cpqUps2Confirmation
Trap ID: 12009   (12004)
Description:  The Compaq Uninterruptible Power Supply (UPS) has returned to normal
operation. A power failure occurred, and the system was shut down. Commercial power
was restored, and the network operating system restarted.

Trap Name: cpqUpsBatteryLow
Trap ID: 12010   (12005)
Description:  The battery set in the UPS is getting low.
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Table B-9
Standby Recovery Server Traps

Trap Name: cpqRsPartnerFailed
Trap ID: 13001
Description:
The Recovery Agent reports that the partner server has failed.  This server has taken over
the operations of the partner server.

One of the two servers of a Recovery Server pair has failed.  The surviving server has
assumed the role of the failed server.  A service event should be scheduled to repair the
failed server and to restore the Recovery Server pair to its original configuration.

Trap Name: cpqRsStandbyCableFailure
Trap ID: 13002
Description:
The Primary server in a Standby Recovery Server configuration has detected a cable fault
condition.  This can be caused by disconnecting the serial interconnect cable from the
Primary server.  Other causes may include failure of the serial port in the Primary server.

Disconnecting the serial cable from the Primary server will cause loss of the heartbeat
message at the recovery server.  The loss of heartbeat will cause the recovery server to
assume that the Primary server has failed.  The recovery server will then switch the disks
from the Primary server to the recovery server.  The recovery server will then boot from
the disks.  In anticipation of this event, the Primary server operating system will be
shutdown in an orderly fashion to prepare for the switchover to the recovery server.  A
service event should be scheduled to repair the failure and to restore the Recovery Server
pair to its original configuration.

continued
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Standby Recovery Server Traps   Continued    

Trap Name: cpqRsStandbyFailure
Trap ID: 13003
Description:
The Recovery Server Option Driver reports that the Standby server has failed or the serial
interconnect cable to the Standby server is not connected.

This trap indicates that the Primary server is no longer receiving an acknowledgment
message from the Standby server.  This error indicates one of the following possible
conditions:

A. The recovery server has failed.
B. The recovery server has been powered off.
C. The serial interconnect cable has been disconnected from the recovery server.

A service event should be scheduled to repair the failure condition and to restore the
Recovery Server pair to its original configuration.

Trap Name: cpqRsOnlineCableFailure
Trap ID: 13004
Description:
The On-Line Recovery Server Agent reports that the local serial interconnect is not
connected or has failed.  However, network operations confirm that the partner is still
operating correctly.

The serial interconnect cable has been disconnected from one of the servers in an On-
Line Recovery Server configuration or the serial interconnect has failed.  Since the
network confirmation option was selected, the partner server has been successfully
contacted over the network.  A service event should be scheduled to repair the failure
condition and to restore the Recovery Server pair to its original configuration.

continued
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Standby Recovery Server Traps  Continued

Trap Name: cpqRsFailoverFailed
Trap ID: 13005
Description:
The On-Line Recovery Server Agent reports that an attempt to take on the operations of
the partner server was made and failed.

One of the two servers in an On-Line Recovery Server configuration has failed.  The
surviving server of the pair has generated this trap message.  The surviving server of the
pair has generated this Insight Manager alarm.  The surviving server attempted a
switchover of the disks of the failed server but the switchover did not complete
successfully. It was not possible to mount the switched disks.  Most likely, this failure was
due to problems encountered by the operating system.  System failures in the other server
may have corrupted the file system.  Often, such problems are corrected by use of utilities
such as NetWare VREPAIR and Microsoft CHKDSK.  A service event should be scheduled
to repair the failed server, to restore the disks in question, and to restore the Recovery
Server pair to its original configuration.
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Table B-10
Manageable IDE Drive Traps

Trap Name: cpqIdeDriveDegraded
Trap ID: 14001
Description:
The IntelliSafe Hard Drive predicts imminent failure. Follow these steps:

      1.   Backup the affected drive.

      2.   Replace the drive and restore data.

Trap Name: cpqIdeDriveOk
Trap ID: 14002
Description:
This alarm indicates an improving condition. This alarm is issued after a physical drive
fault has been corrected, or when you have added a new physical drive.
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Table B-11
Server Manager/R Traps

Trap Name: cpqSmBoardFailed
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 1
Description:
Server Manager/R board failure. Schedule maintenance time to run Compaq Diagnostics
to determine the problem.

Trap Name: cpqSmBoardReset
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 2
Description:
Server Manager/R board reset. If the board and the software were not able to recover,
schedule maintenance time to run the Compaq EISA Configuration Utility to ensure the
proper board configuration.

Trap Name: cpqSmServerManagerAlert
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 3
Description:
Threshold exceeded on Server Manager/R monitored item. Monitor which threshold is
exceeded to determine what actions to take.

Trap Name: cpqSmCommFailed
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 4
Description:  Server Manager/R asynchronous communications failure.

Trap Name: cpqSmBatteryFailed
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 5
Description:  Server Manager/R battery failure. Schedule maintenance time to replace
the failed battery or to replace the board.

continued
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Server Manager/R Traps  Continued    

Trap Name: cpqSmBoardTimeout
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 6
Description:
Server Manager/R board time-out. If the problem persists, run Compaq Diagnostics at the
next scheduled maintenance down time.

Trap Name: cpqSmAlertDestinationBlacklisted
Enterprise ID: 1.3.6.1.4.1.232.4
Trap ID: 7
Description:
The Server Manager/R is unable to complete a call to a designated alert phone number.
Verify the proper Server Manager/R alert configuration.

NOTE: Server Manager/R trap IDs 1 - 7 apply only to Insight Agents for NetWare.

For more details on traps, refer to the README.TXT file in the \MIBS
directory in the Compaq Systems Management Toolkit.
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Appendix C  
Multivendor Integration
from Compaq

To help you successfully integrate and optimize your network or multivendor
system, Compaq has developed a library of systems integration TechNotes for
the NetWare, Microsoft Windows NT, SCO UNIX, and OS/2 operating
system environments. TechNotes provide you with important information on
topics such as network performance management, server management, and
operating system interconnectivity.

To get a copy of a particular TechNote in electronic format, you can access:

■ Downloadable files from the Internet at:

 http:// www.compaq.com

  Pricing

Compaq TechNotes U.S. $15      (CND $20)*

*Plus shipping & handling

  How to Order

To order by PHONE (credit card orders only), call:

■ 1-800-952-7689 (In U.S.:  7 a.m. - 7 p.m. C.S.T.)

■ 1-800-263-5868 (In Canada:  24 hours)

■ 1-317-364-7281 (From outside U.S. & Canada:
7 a.m. - 7 p.m. C.S.T.)
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To order by MAIL or FAX, send complete order information to:

Worldwide: Compaq Fulfillment Center
(except Canada & P.O. Box 4100
France) Crawfordsville, Indiana 47933

FAX:    1-317-364-0787

Canada: Compaq TechNotes
Compaq Canada, Inc.
111 Granton Drive, Suite 101
Richmond Hill, ON  L4B 1L5

FAX:    1-800-668-1835

France: Compaq TechNotes
Compaq Computer S.A.R.L.
5, Avenue de Norvege
91959 LES ULIS Cedex
France

FAX:    1-331-64-46-51-81

  Current TechNotes

The current TechNotes available are listed in Table C-1.
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Table C-1
Compaq TechNotes

TechNote Name Part Number

Compaq Insight Management

Integrating Compaq Insight Manager with Enterprise Management
Platforms (5/96) 145806-004

Integrating Compaq Insight Manager with Microsoft Systems
Management Server (5/96) 184720-002

Integrating Compaq Insight Manager with
ManageWise (5/96) 182074-002

NetWare

Performance Management in a NetWare v3.1x Environment (4/93)
133399-002

NetWare Tape Backup Management Using ARCserve from Compaq
(4/93) 137535-001

NetWare 4 Performance Management (7/94) 137989-001

ORACLE Server Planning in a NetWare v3.11
Environment (5/93) 145143-001

NetWare Server Management (9/92) 145231-001

Compaq IDA-2 Configuration for NetWare (12/92) 145536-001

Compaq ProSignia Configuration Guidelines for NetWare v3.x (12/92)
145537-001

Compaq Answers to Technical Support Questions for NetWare
Environments (2/95) 145710-002

NetWare SFT III v3.11 Installation (9/93) 145905-001

NetWare Migration from 2.x to 3.12 (6/94) 181069-001

continued
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Compaq TechNotes   continued    

TechNote Name Part Number

NetWare (continued)

NetWare Migration from 3.12 to 4 (11/94) 181152-001

SYBASE SQL Server 4.2.2 for NetWare: Tuning and Performance
(2/95) 184429-001

Performance of Lotus Notes 3.1 on Compaq ProLiant Servers with
NetWare 3.1x (2/95) 184430-001

Configuration and Tuning of Oracle7 for NetWare on Compaq Servers
(1/96)

185450-001

Microsoft

Implementing Lotus Notes on Compaq Servers with Microsoft LAN
Manager (9/92) 145201-001

Microsoft SQL Server and Novell NetWare Requester
for OS/2 (9/92) 145376-001

Drive Subsystem Performance with Microsoft LAN Manager 2.1 (11/92)
145517-001

Configuration and Tuning of Microsoft SQL Server for Windows NT on
Compaq Servers (7/94) 184207-001

Migrating from Microsoft Windows NT Advanced
Server 3.1 to Microsoft Windows NT Server 3.5 (2/95) 184669-001

Compaq Backup and Recovery for Microsoft
SQL Server (3/95) 184489-001

Configuration and Tuning of Oracle7 for Windows NT on Compaq
Servers (7/95) 184853-001

Implementing Microsoft Windows NT Server RAS, DHCP, and WINS
on Compaq Servers (9/95) 184488-001

Migrating to Microsoft Windows NT Server 3.51 on Compaq Servers
(8/95) 185026-001

continued
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Compaq TechNotes   continued    

TechNote Name Part Number

UNIX

SCO UNIX in an SNA Environment Using CLEO
DataTalker U/X (5/92) 145081-001

SCO UNIX in an SNA Environment Using Computone
LYNX (7/92) 145116-001

SCO UNIX Database Servers in Novell Networks (10/92) 145402-001

Printing in SCO UNIX and NetWare Integrated Environments (3/93)
145538-001

SCO UNIX Connectivity to SNA Environments Over X.25 Networks
(1/93) 145583-001

Disk Mirroring with VERITAS VxMirror (12/93) 145656-001

SCO UNIX IP Routing Over X.25 Networks (4/93) 145711-001

Performance Tuning for SCO UNIX on Compaq
Systems (5/93) 145730-001

Performance Tuning for ORACLE7 on Compaq Systems Running SCO
UNIX (7/93) 145942-001

Configuration and Tuning of Oracle7 for SCO UNIX on Compaq Servers
(11/94) 184329-001

Configuration and Tuning of Sybase System 10 for Novell UnixWare 2.0
on Compaq Servers (7/95) 184943-001

The Compaq, SCO UNIX, and ORACLE7 Database
Server (9/93) 195818-001

Configuration and Tuning of Sybase System 10 for SCO UNIX Open
Server 3.0 on Compaq Servers (9/95) 185111-001

continued
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Compaq TechNotes   continued    

TechNote Name Part Number

IBM

Compaq Answers to Technical Support Questions for OS/2
Environments (11/94)

Not available in
bound format

Performance of Lotus Notes 3.1.5 on Compaq ProLiant Servers with
OS/2 2.11 (3/95) 184655-001

Technology Overview

Configuring Compaq RAID Technology for Database Servers (7/94)
184206-001
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Index  

A
Access rights, discussion   2-8
Accounting management, ISO model

discussed   2-9
Adding Compaq server support

HP OpenView   6-3
IBM NetView for AIX   4-2, 6-3
SunNet Manager   5-3

Advanced Error Checking and
Correcting Memory   3-4, 3-7

American Network Standards
Institute   2-2

ANSI   3-9
ANSI protocol   2-15
ANSI standard, with remote control

network management   2-2
API   See Application Program

Interface
AppleTalk, use of SNMP discussed

2-12
Application builder   4-20, 6-24
Application Program Interfaces

4-1, 6-1
Application registration file, sample

4-28, 6-30
Asset Management   3-19
AssetControl   3-11, 3-14, 3-17
Attribute   2-3
Attributes, Insight MIBs   A-5
Automatic management, using in

SunNet Manager   5-28

Automatic Server Recovery-2   3-8.
See also Remote maintenance
critical errors, described   3-8
illustration with Rapid Recovery

Engine   3-6
server integrated management

feature   3-5
AWK (programming language)

4-29, 6-31

B
Background images, supported

graphic formats   6-21
Benefits, network management   2-5
Bitmap editor program   6-13
Bitmap files

Compaq server bitmaps   4-12
Compaq server bitmaps,

directory location   6-13
creating   4-12, 6-13
Hewlett-Packard size

recommendation   6-15
IBM size recommendation   4-14
syntax   4-12, 6-13

Bitmap for Compaq server,
illustration   4-13, 6-14

Bitmap mask for Compaq server,
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bitmap(1) program   6-13
bridge   2-1, 2-5, 2-6, 2-9, 2-16, 3-11
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Browsing MIBs
in HP OpenView   6-33
in IBM NetView for AIX   4-31

Btrieve database, object information
stored by Compaq Insight
Manager   3-21

C
Client Management   3-19
CMIP protocol   4-1, 6-1
CMOT protocol   6-1
community string   2-11
Compaq Desktop Management

Solution Partners   2-1
Compaq Insight Management

Agents
for NetWare   B-29
MIB diskette

COMPAQ.SCH, sample
schemas   5-3

COMPAQ.TRP sample file
5-30

CPQSINFO.MIB   5-20
Insight MIB files   5-4
README.TXT file

5-4, 6-39
TRAPD.CPQ file   6-39
TRAPHDR.CPQ file   6-39

MIB files
adding Compaq product

support   5-6, 6-3
compiling   5-5
CPQHLTH.MIB   5-17
CPQIDA.MIB   5-5
CPQSINFO.MIB   5-17

MIB files  continued
CPQSTDEQ.MIB   5-17
described   6-4
key attributes   A-5
transferring to HP

OpenView   6-4
transferring to SunNet

Manager   5-3
software

Compaq Insight Manager
3-18

Insight Agents   3-18
network management

interoperability   3-26
traps

described   B-1
Compaq Insight Management Agents

application registration files 6-23
custom MIB query files   6-36
defining traps manually

4-37, 6-39
described   3-21
discovery process   4-6, 6-7
discussed   5-23, 6-18
enterprise definitions, discussed

4-37, 5-29, 6-39
for IBM OS/2 2-11, 3-21, 4-19, 6-20
for Microsoft Windows NT

2-11, 3-21, 4-19, 6-20
for NetWare 2-11, 3-21, 4-19, 6-20
for SCO UNIX   2-11, 3-21,

4-19, 6-20
for UnixWare   2-11
installing the EISA configuration

information   4-22, 6-24
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MIB files   6-4

described   4-3
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AIX   4-3, 6-4
MIB schemas and   5-4
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5-20
SET support, levels of

4-32, 5-27, 6-34
SNMP MIB-II, support   5-28
SNMP protocol and   2-11
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Compaq Insight Manager
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Compaq Inspect Utility, using to view
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Compaq ProLiant servers
See also Compaq servers
Hot-Pluggable Drives   3-4
Offline Backup Processor   3-4
Rapid Recovery Engine   3-4

Compaq schemas
COMPAQ.SCH   5-3
consolidating files   5-17
copying to SunNet Manager

directory   5-7
customizing   5-17
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in IBM NetView for AIX
environment   4-2, 6-3
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Compaq SMART Controller  3-4
Error Checking and Correcting

Memory   3-4
fault management   2-7
fault prevention, Server
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fault tolerance, features   3-4
Full-Spectrum Fault

Management, defined   3-2
Insight MIB attributes   A-5
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management technology   3-1
network management,

interoperability   3-26
operating system integration  3-25
SNMP-based management

agents, support for   2-1
tools from Compaq for managing

2-2
Compaq SMART Controller   3-4
Compaq System Configuration

Utility   3-9
Compaq System Configuration,

adding in HP OpenView   6-27
Computing (managed) devices,   2-5
Configuration management, ISO

model discussed   2-8
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Conner (hard drive manufacturer) 3-12
Contact node information, retrieving

6-27
Copying, schemas to SunNet

Manager directory   5-7
Corrected Error Log   3-7
Create command, using to create

glyphs   5-9
Critical Error Log   3-7
Custom applications, adding

4-20, 6-22

D
Data Report, requesting with SunNet

Manager   5-23
Desktop management

illustration   2-18
Desktop managment

on PC networks   2-18
Device access

in-band   2-13
out-of-band   2-13

Diagnostics software, Server Health
Logs and   3-7

Diagnostics utilities   3-9
Discover tool

adding Compaq servers to
submap   4-5, 6-7

adding Compaq servers to
subview   5-8

categorizing elements
4-6, 5-8, 6-7

Drive manufacturers   3-12

Dynamic Host Configuration
Protocol   2-2
Insight Manager support   3-20

E
EISA   3-9, 3-23, 3-24
EISA slot information

building application to retrieve
information   6-24

Element Manager   2-3
End User Interface (EUI)   4-17
Enterprise Management   3-23
Enumeration strings, modifying  5-19
ETHER.MIB   4-3, 6-4
EUI   See End User Interface
Event

monitoring
in HP OpenView   6-37
in IBM NetView for AIX 4-35

notification
setting up   4-41, 5-34, 6-44
using traps   B-1

report requesting   5-25

F
Fault Management   3-19
Fault management, ISO model

discussed   2-7
Fault prevention   See also Compaq

servers
Server Parameter Tracking   3-3
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Fault tolerance
Compaq server, features   3-4
MIBs and   A-5
value in proactive monitoring 2-7

Field registration files
modifying   4-8, 6-9
ovw_fields file   4-9, 6-10
snmp_fields file   4-10, 6-11

File locations   See Important
directories

File Transfer Protocol
availability with operating

systems   4-3, 6-4
transferring files   4-3, 5-4, 6-4
using in IBM NetView for AIX

environment   4-4, 6-5
using in SunNet Manager

environment   5-4
Full-Spectrum Fault Management

discussed   3-2
illustrated   3-3

G
gateway   2-1, 2-5
GET, SNMP operating command and

support   2-12
GET-NEXT, SNMP operating

command and support   2-12
GIF (CompuServe Graphics

Interchange Format)   6-21

Glyphs
changing properties   5-16
changing types   5-9
creating icons and   5-13

H
Hard drives, Hot-Pluggable Drives on

Compaq ProLiant servers   3-4
Hewlett-Packard Documents

HP OpenView Network Node
Manager Administrator's
Reference   6-7, 6-12, 6-17,
6-20, 6-29, 6-41

HP OpenView Network Node
Manager User's Guide
6-8, 6-21, 6-36, 6-37, 6-44

HP OpenView Windows User's
Guide   6-8

Hot-pluggable drives   3-4
HP OpenView

adding
Compaq query files   6-23
custom applications   6-22
slot configuration

information   6-24
subclass icon   6-9

application registration files,
building and integrating  6-29

bitmap
directory location of bitmap

files   6-13
illustrated   6-15
program to create icon files

6-13
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HP OpenView  continued
creating bitmap files for Compaq

servers   6-13
default path for MIBs   6-4
discover tool   6-7
integrating with other systems  6-41
integration, discussed   6-1
IP Topology database   6-28
key features   6-1, 6-2
loading Insight MIB files   6-5
modifying configuration files 6-17
modifying field registration files

6-10
monitoring events   6-37
more command, using

6-12, 6-17
netmon process, using   6-7, 6-20
Node discovery, TCP/IP devices 6-

2
ovtopodump command, using 6-28
predefined and custom

applications   6-36
symbol registration files,

directory location   6-16
symbol subclasses, defining 6-16

HP-UX operating system   6-1
hub   2-5

I
IBM documents

NetView for AIX Installation and
Configuration Guide   4-17

NetView for AIX Programmer's
Guide   4-11, 4-14, 4-16, 4-27

NetView for AIX User's Guide
4-5, 4-34

IBM NetView for AIX
adding

Compaq query files   4-21
custom applications   4-20
slot configuration

information   4-22
bitmap

illustrated   4-14
program to create icon files 4-12

creating bitmap files for Compaq
servers   4-12

default path for MIBs   4-3
directory location of preloaded

MIBs   4-5
discover tool   4-5
integrating with other systems 4-39
integration, discussed   4-1
IP Topology database   4-26
key features   4-1
loading Insight MIB files   4-4
modifying field registration files 4-8
monitoring events   4-35
more command, using

4-11, 4-16
netmon process, using   4-6, 4-19
node discovery, IP devices   4-1
ovtopodump command, using 4-26
predefined and custom

applications   4-34
symbol subclasses, defining   4-15

IBM OS/2, Insight Agents for   3-21
IDA   3-7
IETF   See Internet Engineering Task

Force



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
I-7

Important directories
copying schemas as directed by

SunNet Manager
/usr/snm/agents   5-7

location of application
registration files
/usr/OV/registration/$LANG
4-27, 6-29

location of bitmap files
/usr/OV/bitmaps/$LANG
4-12, 6-13

location of default snmp.traps
file /var/adm/snm   5-30

location of elements.schema file
/usr/snm/struct   5-11

location of field registration files
/usr/OV/fields/$LANG
4-8, 6-9

location of oid_to_sym file
/usr/OV/conf   4-18, 6-19

location of symbol registration
files
/usr/OV/symbols/$LANG
4-15, 6-16

In-band management
device access   2-13
discussed   2-11

Infrastructure devices, described   2-5
Inspect utility   3-7
Integrated server management

features   See also Rapid
Recovery Engine
Automatic Server Recovery   3-5
remote maintenance, described

3-8

Integrated server management
continued
Server Health Logging   3-5
Server Health Logs

Corrected Error Log   3-7
Critical Error Log   3-7
Power-On Error Log   3-7
Revision History Table   3-7

Integration Management   3-19
Integration with Enterprise

Management Platforms   3-20
Intelligent manageability   2-1
Intelligent Manageability features  2-19
IntelliSafe Hard Drives   3-12
Internet Engineering Task Force   2-9
Internet Management MIB, discussed

2-10
Internet Packet Exchange   2-2
Internet Protocol   2-2
IP   3-9
IP addresses

contained in OpenView IP
Topology database   6-28

explanation of TechNote
examples   4-1, 6-1

seed file of SNMP-based routers
4-6, 6-7

IP devices
managing with HP OpenView

6-1
managing with IBM NetView for

AIX   4-1
managing with SunNet Manager

5-1
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IP protocol   2-12, 2-15
ipmap process   4-18, 6-19
IPX   3-9, 3-21
IPX protocol   2-12, 2-15
ISO model

configuration management   2-8
fault management   2-7
framework for network

management   2-6
performance management   2-7
security management   2-8

L
LAN   2-13, 2-14, 2-16, 2-18, 3-10,

3-12, 3-16, 3-17, 3-26
LAN Workplace for DOS   4-3, 6-4
Laptops, consideration as a network

asset   2-8
Logical domains, separating network

into   2-8

M
Managed Device   2-3
Managed devices

discussed   2-5
Managed Object   2-3
Management Agent   2-3
Management agents

Insight Agents   2-12
software component explanation

2-9

MIB
browsing   4-1, 4-31, 6-2, 6-33
Compaq software inventory   A-8
definition of two existing types 2-10
drive array status   A-20
fault and recovery features status

A-24
fault identification   A-19
file names

CPQHLTH.MIB   A-18,
A-19, A-23, A-24

CPQHOST.MIB   A-8,
A-9, A-17

CPQIDA.MIB   A-7, A-11,
A-13, A-20

CPQSCSI.MIB   A-7, A-11,
A-14, A-15, A-21

CPQSINFO.MIB   A-7
CPQSTDEQ.MIB   A-7, A-10
CPQSTSYS.MIB   A-23
RFC1213   A-6, A-16

general system description   A-6
hard drive errors   A-13
hard drive read/write/seek   A-11
hardware

asset description   A-7
configuration   A-10
utilization   A-18

information, using   A-25
key information   A-5
loading for IBM NetView for

AIX   4-4
loading from HP OpenView   6-5
NIC information   A-16
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MIB  continued
operating system

configuration   A-9
resource utilization   A-17

SCSI disk status   A-21
system environment status   A-23
transferring

to HP OpenView Console  6-4
to IBM NetView for AIX

Console   4-3
mib2schema program, using   5-20
Microsoft Windows NT, Insight

Agents for   3-21
Modem connection, remote

maintenance, using   3-9
Modem link, using to access

managed elements (out-of-band)
2-13

Modifying
enumeration strings   5-19
field registration files   4-8, 6-10
Insight Agent name and

description   5-20
Motif-based management application

4-1

N
netmon process   4-6, 4-19, 6-7, 6-20
NetWare

Insight Agents for   3-21, B-29
NetWare Virtual Terminal (NVT)

protocol   2-15

Network
elements, online and offline   2-13
remote maintenance, connecting 3-9
typical configuration, illustrated 2-1

Network management
accounting   2-9
ANSI standard   2-2
Compaq tools and   2-2
configuration   2-8
factors, complexity of   2-5
fault detection   2-7
issues for providing acceptable

service levels   2-5
methods for managing resources 2-13
OSI model, discussed   2-6
overview   2-5
performance   2-7
protocols   2-9
security   2-8
server management   2-16
SNMP standards   2-2
terms

defined   2-3
relationship of, illustrated  2-4

Network Node Manager
described   6-1
directory location of preloaded

MIBs   6-6
Network resources, methods of

managing   2-13
New Compaq Deskpro Family   2-1,

2-19
NNM   See Network Node Manager
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O
Offline

Backup Processor   3-4
device, getting contact

information   4-25, 6-27
in-band management   2-15
out-of-band management   2-15

Offline management   2-15
Online

in-band management   2-14
out-of-band

management   2-14
PPP protocol, using   2-14
SLIP protocol, using   2-14

Out-of-band
device access   2-13
management, discussed   2-13

ovtopodump command, using to
dump database object   6-28

P
Performance management   3-19

application to network operation
2-7

ISO model discussed   2-7
Performance monitoring

using Insight Agents   3-21
using Insight MIBs   A-5

Point-to-Point protocol   2-14
Point-to-Point Protocol   2-2
Power-On Error Log   3-7
Protocol layers, OSI model and   2-6

Protocols
ANSI   2-15
AppleTalk   2-12
CMIP   4-1, 6-1
CMOT   6-1
FTP   4-3, 5-4, 6-4
IP   2-12, 2-15, 6-1
IPX   2-12, 2-15
NVT   2-15
PPP   2-14
SLIP   2-14
SNMP   4-1, 6-1
Telnet   2-15
VT100   2-15

Q
Quantum (hard drive manufacturer) 3-

12
Query files

adding to HP OpenView   6-23
adding to IBM NetView for AIX

4-21
Quick Dump

illustrated   5-23
producing in SunNet Manager  5-21

R
Rapid Recovery Engine   See also

Compaq ProLiant servers
Automatic Server Recovery-2,

integrated feature   3-4
flowchart   3-6
Server Health Logging,

integrated feature   3-4



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
I-11

README.TXT file   4-12, 6-13
Remote control management,

Compaq server management   2-2
Remote maintenance

Automatic Server Recovery
support   3-9

Compaq utilities   3-9
using modem connection   3-9
using network connection   3-9

Remote Management   3-20
Reporting   3-20
Revision History Table, described

3-7

S
SCO UNIX, Insight Agents for   3-21
Seagate (hard drive manufacturer)

3-12
Security management, ISO model

discussed   2-8
Serial Line Internet protocol   2-14
Server Health Logging, integrated

feature   3-5
Server Health Logs

Corrected Error Log   3-7
Critical Error Log   3-7
Power-On Error Log   3-7
Revision History Table   3-7

Server management, illustration   2-17
Server parameter tracking, discussed

3-3

SET
Insight Agents, support for   2-11
SNMP operating command and

support   2-12
SNMP support   2-11

Set Request, performing on SNMP
devices   5-26

SET, Insight MIB variables
4-32, 6-34

Simple Network Management
Protocol   2-2

SNMP
Compaq support for agents under

specific operating systems   2-1
compliant management

platforms, vendors of   2-10
devices, performing Set Request

5-26
hosts file, discussed   5-30
MIB-I   6-18
MIB-II   4-25, 5-28, 6-8, 6-27
operating command

GET   2-12
GET-NEXT   2-12
SET   2-12
TRAP   2-12

protocol
discussed   2-9, 6-1
management platforms   2-

10
MIBs and   2-9

reference book specified for in-
depth discussion   2-12

standards, for online network
management   2-2
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SNMPv1   2-3
SNMPv2   2-11
snmpwalk utility   6-17
Solaris operating system   6-1
Solution partners, list   3-16
Standards, network management   2-9
Standby Recovery Server   3-20
Subclass Icon, changing   6-8
Subsystem   2-3
SunNet Manager

automatic management, using 5-28
changing glyphs   5-9
configuration of test environment

5-2
creating file for Compaq server

type   5-12
creating icon files, applying

masks   5-15
Data Report

requesting   5-23
Discover tool

adding Compaq servers to
subview   5-8

categorizing elements   5-8
elements.schema, adding

managed device types   5-11
enumeration strings, modifying

5-19
event notification   5-34
Event Report

requesting   5-25
gateways, setting up   5-35
glyphs

changing properties   5-16
-i option, to load schemas   5-7

SunNet Manager  continued
icon editor screen, illustrated  5-15
Insight MIB files, transferring   5-3
integrating with other systems  5-34
integration, discussed   5-1
key features   5-1
processing traps   5-30
Quick Dump

producing   5-21
running report   5-11

reports, discussed   5-21
schemas, associating with

Compaq servers   5-10
SunOS   6-1
Symbol registration files

modifying   4-17, 6-16
oid_to_sym file   4-18, 6-19
oid_to_type file   6-20
oid_to-type file   4-19

T
TCP/IP, SNMP and   2-12
TechNote

chapter summary   1-1
intended audience   2-1

Telnet   2-2
Telnet protocol   2-15
Terms, defined for network

management   2-3
TOKEN.MIB   4-3, 6-4
Tools, supplied by Compaq to

manage Compaq servers   2-2
Transferring, Insight MIB files from

diskette   5-4
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Transmission Control Protocol   2-2
TRAPD.CPQ   4-37
TRAPHDR.CPQ   4-37
Traps

corrective action   B-1
destination setting,

recommendation   5-29
discussed   4-36, 5-29, 6-38
integrating with SunNet Manager

5-30
processing in SunNet Manager

5-30
setting up in HP OpenView   6-

38
setting up in IBM NetView for

AIX   4-36
troubleshooting with   4-38, 5-33,

6-41
Troubleshooting, using traps   4-38,

5-33, 6-41, B-1

U
UNIX

bitmap program   4-12, 6-13
commands

dos2unix, using to convert
DOS files   5-6

mib2schema, using to
compile Insight MIBs
5-5

more, using to view screen
information   4-11, 4-16,
6-12, 6-17

ovtopodump, using to dump
database object   4-26, 6-
28

UNIX  continued
utilities

snmpwalk   6-17
User network access, security

management and   2-8
Utilities, Compaq   3-7, 3-9

V
Vendor MIBs   2-10
VT100 protocol   2-15

W
WAN   2-13, 2-14
Windows Internet Name Service   2-2
Windows Internet Naming Service

(WINS)   3-20

X
X Windows-based management

application   4-1
XBM (X11 monochrome bitmap

format)   6-21


